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Preface

This document is under ESDIS Project configuration control. Once this
document is approved, ESDIS approved changes are handled in accordance
with Class | and Class Il change control requirements described in the ESDIS
Configuration Management Procedures. Changes to this document shall be
verified by a document change notice (DCN) and implemented by change bars
or by complete revision.

Any questions should be addressed to: esdis-esmo-cmo@Ilists.nasa.gov

ESDIS Configuration Management Office (CMO)
NASA/GSFC

Code 423

Greenbelt, Md. 20771
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Abstract

Originally there was an effort to harmonize a list of standards and
specifications that was in use by the NASA Earth Science community. These
specifications included the Directory Interchange Format (DIF), Earth
Observing System (EOS) Clearing House (ECHO) 10, Service Entry Resource
Format (SERF), and International Organization for Standardization (1SO)
19115- 2. The result of the harmonization effort was the Unified Metadata
Model (UMM).

This document -the UMM-Common document - describes the compilation of
elements that are shared among the UMM profiles which include: collections,
granules, services, visualizations, variables, and documents. Implementers of
ESDIS Common Metadata Repository (CMR), its clients, and data providers
should reference this document and the UMM as a guide while implementing
the system, its clients, or generating metadata. Links to more information
about the standards and specifications used in this document can be found in
Reference Documents .

Keywords: UMM-S, UMM-Common, UMM-C, UMM-G, UMM-Var, NASA
Earthdata Search, Tools, EOSDIS, ESDIS, CMR
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APPENDIX A INTRODUCTION

Earth Observing System Data and Information System (EOSDIS) generates,
archives, and distributes enormous amounts of Earth Science data, which in
turn are made available to the science community and the public at large. To
aid in the search and discovery process, these data must be organized and
cataloged. Accurate, complete, and consistent metadata are required for
efficient accessibility. To improve the quality and consistency among its
metadata holdings, EOSDIS has developed a model describing metadata that
it archives and maintains. This model documents elements that may be
represented across various metadata standards and unifies them through core
elements useful for discovery. This unified model, aptly named the Unified
Metadata Model (UMM), was developed as part of the EOSDIS Metadata
Architecture Studies (MAS | and 11) conducted between 2012 and 2013. The
UMM will be used by the Common Metadata Repository (CMR) and will drive
search and retrieval of metadata cataloged within that system.

This document describes common elements used in various UMM reference
profiles, which include: collections, granules, services, visualizations,
variables, and documents. For each element in this document, the following
information is provided:

e element specification

e description

e profile utilization

e cardinality

e analysis

e mapping to existing standards

e examples

e future recommendations

A.A.1 Purpose

This document provides information to the National Aeronautics and Space
Administration (NASA) Earth Science community. Distribution is unlimited.

A.A.2 Scope

This document is a supplemental document to the Collection Metadata Model.
It holds common elements that are shared between the other metadata
models.

A.A.3 Impact

This document outlines common elements used in the UMM that are intended
to be backward- compatible with existing NASA earth science metadata
implementations. It will impact providers from NASA Distributed Active
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Archive Centers (DAAC), CMR client developers, metadata catalog developers,
and users.

A.A.4 Copyright Notice

The contents of this document are not protected by copyright in the United
States and may be used without obtaining permission from NASA.

A.A.5 Feedback

Questions, comments and recommendations on the contents of this document
should be directed to support@earthdata.nasa.gov.

A.A.6 Document Conventions

This document contains UMM common elements, each of which contains the
following components:
. Element Name: Provides the element name.
o Element Specification: Provides the sub-elements, cardinality of
the sub-elements within (), any valid values within <>, applicable
comments and notes within {}, and any other major factors that make up
the element.
J Description: Provides background information on the purpose of
the element and its intended use. Furthermore, any information about
the element's current usage, recommendations for usage, or unresolved
issues is also documented here. The term "resource" is also used mainly
in the description section though it can be used elsewhere and it is
meant to denote collections, granules, services, visualizations, variables,
documents, etc.

. Profile Utilization: Lists which profiles use the specific element.
. Cardinality: Indicates the expectation of counts for this element,
summarized in Table A.l.

. Analysis: Gives an analysis of this element where needed and
describes any necessary reconciliation.

. Mapping: Gives Extensible Markup Language (XML) Path

Language (XPath) mappings for this element to the elements in other
specifications. This can be considered as the "crosswalk" for this
element. For a link to more information about XPaths please see Related
Documents .

J Examples: XML snippets from "cross- walked" data standards
documenting sample values for the element. Whenever possible, a
Uniform Resource Locator (URL) to the specific collection or service
used for the metadata snippet, is provided.

J Recommendations: Provides any future recommendations for the
element.
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Table A.11. Cardinality

Value Description

1 Exactly one of this element is required

0..N Optionally, up to and including N number of this element may
be present

0..* (Optionally, any number of this element may be present

1.* |At least one of this element isrequired, any number may be
present

A.A.7 Related Documentation

The latest versions of all documents below should be used. The latest ESDIS
Project documents can be obtained from  URL: https://opsl-
cm.ems.eosdis.nasa.gov . ESDIS documents have a document number starting
with either 423 or 505. Other documents are available for reference in the

ESDIS project library website at:
http://esdisfmp01.gsfc.nasa.gov/esdis_lib/default.php unless indicated
otherwise.

A.A.7.1  Applicable Documents

The following documents are referenced within or are directly applicable, or
contain policies or other directive matters that are binding upon the content
of this document.

423-RQMT- | Metadata Requirements Base Reference Document
003
423-RQMT- | Metadata Requirements Base Reference Appendix B
003-B | UMM- Collection
DIF 9 | https://gcmd.nasa.gov/Aboutus/xml/dif/dif.xsd
DIF 10 | https://gcmd.gsfc.nasa.gov/Aboutus/xml/dif/dif v10.2.xsd
ECHO 10 | https://wiki.earthdata.nasa.gov/ECHO
SERF | https://gcmd.nasa.gov/Aboutus/xml/serf/serf.xsd
https://gcmd.nasa.gov/add/serfquide/index.html
ISO 19115-2 | http://www.iso.org/iso/catalogue_detail.htm?
(MENDS) | cshumber=39229
https://cdn.earthdata.nasa.gov/iso/
ISO 19115-1 | https://github.com/I SO- TC211/XML

AA.7.2 Reference Documents

The following documents are not binding on the content but referenced herein
and, amplify or clarify the information presented in this document.

Tags | http://en.wikipedia.org/wiki/Tag_%28metadata%?29
XPath | XPath is a language for addressing parts of an XML
A-9
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document, designed for use with XSLT.

XLinks

http://en.wikipedia.org/wiki/XLink
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APPENDIX B COMMON ELEMENTS

The following subsections describe each of the metadata elements that are
common among the various UMM profiles.

A.B.1 Metadata Language

Element Specification

Metadatal anguage

Description

The language used in the metadata record.

Profile Utilization

Collection, Granule, Service, Visualization, Variable, Document

Cardinality

0..1

Analysis

If not supplied the default language of English will be assumed.

Mapping

ISO 19115-2 /gmi:MI_Metadata/gmd:language/gco:CharacterString
with

gmi:M|_Metadata/gmd:MD_CharacterSetCode
codeList="http://www.isotc211.0rg/2005/resources/Codelist/gm




xCodelists.xml#MD_CharacterSetCode"

codeListValue=

ISO 19115-1

mdb:MD_Metadata/mdb:defaultLocale/lan:PT_Locale/lan:langua
ge/lan:LanguageCode/@codeList="http://standards.iso.org/iso/1
9115/resources/Codelist/cat/codelists.xml#L anguageCode"

@codeListValue=

with
mdb:MD_Metadata/mdb:defaultLocale/lan:PT_Locale/lan:charac
terEncoding/lan:MD_CharacterSetCode/ @codeList="http://www
isotc211.org/2005/resources/Codelist/gmxCodelists.xml#MD_C

haracterSetCode"

@codeListValue=




Examples

SO 19115-2

<gmd:language>
<gco:CharacterString>eng</gco:CharacterString>

</gmd:language>

<gmd:MD_CharacterSetCode

codeList="http://www.isotc211.0rg/2005/resources/Codelist/gmxCodeli
sts.xml#M D_CharacterSetCode"

codeListValue="utf8">utf8</gmd:MD_CharacterSetCode>

</gmd:characterSet>

SO 19115-1

<mdb:MD_Metadata ...>
<mdb:defaultLocale>
<lan:PT_Locale>
<lan:language>
<lan:LanguageCode
codeList="http://standards.iso.org/iso/19115/resources/Codelist/cat/codelists
xml#LanguageCode"
codeListValue="eng">eng</lan:LanguageCode>
</lan:language>
<lan:characterEncoding>
<lan:MD_CharacterSetCode

codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.x
mlI#M D_CharacterSetCode"




codeListValue="utf8">utf8</lan:MD_CharacterSetCode>
</lan:characterEncoding>
</lan:PT_Locale>

</mdb:defaultL ocale>

</mdb:MD_Metadata>

Source Data Information:
ISO 19115-2 - Snippet manually generated from schema

ISO 19115-1 - Snippet manually generated from schema

Recommendations

It is recommended that the value for this element be selected from a list of
language codes. The ISO standard for language codes that we will use is
ISO 639-2. For more information please see the 1SO 639-2 language code
web site at http://www.loc.gov/standards/iso639- 2/php/code_list.php .




A.B.2 Metadata Date
Element Specification

MetadataDate/Date (1)
MetadataDate/Type (1) <"CREATE", "UPDATE", "DELETE", "REVIEW" >

Description
There are three types of dates used in the UMM profiles:

e Dates that concern the metadata record - called Metadata Dates in
this document.

e Dates that concern the resource itself (collections, granules, services,
etc.) - called Data Dates in this document.

e Dates that describe the time period in which the data set was
acquired - called Temporal Extent in this document.

Of these three date types this element is comprised of dates for when the
metadata was created, last revised, planned for future review, or planned
for deletion. For dates related to the actual data or resource, the element
Data Date should be used. For dates that describe the acquisition period the
Temporal Extent element should be used.

Profile Utilization

Collection, Service, Document

Cardinality

0..*

Analysis



All metadata dates have been consolidated under this element. They will be
typed and will all be represented by the 1SO 8601 date and time
conventions as part of the reconciliation process.



Mapping

DIF 9 /DIF/DIF Creation Date
/
DIF/Last DIF Revision Dat
e
/
DIF/Future DIF Review D
ate
DIF 10 DIF/Metadata Dates/Metadata Creation
DIF/Metadata Dates/Metadata Last Revision
DIF/Metadata Dates/Metadata Future Review
DIF/Metadata Dates/Metadata Delete
SERF SERF/SERF Creation Date
SERF/Last SERF Revision
Date
SERF/Future SERF Review Date
ECHO 10 /Collection/RevisionDate
Collection
ECHO 10 |N/A
Granule
ISO 19115- |/ This element can be populated, but not
2 gmi:MI Metadata/datesta used by the UMM. This element does
mp not contain a date type and therefore it
1s not known what date is represented
by this element.
/
gmi:MI Metadata/gmd:metadataExtensionInfo/gmd:MD MetadataE
xtensionInformation/gmd:extendedElementInformation/gmd:MD_ Ex
tendedElementInformation/gmd:name/gco:CharacterString=<Meta
data Create Date, Metadata Update Date, Metadata Future Review
Date, Metadata Delete Date>
with
.../gmd:definition/gco:CharacterString=<Create Date, Update Date,
Future Review Date, Delete Date>
.../gmd:dataType/gmd:MD_ DatatypeCode codeList=""
codeListValue="" = Date
.../gmd:domainValue/gco:CharacterString= {the actual date}
ISO 19115- |/mdb:MD _ Metadata/mdb:dateInfo/cit:CI_Date/cit:date/gco:DateTime




EMS

/
mdb:MD Metadata/mdb:dateIlnfo/cit:CI_Date/cit:dateType/cit:CI_Dat
eTypeCode

@codeList="http://standards.iso.org/iso/19115/resources/Codelist/c
at/codelists.xm#CI DateTypeCode" (@codeListValue=

N/A




Examples

DIF 9

<DIF_Creation_Date>2002- 06-25</DIF_Creation_Date>
<Last DIF_Revision_Date>2015- 12-02</Last_DIF_Revision_Date>
<Future DIF Review Date>2005- 04-27</Future DIF Review Date>

DIF 10

<Metadata Dates>
<Metadata Creation>2007- 02-26</Metadata_Creation>
<Metadata Last Revision>2015- 06-11</Metadata_L ast_Revision>
<Metadata_ Future_Review>2017- 05-01</Metadata_Future_Review>

</Metadata Dates>

SERF

<SERF_Creation_Date>2005- 06-01</SERF_Creation_Date>

<Last SERF_Revision Date>2008- 06-03</Last SERF_Revision Date>

ECHO 10 Caollection

<RevisionDate>2008- 12-02T00:00:00.000Z</RevisionDate>

SO 19115-2

<gmd:dateStamp>
<gco:DateTime>2008- 12-02T00:00:00Z</gco:DateTime>

</gmd:dateStamp>

<gmd:date>

<gmd:Cl_Date>




<gmd:date>
<gco:DateTime>2008- 12-02T00:00:00.000Z</gco:DateTime>
</gmd:date>
<gmd:dateType>
<gmd:Cl_DateTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#Cl_DateTypeCode"
codeListValue="revision">revision</gmd:Cl_DateTypeCode>
</gmd:dateType>
</gmd:Cl_Date>
</gmd:date>
<gmd:date>
<gmd:Cl_Date>
<gmd:date>
<gco:DateTime>2008- 12-02T00:00:00.000Z</gco:DateTime>
</gmd:date>
<gmd:dateType>
<gmd:Cl_DateTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#Cl_DateTypeCode"
codeListValue="creation">creation</gmd:Cl_DateTypeCode>

</gmd:dateType>

</gmd:Cl_Date>

</gmd:date>

SO 19115-1




<mdb:datelnfo>
<cit:Cl_Date>
<cit:date>
<gco:DateTime>2008- 12-02T00:00:00Z</gco:DateTime>
</cit:date>
<cit:dateType>
<cit:Cl_DateTypeCode
codeList="http://standards.iso.org/iso/19115/resources/Codelist/cat/codelis
ts.xm#Cl_DateTypeCode"
codeListValue="creation">creation</cit:Cl_DateTypeCode>

</cit:dateType>

</cit:Cl_Date>

</mdb:datel nfo>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214608783-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1273348636-
GES _DISC

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA-Athena

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179003030- ORNL_DAAC
ISO 19115-2 - https://cmr.earthdata.nasa.gov/search/concepts/C179003030-
ORNL_DAAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

A.B.3 Entry Title
Element Specification

EntryTitle



Description

The EntryTitle element represents the title of the resource described by the
metadata.

Profile Utilization

Collection, Service, Document

Cardinality

1



Mapping

DIF 9 /DIF/Entry_Title

DIF 10 /DIF/Entry_Title

SERF /SERF/Entry_Title

ECHO 10 /Collection/DataSetId
Collection
ISO 19115-2 /
gmi:MI Metadata/gmd:identificationInfo/gmd:MD_ Datald
entification/gmd:citation/gmd:CI_Citation/gmd:title/gco:C
haracterString
ISO 19115-1 /

gmi:MI Metadata/mdb:metadataldentifier/mcc:MD Ident
ifier/mcc:code/gco:CharacterString
and
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Datal
dentification/mri:citation/cit:CI_Citation/cit:title/gco:Char
acterString

EMS MetaDataLongName

Examples
DIF 9

<Entry Title>1- km Water Fraction From National Topographic Data Base Maps,
Canada</Entry Title>

DIF 10

<Entry Title>Aerosol Ratio Small MODIS L2 (AQUA Browse
Product)</Entry Title>

SERF

<Entry Title>Project 3D-View: Virtual Interactive Environmental
Worlds</Entry Title>

ECHO 10 Collection




<Collection>

<DataSetld>Aquarius L3 Gridded 1-Degree Daily Soil Moisture
V004</DataSetld>

</Collection>

SO 19115-2

<gmd:identificationlnfo>
<gmd:MD_Datal dentification>
<gmd:citation>
<gmd:Cl_Citation>
<gmd:title>
<gco:CharacterString>Aquarius L3 Gridded 1-Degree Daily
Soil Moisture

V004</gco:CharacterString>

</gmd:title>

</gmd:CI_Citation>

</gmd:citation>

</gmd:MD_Dataldentification>

</gmd:identificationlnfo>

SO 19115-1

| <mdb:metadatal dentifier>




<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>Aquarius L3 Gridded 1-Degree Daily Soil
Moisture
V004</gco:CharacterString>
</mcc:code>
<mcc:.codeSpace>
<gco:CharacterString>gov.nasa.echo</gco:CharacterString>
</mcc:codeSpace>

</mcc:MD_Identifier>

</mdb:metadatal dentifier>

<mdb:identificationlnfo>
<mri:MD_Dataldentification>
<mri:citation>
<cit:Cl_Citation>
<cit:title>
<gco:CharacterString>Aquarius L3 Gridded 1-Degree Daily
Soil Moisture

V004</gco:CharacterString><gmd:Cl_Citation>

</cit:title>

</cit:Cl_Citation>




</mri:citation>

</mri:MD_Datal dentification>

</mdb:identificationlnfo>

EMS Flat File

Aquarius L3 Gridded 1-Degree Daily Soil Moisture




Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214615490-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1225368560-
LAADS

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C1000001602-
NSIDC_ECS

ISO 19115-2 - Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179001766- SEDAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

EMS - NSIDCVO flat file

A.B.4 Abstract
Element Specification

Abstract

Description

Abstract provides a brief description of the resource the metadata
represents. This element allows markdown- formatted text and line breaks
within the text are preserved. Additional information on markdown can be
found at http://en.wikipedia.org/wiki/Markdown

Profile Utilization

Collection, Service, Visualization, Variable, Document

Cardinality

1



Mapping

DIF 9

DIF/Summary/Abstract

DIF 10

DIF/Summary/Abstract

SERF

SERF/Summary/Abstract

ECHO 10
Collection

Collection/Description

ECHO 10
Granule

N/A

SO
19115-2

gmi:MI|_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/gm
d:abstract/gco:CharacterString

SO
19115-1

mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentification/mr
i;abstract/gco:Character String

EMS

N/A




Examples

DIF 9

<Summary >

<Abstract>The Lambert Glacier Basin (LGB) series of five oversnow
traverses were conducted from 1989-95. Ten metre depth (10 m) firn
temperatures, as a proxy indicator of annual mean surface temperature at a
site, were recorded approximately every 30 km along the 2014 km main
traverse route from LGBOO (68.6543 S, 61.1201 E) near Mawson Station, to
LGB72 (69.9209 S, 76.4933 E) near Davis Station.

10 m depth firn temperatures were recorded manually in field notebooks and
the data transferred to spreadsheet files (MS Excel).

Summary data (30 km spatial resolution) can be obtained from CRC Research
Note No0.09 &amp;Surface Mass Balance and Snow Surface Properties from
the Lambert Glacier Basin Traverses 1990-94& amp;.

This work was completed as part of ASAC projects 3 and 2216.

Some of this data have been stored in a very old format. The majority of files
have been updated to current formats, but some files (kaleidograph files in
particular) were not able to be modified due to a lack of appropriate
software. However, these files are simply figures, and can be regenerated
from the raw data (also provided).

The fields in this dataset are:

Latitude

Longitude

Height

Cane

Distance

Elevation

Density

Mass Accumulation
Y ear

Delta Oxygen- 18
Grain Size

Ice Crusts

Depth Hoar</Abstract>

</Summary >




DIF 10

<Summary>

<Abstract>The Atmospheric Infrared Sounder (AIRS) is a grating
spectrometer (R = 1200) aboard the second EOS polar-orbiting platform,
EOS Aqua. In combination with the Advanced Microwave Sounding Unit
(AMSU) and the Humidity Sounder for Brazil (HSB), AIRS constitutes an
innovative atmospheric sounding group of visible, infrared, and microwave
sensors. The AIRS Carbon Dioxide (CO2) Standard Retrieval Product consists
of retrieved estimates of CO2, plus estimates of the errors associated with
the retrieval. In contrast to AIRX2RET, the horizontal resolution of this
standard product is about 110 km (1x1 degree). An AIRS granule has been
set as 6 minutes of data, 15 footprints cross track by 22 lines along
track.</Abstract>
</Summary >

SERF

<Summary><Abstract>The Minnesota Public Health Data Access Portal
(also called the Data Access Portal) provides access to data on a variety of
environmental and health topics. Minnesota Public Health Data Access
(MNPH Data Access) is an online query and information system designed to
provide public access to Minnesota data about health, the environment, and
other risk factors that may impact public health. Each topic area on the
portal has a web page with information and details about the data. This page
identifies the source of the data, as well as the data's strengths and
limitations.

Minnesota Public Health Data Access (the Data Access portal) is updated
regularly to include new features and data (as data are available). The portal
includes data on air quality, asthma, birth defects, cancer, carbon monoxide
poisoning, chemicals in people: biomonitoring, childhood immunizations,
childhood lead poisoning, chronic obstructive pulmonary disease, drinking
water quality, environmental tobacco smoke, health insurance, heart attacks,
heat- related illness, obesity, poverty & income, reproductive & birth
outcomes, and smoking. Some of the data are available in mapped
format.</Abstract>

</Summary >

ECHO 10 Collection




<Description>

The AMSR-E/Aqua Level-3 daily Snow Water Equivalent (SWE) product
includes global

SWE on Northern and Southern Hemisphere 25 km EASE-Grids, generated
by the GSFC algorithm

using Level-2A TBs.

</Description>

SO 19115-2

<gmd:abstract>
<gco:CharacterString>The AMSR-E/Aqua Level-3 daily SWE product

includes global SWE on Northern and Southern Hemisphere 25 km EASE-
Grids, generated

by the GSFC algorithm using Level-2A TBs. Version Description:
Transitional SWE

corrects for forest attenuation using forest fraction from

MODIS 1 km IGBP Classes and forest density from MODIS 500 m UMD
Vegetation Continuous

Field; snow density climatology is used to convert snow depth to

SWE.</gco:CharacterString>

</gmd:abstract>

SO 19115-1

<mri:abstract>

<gco:CharacterString>The AMSR-E/Aqua Level-3 daily SWE product

includes global SWE on Northern and Southern Hemisphere 25 km EASE-




Grids, generated

by the GSFC algorithm using Level-2A TBs. Version Description:
Transitional SWE

corrects for forest attenuation using forest fraction from

MODIS 1 km IGBP Classes and forest density from MODIS 500 m UMD
Vegetation Continuous

Field; snow density climatology is used to convert snow depth to

SWE.</gco:CharacterString>

</mri:abstract>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214313574-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1243477314-
GES _DISC

SERF -
http://gcmd.gsfc.nasa.gov/mws/serf/Minnesota Public_Health_Data Access_
Portal

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179014688- NSIDC_ECS

ISO 19115-2 - https://cmr.earthdata.nasa.gov/search/concepts/C179014688-
NSIDC_ECS.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

A.B.5 Purpose

Element Specification

Purpose



Description

This element contains suggested usage, a description for as to why the
resource exists, or a description for what the resource can be used. Any
limitations on the resource including, but not limited to special restrictions,
legal prerequisites, and terms and conditions should be placed into the
UseConstraints element and not the Purpose element.

Profile Utilization

Collection, Service, Visualization, Document

Cardinality

0..1

Mapping

DIF 9 DIF/Summary/Purpose
DIF 10 DIF/Summary/Purpose
SERF SERF/Summary/Purpose
ECHO 10 Collection/SuggestedUsage
Collection

ECHO 10 N/A

Granule

ISO 19115-2

gmi:MI|_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentific
ation/gmd: purpose/gco:CharacterString

ISO 19115-1
mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentific
ation/mri:purpose/gco:CharacterString

EMS N/A




Examples

DIF 9

<Summary >

<Purpose>To assess species composition, abundance, distribution and
biomass of zooplankton within the Bering and Chukchi Seas, 1985-
1989</Purpose>

</Summary >

DIF 10

<Summary>

<Purpose>To provide VIIRS 375m active fire locations in Near Real-
Time in easy to use formats.</Purpose>
</Summary >

SERF

<Summary

<Purpose>MNPH Data Access may be used to:

-Help people and communities make healthy choices
-Protect children, the environment, and future generations

-Evaluate and measure the effectiveness of public health actions and policy

Ultimately, the goal of MNPH Data Access is to support the Minnesota
Department of Health's mission -- to protect, maintain, and improve the
health of all Minnesotans.</Purpose></Summary>

ECHO 10 Caoallection




<SuggestedUsage>To serve a wide user community by providing
composite Landsat images and raw data for urban areas that can be used
in interdisciplinary studies of remote sensing and the
environment.</SuggestedUsage>

SO 19115-2

<gmd:purpose>

<gco:CharacterString>To serve a wide user community by providing
composite Landsat images and raw data for urban areas that can be used
in interdisciplinary studies of remote sensing and the
environment.</gco:CharacterString>

</gmd:purpose>




1SO 19115-1

<mri:purpose>

<gco:CharacterString>To serve a wide user community by providing
composite Landsat images and raw data for urban areas that can be used
in interdisciplinary studies of remote sensing and the
environment.</gco:CharacterString>

</mri:purpose>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214595006-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1221486837-
SCIOPS

SERF -
http://gcmd.gsfc.nasa.gov/mws/serf/Minnesota_Public_Health_Data Access_
Portal

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179001954- SEDAC

ISO 19115-2 - https://cmr.earthdata.nasa.gov/search/concepts/C179001954-
SEDAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

A.B.6 Language

Element Specification

Language

Description

The language used in the dataset. Note: This is different from the language
of the metadata.

Profile Utilization

Collection, Granule, Service, Visualization, Document



Cardinality

0..*

Analysis

This element is not controlled. If a language is not supplied - English, the
default language, will be assumed.



Mapping

DIF 9 DIF/Data_Set_Language

DIF 10 DIF/Data_Set_L anguage

SERF SERF/Service_Language

ECHO 10 N/A

Collection

ECHO 10 N/A

Granule

SO gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/

19115-2 gmd:language/gco:CharacterString
with
gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentification/
gmd:MD_CharacterSetCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodeli
sts.xml#M D _CharacterSetCode"

codeListValue=

SO

19115-1 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/
mri:defaultLocale/lan:PT_Locale/lan:language/lan:LanguageCode
codeList="http://standards.iso.org/iso/19115/resources/Codelist/cat/co
delists.xml#L anguageCode" codeListValue=
mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Datal dentification/
mri:defaultLocale/lan:PT_Locale/lan:characterEncoding/lan:MD_Chara
cterSetCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodeli
sts.xml#M D CharacterSetCode" codeListValue=

EMS N/A

Examples

DIF 9




<Data_Set Language>English</Data Set_Language>

DIF 10

<Dataset_Language>English</Dataset_Language>

SERF

<Service Language>English</Service Language>




SO 19115-2

<gmd:language>
<gco:CharacterString>eng</gco:CharacterString>
</gmd:language>
<gmd:MD_CharacterSetCode
codeList=http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.x

mlI#M D _CharacterSetCode
codeListValue="utf8">utf8</gmd:MD_CharacterSetCode>

</gmd:character Set>

SO 19115-1

<mdb:identificationlnfo>
<mri:MD_Dataldentification>
<mri:defaultL ocal e>
<lan:PT_Locale>
<lan:language>
<lan:LanguageCode codelList =" codeListLocation#L anguageCode "
codeListValue ="eng">eng</lan:LanguageCode>
</lan:language>
<lan:characterEncoding>
<lan:MD_CharacterSetCode
codeList ="http://www.isotc211.0rg/2005/resources/Codelist/gmxCodelists.
xml#MD_CharacterSetCode "

codeListValue =" utf8">utf8</lan:MD_CharacterSetCode>

</lan:characterEncoding>




</lan:PT_Locale>
</mri:defaultLocale>
<mri:supplementallnformation/>

</mri:MD_Dataldentification>

</mdb:identificationl nfo>

Source Data Information :

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214587974-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1223726607-
GES _DISC

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA-Athena

ISO 19115-2 -
https://cmr.earthdata.nasa.gov:443/search/concepts/C179003030-
ORNL_DAAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of ISO
19115- 2 record

Recommendations

It is recommended that the value for this element be selected from a list of
language codes. The ISO standard for language codes that we will use is
ISO 639-2. For more information please see the 1SO 639-2 language code
web site at http://www.loc.gov/standards/iso639- 2/php/code_list.php.



A.B.7 Data Date

Element Specification

DataDate/Date (1)
DataDate/Type (1) <"CREATE", "UPDATE", "DELETE", "REVIEW" >

Description
There are three types of dates used in the UMM profiles:

e Dates that concern the metadata record - called Metadata Dates in
this document.

e Dates that concern the resource itself (collections, granules, services,
etc.) - called Data Dates in this document.

e Dates that describe the time period in which the data set was
acquired - called Temporal Extent in this document.

Of these three date types this element is comprised of dates for when the
data or resource itself changed in some way. It does not include the first or
third bullets that describe Metadata Dates or Temporal Extent. This
element is made of two sub-elements, type and date. The type describes
what the date represents: a future review, when the resource was created,
last updated, or planned for deletion. The date describes when the resource
had an action performed on it or when an action on it will occur as
described by the type element.

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*



Analysis

The Creation, Last Revision, Future Review, and Planned Deletion dates
exist in various places in the different standards.

All data dates have been consolidated under this element. They will be
typed and will all be represented by the 1SO 8601 date and time
conventions as part of the reconciliation process. In DIF 10 both the
metadata and data dates are located under the DIF/Metadata Dates
element. The difference is that the sub-elements of Metadata Creation,
Metadata Last Revision, Metadata Future Review, and Metadata Delete
describe the metadata dates and the sub-elements of Data Creation,
Data Last Revision, Data Future Review, Data Delete describe the
resource dates.



Mapping

DIF 9 N/A
IDIF/Metadata_Dates/Data_Creation
DIE 10 IDIF/Metadata_Dates/Data_Last_Revision
IDIF/Metadata_Dates/Data_Future Review
IDIF/Metadata Dates/Data Delete
SERF N/A
ECHO 10 /CoIIect!on/InsertTlme
Collection /Collection/LastUpdate
/Collection/DeleteTime
ECHO 10 /Granule/lnsertTime
Granule /Granule/LastUpdate
/Granule/DeleteTime
/
gmi:MI|_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentificatio
n/gmd:citation/gmd:Cl_Citation/gmd:date/gmd:Cl_Date/gmd:date/g
co:DateTime
1SO° | with
19115-2 /
gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentificatio
n/gmd:citation/gmd:Cl_Citation/gmd:date/gmd:Cl_Date/gmd:dateTy
pe/gmd:Cl_DateTypeCode codeListValue varies.
/
mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentificatio
n/mri:citation/cit:Cl_Citation/cit:date/cit:Cl_Date/cit:date/gco:DateT
ime
ISO with
19115-1 |/
mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentificatio
n/mri:citation/cit:Cl_Citation/cit:date/cit:Cl_Date/cit:dateType/cit:ClI
_DateTypeCode codeList="codeListLocation#Cl_DateTypeCode"
codeListValue varies.
EMS N/A
Examples
DIF 10

<Metadata_Dates>

<Data_ Creation>2015- 01-01</Data_Creation>
<Data_Last_Revision>2015- 01-01</Data_Last_Revision>
<Data Future Review>2026- 05-12</Data Future Review>




| </Metadata_Dates>

ECHO 10 Caollection

<lnsertTime>2008- 12-02T00:00:00.000Z</InsertTime>

<LastUpdate>2008- 12-02T00:00:00.000Z</L astUpdate>

ECHO 10 Granule

<InsertTime>2011- 09-07T06:07:24Z</InsertTime>
<LastUpdate>2012- 10-31T20:33:38Z</LastUpdate>

SO 19115-2

<gmd:date>
<gmd:Cl_Date>
<gmd:date>
<gco:DateTime>2008- 06-03T00:00:00.000Z</gco:DateTime>
</gmd:date>
<gmd:dateType>
<gmd:Cl_DateTypeCode
codeList="http://www.isotc211.0rg/2005/resources/Codelist/gmxCodelists.xml
#Cl_DateTypeCode"
codeListValue="revision">revision</gmd:Cl_DateTypeCode>
</gmd:dateType>
</gmd:Cl_Date>
</gmd:date>

<gmd:date>

<gmd:Cl_Date>




<gmd:date>
<gco:DateTime>2005- 06-01T00:00:00.000Z</gco:DateTime>
</gmd:date>
<gmd:dateType>
<gmd:Cl_DateTypeCode
codeList="http://www.isotc211.0rg/2005/resources/Codelist/gmxCodelists.xml
#Cl_DateTypeCode"
codeListValue="creation">creation</gmd:Cl_DateTypeCode>

</gmd:dateType>

</gmd:Cl_Date>

</gmd:date>

SO 19115-1

<cit:date>
<cit:Cl_Date>
<cit:date>
<gco:DateTime>2008- 12-02T00:00:00Z</gco:DateTime>
</cit:date>
<cit:dateType>
<cit:Cl_DateTypeCode
codeList="codeListLocation#CIl_DateTypeCode"
codeListValue="revision">revision</cit:Cl_DateTypeCode>
</cit:dateType>

</cit:Cl_Date>

</cit:date>




<cit:date>
<cit:Cl_Date>
<cit:date>
<gco:DateTime>2008- 12-02T00:00:00Z</gco:DateTime>
</cit:date>
<cit:dateType>
<cit:Cl_DateTypeCode
codeList="codeListLocation#Cl_DateTypeCode"
codeListValue="creation">creation</cit:Cl_DateTypeCode>
</cit:dateType>

</cit:Cl_Date>

</cit:date>

Source Data Information:

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1246144386-
SCIOPS

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C179003030-
ORNL_DAAC

ECHO 10 Granule -
https://cmr.earthdata.nasa.gov:443/search/concepts/G1223690990- ASF

ISO 19115-2 -
https://cmr.earthdata.nasa.gov:443/search/concepts/C179003030-
ORNL_DAAC.iso

ISO 19115-1 — Example based on 1S019139t019115- 3.xsl translation of 1SO
19115- 2 record

A.B.8 Related URL
Element Specification




RelatedURL (0..*)
RelatedURL/URL (1)
RelatedURL/Description (0..1)

RelatedURL/URLContentType (1) <CollectionURL, PublicationURL,
DataCenterURL, DistributionURL, DataContactURL, VisualizationURL >

RelatedURL/Type (1) {Valid values shown below}
RelatedURL/Subtype (0..1) {Valid values shown below}
RelatedURL/GetData (0..1)

RelatedURL/GetData/Format (1) <"ascii", "binary”, "GRIB", "BUFR",
"HDF4", "HDF5", "HDF- EOS4", "HDF-EOS5", "jpeg", "png", "tiff", "geotiff",
"kml", "Not provided">

RelatedURL/GetData/Size (1)

RelatedURL/GetData/Unit (1) <"KB", "MB", "GB", "TB", "PB">
RelatedURL/GetData/Fees (0..1)

RelatedURL/GetData/Checksum (0..1)

RelatedURL/GetService (0..1)

RelatedURL/GetService/MimeType (1) {Valid values shown below}

RelatedURL/GetService/Protocol (1) <"ESI", "FTP", "FTPS", "HTTP",
"HTTPS", "OPeNDAP", "WCS", "WMS", "Not provided">

RelatedURL/GetService/FullName (1)
RelatedURL/GetService/DatalD (1)

RelatedURL/GetService/DataType (1)

RelatedURL/GetService/URI (0..*)



Vaid Values for

URLContentType

o Type
= Subtype

DistributionURL

GET DATA
DATACAST URL
EARTHDATA SEARCH
ECHO
EDG
EOSDIS DATA POOL
GDS
GIOVANNI
KML
LAADS
LANCE
LAS
MIRADOR
MODAPS
NOAA CLASS
ON-LINE ARCHIVE
REVERB

GET SERVICE
ACCESS MAP VIEWER
ACCESS MOBILE APP
ACCESS WEB SERVICE
DIF
MAP SERVICE
NOMADS
OPENDAP DATA
OPENDAP DATA

(DODS)

OPENDAP DIRECTORY

(DODS)

OpenSearch

SERF

SOFTWARE PACKAGE
SSW

SUBSETTER
THREDDS CATALOG
THREDDS DATA
THREDDS DIRECTORY

CollectionURL

o DATA SET LANDING PAGE

o DOI

o EXTENDED METADATA

0o PROFESSIONAL HOME

PAGE

PROJECT HOME PAGE

PublicationURL

o VIEW RELATED
INFORMATION

= ALGORITHM THEORETICAL

BASIS DOCUMENT

= CALIBRATION DATA

DOCUMENTATION

= CASE STUDY

= DATA QUALITY

= DATA USAGE

= DELIVERABLES CHECKLIST

= GENERAL

DOCUMENTATION

= HOW-TO

= PI DOCUMENTATION

= PROCESSING HISTORY

= PRODUCTION VERSION

HISTORY

= PRODUCT QUALITY

ASSESSMENT

= PRODUCT USAGE

= PRODUCT HISTORY

= PUBLICATIONS

= RADIOMETRIC AND

GEOMETRIC CALIBRATION

METHODS

= READ-ME

= RECIPE

* REQUIREMENTS AND

DESIGN

= SCIENCE DATA PRODUCT

SOFTWARE DOCUMENTATION

o



. WEB COVERAGE
SERVICE (WCS)

] WEB FEATURE
SERVICE (WFS)

= WEB MAP FOR TIME = SCIENCE DATA PRODUCT
SERIES VALIDATION

] WEB MAP SERVICE = USER FEEDBACK
(WMS) = USER'S GUIDE

] WORKFLOW (SERVICE e DataCenterURL
CHAIN) o HOME PAGE
VisualizationURL DataContactURL

0 GET RELATED o HOME PAGE

VISUALIZATION

] GIBS

. GIOVANNI

= MAP

Valid values for RelatedURL/GetService/MimeType:

e application/json e application/pdf

e application/xml e application/x- hdf

e application/x- netcdf e application/xhdf5

e application/gml+xml e application/octet- stream

e application/vnd.google- e application/vnd.google-
earch.kml+xml earth.kmz

e image/gif e image/jpeg

e image/tiff e image/png

e image/bmp e image/vnd.collada+xml

e text/csv e text/html

e text/xml e text/plain

Description

This element describes any resource-related URLs that include project
home pages, resource information pages, services, related data,
archives/servers, metadata extensions, direct links to online software
packages, web mapping services, links to images, documents, or other data.
When filling out this element URLContentType, Type are required -
Description and Subtype are optional. |If the URLContentType is
"DistributionURL" and the Type is "GET DATA", then the
RelatedURL/GetData  sub-elements are also filled out. If the



URLContentType is "DistributionURL" and the Type is "GET SERVICE",
then the RelatedURL/GetService sub-elements are also filled out.

e RelatedURL - contains URLs to data or services (e.g. Distribution
URLS).

e GetData - information about the data (e.g. format, size, units, fees,
checksum).

e GetService - contains URIs to data via services and information about
the data and service (e.g. mime type, protocol, name, data IDs, data

type).
The valid values for Type and Subtype were derived and tailored from the
GCMD RelatedURL Type and Subtype elements. We looked at these values,
categorized them, removed duplicates, and tailored them while preserving
the mapping between the type and sub-type. It is our intent to work with
GCMD and get back to a single set of values that can be controlled through
the KMS.

Note: The Distribution class has now been subsumed into the GetData class.

Some use Examples:

| have a DAAC Home page that | would like to put into the metadata:
RelatedURL/URL = http://www.daachomepage.gov
RelatedURL/Description = The DAAC home page
RelatedURL/URLContentType = DataCenterURL

RelatedURL/Type = HOME PAGE

RelatedURL/Subtype =

| have a file that | can distribute to whomever is interested:
RelatedURL/URL = http://www.daachomepage.gov/path/downloadable.doc

RelatedURL/Description = some downloadable resource



RelatedURL/URLContentType = DistributionURL
RelatedURL/Type = GET DATA

RelatedURL/Subtype = ON-LINE ARCHIVE
RelatedURL/GetData/Format = application/msword

RelatedURL/GetData/Size = 40
RelatedURL/GetData/Unit = MB
RelatedURL/GetData/Fees = 0

RelatedURL/GetData/Checksum = f5d30a4f2

| have a service that | can distribute a sub-setted variable:
RelatedURL/URL = http://oco2.gesdisc.eosdis.nasa.gov/opendap/
RelatedURL/Description = An OPeNDAP page to get data through a service
RelatedURL/URLContentType = DistributionURL

RelatedURL/Type = GET SERVICE

RelatedURL/Subtype = OPENDAP DATA
RelatedURL/GetService/MimeType = application/x- netcdf
RelatedURL/GetService/Protocol = http

RelatedURL/GetService/FullName = OCO2_L1B_Science.7r
RelatedURL/GetService/DatalD = OCO2_L1B_Science.7r

RelatedURL/GetService/DataType = nc4

RelatedURL/GetService/URI =
http://oco2.gesdisc.eosdis.nasa.gov/opendap/OCO2_L1B_Science.7r/2015/01
5/0co2_L1bScND_02879a 150115 _B7000r_150616093751.h5.nc4?
_SoundingGeometry_sounding_latitude[0:1:8363]
[0:1:7],_SoundingGeometry_sounding longitude[0:1:8363][0:1:7]

RelatedURL/GetService/URI =
http://oco2.gesdisc.eosdis.nasa.gov/opendap/OCO2_L1B_Science.7r/2015/01



5/0co2_L1bScND_02879a 150115 B7000r_150616093751.h5.nc4?
_SoundingGeometry_sounding_latitude[0:8363]
[0:7],_SoundingGeometry_sounding_longitude[0:8363][0:7]
RelatedURL/GetService/URI =
http://oco2.gesdisc.eosdis.nasa.gov/opendap/OCO2_L1B_Science.7r/2015/01
5/0co2_L1bScND_02879a 150115 B7000r_150616093751.h5.nc4?

_SoundingGeometry_sounding_latitude, SoundingGeometry sounding_longi
tude

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*

Analysis

Related online resource information is found in both GCMD and ECHO.

ECHO (ECHO10) has OnlineAccessURL, OnlineResource,
AssociatedBrowsel mages, and AssociatedBrowselmageURLSs:

e OnlineAccessURL - stores the online URL(s) for present granules. Those
URLs either provide the site where granule data can be obtained or instruct
the user on how to obtain the granule data.

» AssociatedBrowselmageURLS - contains URLs to browse imagery.

GCMD (DIF 9/10) has RelatedURL and MultimediaSample:

* Related_URL - element provides both documentation and dataset links and
they are differentiated by the Related URL/URLContentType sub-element.



This value is hierarchical using type and sub type elements to organize the
kinds of URLs associated with collection metadata.

* Multimedia _Sample - allows the author to provide information that will

enable the display of a sample image, movie, or sound clip within the DIF
9/10.

Mapping

DIF 9 DIF/Related_URL
DIF/Multimedia_Sample

DIF/Distribution

DIF 10 DIF/Related_URL
DIF/Multimedia_Sample

DIF/Distribution

SERF SERF/Related_URL

SERF/Multimedia_Sample

ECHO 10 V/Collection/OnlineAccessURLs/OnlineAccessURL
Collection
Collection/AssociatedBrowsel mageUrls
Collection/OnlineResources

Collection/Price

Collection/DataFormat

ECHO 10 /Granule/OnlineAccessURL s/OnlineAccessURL
Granul e
Granule/OnlineResources/OnlineResource

Granule/AssociatedBrowsel mageUrls

SO
19115-2 gmi:MI_Metadata/gmd:distributionlnfo/gmd:MD_Distribution/gm
d:distributor/gmd:MD_Distributor/gmd:distributorTransferOption
s/gmd:MD_Digital TransferOptions/gmd:onLine/gmd:Cl_OnlineRe
source




and/or
gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_Dataldentifica
tion/gmd:graphicOverview/gmd:MD_BrowseGraphic/gmd:fileNa
me/gmx:FileName src=

SO

19115-1 mdb:MD_Metadata/mdb:distributioninfo/mrd:MD_Distribution/m
rd:distributor/mrd:MD_Distributor/mrd:distributorTransferOptio
ns/mrd:MD_Digital TransferOptions/mrd:online/cit:Cl_OnlineReso
urce
and/or
mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentifica
tion/mri:graphicOverview/mcc:MD_BrowseGraphic/mcc:filename
gex:FileName/@src=

EMS N/A

Examples

DIF 9

<Related URL >
<URL_Content_Type uuid="6e72d128- 7d28- 4bd0- bac0- 8c5ffd8b31f1" >
<Type>VIEW PROJECT HOME PAGE</Type>
</URL_Content_Type>
<URL >http://www.waisdivide.unh.edu/</URL >
</Related_URL>
<Related URL >

<URL_Content_Type uuid="5eclbb9d- Oefc-4099-9b31-
ec791bbd8145" >

<Type>VIEW RELATED INFORMATION</Type>




</URL_Content_Type>
<URL >http:// www.homepage.montana.edu/~lkbonney/</URL >
<Description>
Website for the Priscu Research Group
</Description>

</Related_URL>

<Multimedia_Sample>

<URL>http://www.waisdivide.unh.edu/images/sitemapl_large.jpg</URL >

</Multimedia_Sample>

DIF 10

<Multimedia_Sample>

<URL >http://disc.gsfc.nasa.gov/AIRS/images/G1932015.04.19allL1CBright
nessTemperature_K _at10.9microns_map.png</URL>
<Format>PNG</Format>
<Caption>The BT derived from an AIRS Level 1C granule for a
channel at 10.9 microns.</Caption>
<Description>Sample image of an AIRICRAD channel converted to
brighness temperature</Description>
</Multimedia_Sample>

<Related URL >
<URL_Content_Type>
<Type>GET DATA</Type>
<Subtype>ON- LINE ARCHIVE</Subtype>
</URL_Content_Type>

<URL >http://airsl1.gesdisc.eosdis.nasa.gov/data/Aqua_AIRS Levell/AIRIC
RAD.006/</URL >

<Description>Access the data via HTTP.</Description>
</Related_URL >




<Related URL >
<URL_Content_Type>
<Type>GET DATA</Type>
<Subtype>MIRADOR</Subtype>
</URL_Content_Type>
<URL>http://mirador.gsfc.nasa.gov/cgi- bin/mirador/homepageAlt.pl?
keyword=AIRICRAD</URL >
<Description>Mirador is a data search interface that allows
searching, browsing, and retrieving of Earth science data archived at
NASA GES DISC.</Description>
</Related_URL>
<Related URL>
<URL_Content_Type>
<Type>GET DATA</Type>
<Subtype>OPENDAP DATA</Subtype>
</URL_Content_Type>

<URL >http://airsl1.gesdisc.eosdis.nasa.gov/opendap/Aqua _AIRS Level1/Al
RICRAD.006/contents.html</URL >
<Description>Access the data via the OPeNDAP
protocol.</Description>
</Related_URL >

<Related URL >
<URL_Content_Type>
<Type>GET DATA</Type>
<Subtype>EARTHDATA SEARCH</Subtype>
</URL_Content_Type>
<URL>https://search.earthdata.nasa.gov/search?
g=AIRICRAD+006</URL >
<Description>Use the Earthdata Search Client (EDSC) to find and
retrieve data sets across multiple data centers.</Description>
</Related_URL >

SERF

<Related URL >
<URL_Content_Type uuid="ca8b62c9- 5f31-40bd- 92a9- 8d30081309e2" >

<Type>GET SERVICE</Type>




<Subtype>GET SOFTWARE PACKAGE</Subtype>
</URL_Content_Type>
<URL>http://www.mezogis.org/download.html</URL >
<Description>
Download mezoGIS.
</Description>
</Related_URL >
<Related URL >
<URL_Content_Type uuid="ca04650e- 9e65- 4ce6- 93ac- 597b77afcbha6" >
<Type>GET RELATED SERVICE METADATA (SERF)</Type>
</URL_Content_Type>
<URL >http://gcmd.nasa.gov/getserf.htm?POSTGIS</URL >
<Description>
Get metadata for PostGIS: Geographic Objects for PostgreSQL.
</Description>

</Related_URL >

<Multimedia_Sample>

<URL >http://www.mezogis.org/pictures/screenshot_22 03_06.jpg</URL >

<Format>JPEG</Format>

</Multimedia_Sample>

ECHO 10 Collection




<OnlineAccessURL s>
<OnlineAccessURL >

<URL >http://sedac.ciesin.columbia.edu/data/set/ulandsat- cities- from-
space/data- download</URL >

<URLDescription>data download page</URLDescription>
</OnlineAccessURL >
</OnlineAccessURL s>
<OnlineResources>
<OnlineResource>
<URL >http://dx.doi.org/10.7927/H4SQ8XB1</URL >
<Description>data set DOl and homepage</Description>
<Type>DOIl URL</Type>
</OnlineResource>

</OnlineResources>

<AssociatedBrowselmageUrl s>
<ProviderBrowseUrl|>

<URL >http://sedac.ciesin.columbia.edu/data/set/ulandsat- cities- from-
space/maps</URL >

</ProviderBrowseUrl| >

</AssociatedBrowsel mageUrls>

ECHO 10 Granule

<OnlineAccessURL s>
<OnlineAccessURL >




<URL >https://datapool.asf.alaska.edu/GEOTIFF/SS/SS_00107_STD_F0373
_tif.zip</URL >

</OnlineAccessURL >

</OnlineAccessURL s>
<Orderable>true</Orderable>
<Visible>true</Visible>
<AssociatedBrowselmageUrls>
<ProviderBrowseUrl| >

<URL >https://datapool.asf.alaska.edu/BROWSE/SS/SS_00107_STD_F0373
 BROWSE.jpg</URL >
</ProviderBrowseUrl| >
</AssociatedBrowsel mageUrls>

SO 19115-2

<gmd:onLine>
<gmd:Cl_OnlineResource>
<gmd:linkage>

<gmd:URL >http://sedac.ciesin.columbia.edu/data/set/ulandsat-
cities- from- space/data- download</gmd:URL >

</gmd:linkage>
<gmd:applicationProfile gco:nilReason="missing"/>
<gmd:description>

<gco:CharacterString>data download
page</gco:CharacterString>

</gmd:description>
<gmd:function>
<gmd:Cl_OnLineFunctionCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.

xml#CIl_OnLineFunctionCode"
codeListValue="download">download</gmd:CIl_OnLineFunctionCode>




</gmd:function>
</gmd:CIl_OnlineResource>
</gmd:onLine>
<gmd:onLine>
<gmd:Cl_OnlineResource>
<gmd:linkage>
<gmd:URL >http://dx.doi.org/10.7927/H4SQ8XB1</gmd:URL >
</gmd:linkage>
<gmd:applicationProfile gco:nilReason="missing"/>
<gmd:name>
<gco:CharacterString>DOIl URL</gco:CharacterString>
</gmd:name>
<gmd:description>

<gco:CharacterString>data set DOI and
homepage</gco:CharacterString>

</gmd:description>
<gmd:function>
<gmd:Cl_OnLineFunctionCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#Cl_OnLineFunctionCode" codeListValue=""/>
</gmd:function>

</gmd:CIl_OnlineResource>

</gmd:onLine>




<gmd:graphicOverview>
<gmd:MD_BrowseGraphic>
<gmd:fileName>
<gmx:FileName
src="http://sedac.ciesin.columbia.edu/data/set/ulandsat- cities- from-
space/maps"/>
</gmd:fileName>
<gmd:fileDescription>
<gco:CharacterString>File Size:</gco:CharacterString>

</gmd:fileDescription>

<gmd:fileType gco:nilReason="missing"/>

</gmd:MD_BrowseGraphic>

SO 19115-1

<mrd:onLine>
<cit:Cl_OnlineResource>

<cit:linkage>
<gco:CharacterString>http://sedac.ciesin.columbia.edu/data/set/ulandsat-
cities- from- space/data- download</gco:CharacterString>

</cit:linkage>

<cit:applicationProfile gco:nilReason="missing"/>

<cit:description>

<gco:CharacterString>data download
page</gco:CharacterString>




</cit:description>
<cit:function>
<cit:Cl_OnLineFunctionCode
codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/schema/reso
urces/Codelist/gmxCodelists.xml#CIl_OnLineFunctionCode"
codeListValue="download">download</cit:Cl_OnLineFunctionCode>
</cit:function>
</cit:Cl_OnlineResource>
</mrd:onLine>
<mrd:onLine>
<cit:Cl_OnlineResource>
<cit:linkage>
<gco:CharacterString>http://dx.doi.org/10.7927/H4SQ8XB1</gco:Charact
erString>
</cit:linkage>
<cit:applicationProfile gco:nilReason="missing"/>
<cit:name>

<gco:CharacterString>DOlI
URL </gco:CharacterString>

</cit:name>
<cit:description>

<gco:CharacterString>data set DOI and
homepage</gco:CharacterString>

</cit:description>




<cit:function>
<cit:Cl_OnLineFunctionCode
codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/schema/reso
urces/Codelist/gmxCodelists.xml#Cl_OnLineFunctionCode"
codeListValue=""/>
</cit:function>

</cit:Cl_OnlineResource>

</mrd:onLine>

<mri:graphicOverview>
<mcc:MD_BrowseGraphic>
<mcc:fileName>
<gcx:FileName
src="http://sedac.ciesin.columbia.edu/data/set/ulandsat- cities- from-
space/maps"/>
</mcc:fileName>
<mcc:fileDescription>
<gco:CharacterString>File Size:</gco:CharacterString>
</mcc:fileDescription>

<mcc:fileType gco:nilReason="missing"/>

</mcc:MD_BrowseGraphic>

</mri:graphicOverview>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591041-
SCIOPS



DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1243477379-
GES_DISC
SERF - http://gcmd.gsfc.nasa.gov/mws/serf/mezoGIS

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C179001954- SEDAC
ECHO 10 Granule -
https://cmr.earthdata.nasa.gov:443/search/concepts/G1001055217- ASF

ISO 19115-2 -
https://cmr.earthdata.nasa.gov:443/search/concepts/C179001954-
SEDAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

A.B.9 Online Resource
Element Specification

OnlineResource/ (0..1)
OnlineResource/Linkage (1)
OnlineResource/Protocol (0..1)

OnlineResource/ApplicationProfile (0..1)
OnlineResource/Name (1)

OnlineResource/Description (1)

OnlineResource/Function (0..1)

Description

This element describes any online resource which includes citations,
publications or references. This element is analogous to
Cl_Online_Resource from EN ISO 19115-1:2014 Geographic Information —
Metadata — Part 1: Fundamentals. This element is not a base element but
will be included as a sub-element of resource citation and publication
reference. Any mapping to the OnlineResource sub-element will be
accomplished through the main element, therefore the mapping section is
omitted.

A.B.10 Resource Citation
Element Specification



ResourceCitation/Creators (0..1)
ResourceCitation/Editors (0..1)
ResourceCitation/Title (0..1)
ResourceCitation/SeriesName (0..1)
ResourceCitation/ReleaseDate (0..1)
ResourceCitation/ReleasePlace (0..1)
ResourceCitation/Publisher (0..1)
ResourceCitation/Version (0..1)
ResourceCitation/Issueldentification (0..1)
ResourceCitation/DataPresentationForm  (0..1)
ResourceCitation/OtherCitationDetails (0..1)
ResourceCitation/OnlineResource (0..1) - {See OnlineResource for full
specification}

Description

This element instructs the user how to properly cite the provider and
specifies how the resource should be cited in professional scientific
literature.

This element provides a citation for the item itself, and is not designed for
listing bibliographic references of scientific research articles arising from
search results. A list of references related to the research results should be

in the Publication Reference element. The DataPresentationForm
vocabulary is currently not controlled.

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*

Analysis

Citation information is found in DIF 9, DIF 10, SERF, and ECHO. The
following elements map to this mapping:



Originators -> Either Creator or Editor - The name of the organization(s) or
individual (s)

with primary intellectual responsibility for the resource's development.
Title -> Title - The Title of the resource; this is the same as Entry Title.
Release Date -> ReleaseDate - The date the resource was made available
for release.

Provider -> Publisher - The name of the individual or organization that
released the resource.

Edition -> Version - The edition or version of the resource.

URL -> RelatedUrl



Mapping

DIF 9 DIF/Data_Set_Citation/

DIF 10 DIF/Dataset_Citation/

SERF SERF/Service_Citation/

ECHO 10 /Collection/CitationForExternal Publication
Collection

ECHO 10 N/A

Granule

SO

19115-2 gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentification/g
md:citation/gmd:Cl_Citation

SO
19115-1 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/
mri:citation/cit:Cl_Citation

EMS N/A
Examples
DIF 9

<Data_Set_ Citation>
<Dataset_Creator>Fastook, J. L.</Dataset_Creator>
<Dataset_Title>Amundsen Sea Sector Data Set</Dataset_Title>
<Dataset_Series_Name>NSIDC-0312</Dataset_Series_Name>
<Dataset_Release _Date>2007- 01-01</Dataset_Release _Date>
<Dataset_Release Place>Boulder, Colorado USA</Dataset Release_ Place>
<Dataset_Publisher>NSIDC: National Snow and Ice Data
Center</Dataset_Publisher>
<Version>1</Version>
<Dataset_DOI>do0i:10.7265/N5J9649Q</Dataset_DOI >
<Online_Resource>http://nsidc.org/data/NSIDC- 0312</Online_Resource>
</Data_Set_Citation>

DIF 10

<Dataset_Citation>
<Dataset_Creator>AIRS Science Team/Joao Texeira</Dataset_Creator>
<Dataset_Title>AIRS/Aqua L2 CO2 in the free troposphere (AIRS+AMSU)
VO0O5</Dataset_Title>
<Dataset_Series_Name>AIRX2STC</Dataset_Series_Name>
<Dataset Release Date>2010- 01-0l1</Dataset Release Date>




<Dataset_Release_Place>Greenbelt, MD, USA</Dataset_Release_Place>
<Dataset_Publisher>Goddard Earth Sciences Data and Information Services
Center (GES DISC)</Dataset_Publisher>
<Version>005</Version>
<Data_Presentation_Form>Digital Science Data</Data_Presentation_Form>
<Persistent_ldentifier>
<Type>DOI</Type>
<ldentifier>10.5067/AQUA/AIRS/DATA218</ldentifier>
</Persistent_ldentifier>

<Online_Resource>http://disc.gsfc.nasa.gov/datacollection/AIRX2STC_005.html
</Online_Resource>
</Dataset Citation>

SERF

<Service_Citation>
<Originators>Frederic Back</Originators>

<Title>mezoGIS: A GIS Application and Graphical Interface To Query
and Analyze Spatial Data</Title>

<Release_Date>2006</Release_Date>

<URL >http://www.mezogis.org/index.html</URL >

<Service Citation>

ECHO 10 Caollection

<CitationForExternal Publication>Wood, E. F. 1994. 15 Minute Stream
Flow Data: USGS (FIFE). Data set. Available on-line
[http://www.daac.ornl.gov] from Oak Ridge National Laboratory
Distributed Active Archive Center, Oak Ridge, Tennessee, U.S.A. Also
published in D. E. Strebel, D. R. Landis, K. F. Huemmrich, and B. W.
Meeson (eds.), Collected Data of the First ISLSCP Field Experiment, Vol. 1:
Surface Observations and Non-Image Data Sets. CD-ROM. National
Aeronautics and Space Administration, Goddard Space Flight Center,
Greenbelt, Maryland, U.S.A. (available from http://www.daac.ornl.gov).
doi:10.3334/ORNLDAAC/1</CitationForExternal Publication>




SO 19115-2

<gmd:citation>
<gmd:CIl_Citation>
<gmd:title>
<gco:CharacterString>CIESIN_CHRR_NDH_CYCLONE_HFD
& gt; Global Cyclone Hazard Frequency and
Distribution</gco:CharacterString>

</gmd:title>

<gmd:date>

</gmd:date>

<gmd:edition>

</gmd:edition>

<gmd:identifier>

</gmd:identifier>
<gmd:otherCitationDetails>

<gco:CharacterString>Center for Hazards and Risk Research -
CHRR - Columbia University, Center for International Earth Science
Information Network - CIESIN - Columbia University, International Bank
for Reconstruction and Development - The World Bank, and United Nations
Environment Programme Global Resource Information Database Geneva -
UNEP GRID-Geneva. 2005. Global Cyclone Hazard Frequency and
Distribution. Palisades, NY:NASA Socioeconomic Data and Applications
Center (SEDAC).

http://dx.doi.org/10.7927/H4CZ353K </gco:CharacterString>




</gmd:otherCitationDetails>

</gmd:Cl_Citation>

</gmd:citation>

SO 19115-1

<mri:citation>
<cit:Cl_Citation>
<cit:title>
<gco:CharacterString>CIESIN_CHRR_NDH_CYCLONE_HFD
& gt; Global Cyclone Hazard Frequency and
Distribution</gco:CharacterString>

</cit:title>

<cit:date>

</cit:date>

<cit:edition>

</cit:edition>

<cit:identifier>

</cit:identifier>
<cit:otherCitationDetail s>

<gco:CharacterString>Center for Hazards and Risk Research -
CHRR - Columbia University, Center for International Earth Science
Information Network - CIESIN - Columbia University, International Bank
for Reconstruction and Development - The World Bank, and United Nations




Environment Programme Global Resource Information Database Geneva -
UNEP GRID-Geneva. 2005. Global Cyclone Hazard Frequency and
Distribution. Palisades, NY:NASA Socioeconomic Data and Applications
Center (SEDAC).

http://dx.doi.org/10.7927/H4CZ353K </gco:CharacterString>

</cit:otherCitationDetail s>

</cit:Cl_Citation>

</mri:citation>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1219224107-
NSIDCVO

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1243477314-
GES _DISC

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/mezoGIS
ECHO 10 Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179003030- ORNL_DAAC

ISO 19115-2 - https://cmr.earthdata.nasa.gov/search/concepts/C179001766-
SEDAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of ISO
19115- 2 record

A.B.11 Quality
Element Specification

QualityAssessment

Description

This element permits the author to provide the following information about
a resource (collection, granule, service, etc.) described in the metadata: 1)
Quality of the resource, and 2) any quality assurance procedures followed in
producing the resource. Examples of appropriate element information



include: A) succinct description; B) indicators of resource quality or quality
flags - both validated, invalidated, or unvalidated; C) recognized or potential
problems with quality; D) established quality control mechanisms; and E)
established quantitative quality measurements.

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..1

Analysis

This element is found only in GCMD and its value is an uncontrolled block of
text describing the quality assessment. Both 1SO conventions (19115-1 & 2)
have sub-fielded text that more precisely describe the quality assessment of
a resource. Please refer to 1SO 19157 (Geographic information — Data
quality) for more information about data quality in 1SO.

Mapping

DIF 9 DIF/Quality

DIF 10 DIF/Quality

SERF SERF/Quality

ECHO 10 N/A

Collection

ECHO 10 N/A

Granule

1SO

19115-2 gmi:MI_Metadata/gmd:dataQualitylnfo/ gmd:DQ_DataQuality/gmd:report/g
md:DQ_QuantitativeAttributeAccuracy/gmd:evaluationMethodDescription/gco:Cha
racterString

ISO mdb:MD_Metadata/mdb:dataQualitylnfo

19115-1
or




mdb:MD_Metadata/mdb:dataQualitylnfo/mdq:DQ_DataQuality/mdq:r
eport/mdq:DQ_DomainConsistency/mdq:result/mdq:DQ_DescriptiveR
esult/mdq:statement/gco:CharacterString

EMS

N/A




Examples

DIF 9

<Quality>The dates provided in temporal coverage are approximate
only. Years are correct.

See the referenced paper for full details on steps taken to ensure quality of
data.

To assess extraction efficiency for a range of sediment types, four marine
sediments were analysed in detail. Two international certified reference
materials (CRMs) and two well-characterised Antarctic sediments were
chosen to compare and contrast moderately to strongly contaminated
samples (based on total metal digest), with clean samples of similar
matrices. One CRM was an uncontaminated continental shelf mud (MESS-
2), and the other a contaminated harbour mud (PACS-2) (NRCC, 2002).
The two Antarctic sediments were collected as part of a regional
hierarchical survey (Stark et al., 2003). One Antarctic sample was from an
area of known metal pollution in Brown Bay (BB), which is adjacent to the
'Old' Casey Station waste disposal site (Snape et al., 2001; Stark et al.,
2003). The second Antarctic sample was from a non-impacted control site
from O'Brien Bay (OBB), 3 km south of Casey Station and the disposal site
(Fig. 1). The Antarctic samples, OBB and BB, have similar matrices,
proportions of mud (less than 63 microns; 19% and 22% respectively) and
total organic carbon contents (1.9% and 2.3% respectively). Both MESS
and PACS are sieved, homogenised and dried CRMs that have been ground
to ~50 microns (NRCC, 2002). In contrast, OBB and BB were only sieved
to less than 2 mm, thereby removing only the very largest particles (less
than or equal to 3%). The Antarctic samples were collected using acid-
washed PVC coring tubes. The samples were kept frozen at -20 degrees C
until wet-sieved with a small amount of clean filtered (0.45 microns
cellulose nitrate) O'Brien Bay seawater through 2 mm nylon mesh held in a
plastic sieve unit. The sediments were then oven-dried to constant weight
at 103 degrees C (Loring and Rantala 1992), and stored in Nalgene HDPE
bottles until analysis.</Quality>

DIF 10

<Quality>Nucleic extraction blanks were carried out through amplification
steps and sequence analysis quality control measures were followed on
data analyzed. Oceanographic instruments were calibrated at SeaBird
before the cruise and sample blanks were periodically run for chlorophyll
and nutrient analyses.</Quality>




SERF

<Quality>

While some of the data layers included on this site were
originally developed by the AMC, most were derived from existing
data obtained from a wide range of publicly available

sources. Therefore these maps are not guaranteed to be 100%
accurate.

</Quality>




SO 19115-2

<gmd:dataQualitylnfo>
<gmd:DQ_DataQuality>
<gmd:scope>
<gmd:DQ_Scope>
<gmd:level >
<gmd:MD_ScopeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#M D_ScopeCode”
codeListValue="series">series</gmd:MD_ScopeCode>
</gmd:level >
</gmd:DQ_Scope>
</gmd:scope>
<gmd:report>
<gmd:DQ_AccuracyOfATimeMeasurement >
<gmd:measureldentification>
<gmd:MD_Ildentifier>

<gmd:code>

<gco:CharacterString>PrecisionOf Seconds</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>

</gmd:measureldentification>




<gmd:result>
<gmd:DQ_QuantitativeResult>
<gmd:valueUnit/>
<gmd:value>
<gco:Record xsi:type="gco:Real PropertyType">
<gco:Real>1</gco:Real >
</gco:Record>
</gmd:value>
</gmd:DQ_QuantitativeResult>
</gmd:result>
</gmd:DQ_AccuracyOfATimeM easurement>
</gmd:report>
<gmd:lineage>
<gmd:LI_Lineage>
<gmd:processStep>
<gmi:LE_ProcessStep>
<gmd:description gco:nilReason="unknown"/>
<gmd:processor>
<gmd:Cl_ResponsibleParty>

<gmd:organisationName>

<gco:CharacterString>SEDAC</gco:CharacterString>

</gmd:organisationName>




<gmd:role>
<gmd:Cl_RoleCode

codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#Cl_RoleCode"
codeListValue="processor">processor</gmd:Cl_RoleCode>

</gmd:role>

</gmd:Cl_ResponsibleParty>
</gmd:processor>
</gmi:LE_ProcessStep>
</gmd:processStep>
</gmd:LI_Lineage>
</gmd:lineage>

</gmd:DQ_DataQuality>

</gmd:dataQualitylnfo>

SO 19115-1

<mdb:dataQualitylnfo>
<mdq:DQ_DataQuality>
<mdq:scope>
<mcc:MD_Scope>
<mcc:level >
<mcc:MD_ScopeCode

codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/schema/reso
urces/Codelist/gmxCodelists.xml#M D _ScopeCode"




codeListValue="series">series</mcc:MD_ScopeCode>
</mcc:level >
</mcc:MD_Scope>
</mdq:scope>
<mdq:report>
<mdq:DQ_DomainConsistency>
<mdgq:result>
<mdq:DQ_DescriptiveResult>
<mdq:statement>
<gco:CharacterString>Taxonomy has been checked against
ITIS, Catalogue of Life and World Register of Marine Species
databases</gco:CharacterString>
</mdq:statement >
</mdq:DQ_DescriptiveResult>
</mdq:result>
</mdq:DQ_DomainConsistency >
<mdq:DQ_AccuracyOfATimeMeasurement >
<mdq:measure>
<mdq:DQ_MeasureReference>
<mdq: measureldentification>
<mcc:MD_ldentifier>

<mcc:code>

<gco:CharacterString>PrecisionOfSeconds</gco:CharacterString>




</mcc:code>
</mcc:MD_Identifier>
</mdq:measureldentification>
</mdq:DQ_MeasureReference>
</mdq:measure>
<mdq:evaluationMethod>
<mdq:DQ_Fulllnspection>
<mdq:evaluationProcedure/>
</mdqg:DQ_Fulllnspection>
</mdq:evaluationM ethod>
<mdq:result>
<mdq:DQ_QuantitativeResult>
<mdq:value>
<gco:Record xsi:type="gco:Real_PropertyType">
<gco:Real>1</gco:Real >
</gco:Record>
</mdg:value>
<mdq:valueUnit/>
</mdq:DQ_QuantitativeResult>
</mdgq:result>
</mdq:DQ_AccuracyOfATimeM easurement>

</mdq:report>




</mdq:DQ_DataQuality>

</mdb:dataQualitylnfo>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214305813-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1232343424-
SCIOPS

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/AMC_Interactive_Mapping

ISO 19115-2 - https://cmr.earthdata.nasa.gov/search/concepts/C179001954-
SEDAC.iso

ISO 19115-1 — Example based on 1S019139t019115- 3.xsl translation of 1SO
19115- 2 record and everything within the mdq:DQ_DomainConsistency
element is manually generated from DIF 9 record.

Recommendations

The CMR team recommends that a future focus group explore the
possibility of enhancing the element to include controlled vocabulary and
structured sub-elements. This would align the Quality element more with
1SO19157 (Geographic information - Data quality). We would also
potentially be incorporating recommendations emerging from the BEDI/CDI
metadata quality efforts. It is also recommended that the 1SO 19115-1
translation be changed into a descriptive report just as in the example
within the mdq:DQ_DomainConsistency element.



A.B.12 Use Constraints

Element Specification

UseConstraints

Description

The UseConstraints element 1is designed to protect privacy and/or
intellectual property by allowing the author to specify how the item
(collection, granule, service, visualization, etc.) may or may not be used
after access 1s granted. This includes any special restrictions, legal
prerequisites, terms and conditions, and/or limitations on using the item.
Providers may request acknowledgement of the item from users and claim
no responsibility for quality and completeness. Note: UseConstraints
describes how the item may be used once access has been granted; and is
distinct from AccessConstraints, which refers to any constraints in
accessing the item.

Profile Utilization

Collection, Granule, Service, Visualization, Document

Cardinality

0..1

Analysis

This element's value is an uncontrolled block of text describing the use
constraint.

Mapping

| DIF 9 | /DIF/Use Constraints




DIF 10

/DIF/Use Constraints

SERF /SERF/Use Constraints

ECHO N/A

10

Collecti

on

ECHO N/A

10

Granule

ISO /

19115-2 | gmd:MD Metadata/gmd:identificationInfo/gmd:MD_ Dataldentific
ation/gmd:resourceConstraints/gmd:MD LegalConstraints/gmd:us
eLimitation/gco:CharacterString

ISO /

19115-1 | mdb:MD_ Metadata/mdb:identificationInfo/mri:MD _ Dataldentificat
ion/mri:resourceConstraints/mco:MD LegalConstraints/mco:useC
onstraints/mco:MD RestrictionCode/gco:CharacterString

EMS N/A

Examples

DIF 9

<Use Constraints>This data set conforms to the PICCCBY Attribution
[icense

(http://creativecommons.org/licenses/by/3.0/).

Please follow instructions listed in the citation reference provided at
http://data.aad.gov.au/aadc/metadata/citation.cfm?
entry 1id=ASAC 2201 HCL 0.5 when using these data.</Use Constraints>

DIF 10

<Use Constraints>The distribution of this data set is funded by NASA's
Earth Science Enterprise (ESE). The data are not copyrighted; however,
we request that when you publish data or results using these data, please
acknowledge as follows:

The data used in this study were acquired as part of the Tropical Rainfall

Measuring Mission (TRMM). The algorithms were developed by the TRMM
Science Team. The data were processed by the TRMM Science Data and
Information System (TSDIS) and the TRMM Office; they are archived and
distributed by the Goddard Earth Sciences Data and Information Services
Center. TRMM is an international project jointly sponsored by the Japan
National Space Development Agency (NASDA) and the U.S. National




Aeronautics and Space Administration (NASA) Office of Earth Sciences.

Please send a copy of your publication to Help Desk, Goddard Earth
Sciences Data and Information Services Center, Code 610.2, NASA GSFC,
Greenbelt, MD 20771 or email the reference of your publication to gsfc-
hel p- disc@lists.nasa.gov.</Use_Constraints>

SERF

<Use_ Constraints>

The Tool is written in Java and XML and is distributed under the Apache
Public License (version 2).

</Use_Constraints>

SO 19115-2

<gmd:resourceConstraints>
<gmd:MD_L egalConstraints>
<gmd:useLimitation>
<gco:CharacterString>The distribution of this data set is funded by
NASA's Earth Science Enterprise (ESE). The data are not copyrighted;
however, we request that when you publish data or results using these
data, please acknowledge as follows:

The data used in this study were acquired as part of the Tropical Rainfall
Measuring Mission (TRMM). The algorithms were developed by the TRMM
Science Team. The data were processed by the TRMM Science Data and
Information System (TSDIS) and the TRMM Office; they are archived and
distributed by the Goddard Earth Sciences Data and Information Services
Center. TRMM is an international project jointly sponsored by the Japan
National Space Development Agency (NASDA) and the U.S. National
Aeronautics and Space Administration (NASA) Office of Earth Sciences.

Please send a copy of your publication to Help Desk, Goddard Earth
Sciences Data and Information Services Center, Code 610.2, NASA GSFC,
Greenbelt, MD 20771 or email the reference of your publication to gsfc-
hel p- disc@lists.nasa.gov.</gco:CharacterString>

</gmd:useLimitation>

</gmd:MD_L egalConstraints>
</gmd:resourceConstraints>







1SO 19115-1

<mri:resourceConstraints>
<mco:MD_L egalConstraints>
<mri:resourceConstraints>
<mco:MD_LegalConstraints>
<mco:useLimitation>
<gco:CharacterString>The distribution of this data set is funded by
NASA's Earth Science Enterprise (ESE). The data are not copyrighted; however, we
request that when you publish data or results using these data, please acknowledge
as follows:
The data used in this study were acquired as part of the Tropical Rainfall
Measuring Mission (TRMM). The algorithms were developed by the TRMM Science
Team. The data were processed by the TRMM Science Data and Information
System (TSDIS) and the TRMM Office; they are archived and distributed by the
Goddard Earth Sciences Data and Information Services Center. TRMM is an
international project jointly sponsored by the Japan National Space Development
Agency (NASDA) and the U.S. National Aeronautics and Space Administration
(NASA) Office of Earth Sciences.
Please send a copy of your publication to Help Desk, Goddard Earth Sciences Data
and Information Services Center, Code 610.2, NASA GSFC, Greenbelt, MD 20771
or email the reference of your publication to gsfc- help-disc@lists.nasa.gov.
</gco:CharacterString>

</mco:useLimitation>

</mco:MD_LegalConstraints>
</mri:resourceConstraints>

</mco:MD_Legal Constraints>

</mri:resourceConstraints>




Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214305813-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1282032564-
GES DISC

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/met

ISO 19115-2 -
https://cmr.earthdata.nasa.gov/search/concepts/C1282032564-
GES DISC.iso

ISO 19115-1 - Example based on schema with data from DIF 10 record

A.B.13 Access Constraints

Element Specification

AccessConstraints/Description (1)
AccessConstraints/Value (0..1)

Description

The Description sub-element allows the author to provide information
concerning accessing constraints. This includes any special restrictions,
legal prerequisites, limitations and/or warnings on obtaining the data.
Examples of values include: Public, In-house, Limited, and None. The Vaue
sub-element is wused for special access control list (ACL) rules
(http://en.wikipedia.org/wiki/Access_control_list) - for example, to hide
metadata when it isn't ready for public consumption.




Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..1

Analysis

Providers use the AccessConstraint/Value element to specify various
restriction levels with ACLs. For example: A provider might specify a
service Level ACL that hides all items (collections for this example) with a
value element set to '15.0'. There is no controlled mapping for what the
values represent. ECHO has the exact same feature and there are many
ACLs built in off of these types of rules.

Mapping
DIE 9 IDIF/Access_Constraints
/IDIF/Extended Metadata/M etadata
DIE 10 IDIF/Access_Constraints

IDIF/Extended _Metadata/M etadata

SERF | /SERF/Access _Constraints

ECiI(-;O /Collection/RestrictionComment

Co!ﬁcn /Collection/RestrictionFlag

ECthIgO /Granule/RestrictionComment

Granule |/Granule/RestrictionFlag
/
gmi:MI|_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentification/
gmd:resourceConstraints/gmd:MD_LegalConstraints/gmd:useLimitat

SO ion/gco:CharacterString (prefix: 'Restriction Comment:' )
19115-2 |/

gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentification/
gmd:resourceConstraints/gmd:MD_LegalConstraints/gmd:otherConst
raints/gco:CharacterString (prefix: 'Restriction Flag:' )




SO
19115-1

/
mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentification
/mri:resourceConstraints
/mco:MD_LegalConstraints/mco:useLimitation/gco:CharacterString
(prefix:'Restriction Comment: ')

/
mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Datal dentification
/mri:resourceConstraints/mco:MD_LegalConstraints/mco:otherConst
raints/gco:CharacterString (prefix:'Restriction Flag: ")

EMS

N/A




Examples

DIF 9

<Access_Constraints>None</Access_Constraints>

<Extended Metadata>
<Metadata>
<Group>gov.nasa.earthdata.cmr</Group>
<Name>Restriction</Name>
<Value>[0 or 1+]</Value>
</Metadata>
</Extended Metadata>

DIF 10

<Access_Constraints>None. The paper is open
access.</Access_Constraints>

<Extended_ Metadata>
<Metadata>
<Group>gov.nasa.earthdata.cmr</Group>
<Name>Restriction</Name>
<Value>[0 or 1+]</Value>
</Metadata>
</Extended Metadata>

SERF

<Access_Constraints>
There are no fees for training, materials, rubrics, and assessments. Each

participant must complete the online form to access materials.

</Access Constraints>

ECHO 10 Caoallection




<RestrictionFlag>0</RestrictionFlag>

<RestrictionComment>None</RestrictionComment>

ECHO 10 Granule

<RestrictionFlag>0</RestrictionFlag>
<RestrictionComment>
This product has full public access

</RestrictionComment>

SO 19115-2

<gmd:resourceConstraints>
<gmd:MD_LegalConstraints>
<gmd:useLimitation>

<gco:CharacterString>Restriction Comment: There are no fees for
training, materials, rubrics, and assessments. Each

participant must complete the online form to access
materials.</gco:CharacterString>

</gmd:useLimitation>
<gmd:otherConstraints>

<gco:CharacterString>Restriction Flag:0</gco:CharacterString>
</gmd:otherConstraints>

</gmd:MD_LegalConstraints>

</gmd:resourceConstraints>

SO 19115-1




<mri:resourceConstraints>
<mco:MD_LegalConstraints>

<mco:useLimitation>

for training, materials, rubrics, and assessments. Each

participant must complete the online form to access
materials.</gco:CharacterString>

</mco:useLimitation>
<mco:otherConstraints>

<gco:CharacterString>Restriction
Flag:0</gco:CharacterString>

</mco:otherConstraints>

</mco:MD_LegalConstraints>

</mri:resourceConstraints>

<gco:CharacterString> Restriction Comment:

There are no fees

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214608509-
SCIOPS - The Extended_Metadata section is manually created.

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1289077312-
SCIOPS - The Extended_Metadata section is manually created.

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW

ECHO 10 Collection - Example manually created from the ECHO 10 schema.

ECHO 10 Granule - Example manually created from the ECHO 10 schema.

ISO 19115- 2 - Example manually generated from schema and SERF record

ISO 19115-1 - Example manually generated from schema and SERF record




Recommendations
Metadata that is meant for EMS use only should carry a restricted flag that
allows only data provider and EMS to use it.

A.B.14 Metadata Association

Element Specification

MetadataAssociation/Entryld (1)

MetadataAssociation/Type (0..1) <"SCIENCE ASSOCIATED",
"DEPENDENT", "INPUT", "PARENT", "CHILD", "RELATED", "LARGER

CITATION WORKS">
MetadataAssociation/Description (0..1)

MetadataAssociation/Version (0..1)



Description

This element is used to identify other metadata resources including but not
limited to services, collections, Vvisualizations, parameters, granules,
documents, etc. that are associated with or dependent on the data
described by the metadata. This element is also used to identify a parent
metadata record if it exists. This usage should be reserved for instances
where a group of metadata records are subsets that can be better
represented by one parent metadata record, which describes the entire set.
In some instances, a child may point to more than one parent.

Profile Utilization

Collection, Granule, Document

Cardinality

0..*

Analysis

This element represents dependent relationships in the UMM. Since data
within the profiles can reference each other, it would be convenient to
search for items based on associated items.

In SERF, the metadata associations are not directly mappable. To
determine the meta associations, the Related URL/Content_Type must be
read for a string equaling "GET RELATED DATA SET METADATA (DIF)" or
"GET RELATED SERVICE METADATA (SERF)", and the URL obtained from
the Related URL/URL element. The element can then be accessed for
information.

Mapping



DIF 9 DIF/Parent DIF

DIF 10 DIF/Parent_DIF
DIF/MetadataAssociation/

SERF DIF/Parent_SERF
Other metadata associations are not directly mappable

ECHO 10 /Collection/CollectionAssociations/CollectionAssociation/

Collection

ECHO 10 Not yet mapped

Granule

SO

19115-2 gmi:MI_Metadata/gmd:identificationinfo/gmd:MD_Datal dentification/gmd:a
ggregationinfo/gmd:MD_Aggregatelnformation/gmd:aggregateDataSetNam
e/gmd:Cl_Citation
Metadata Associations:
gmi:MI|_Metadata/gmd:identificationInfo/gmd:MD_Datal dentification/gmd:a
ggregationinfo/gmd:MD_Aggregatelnformation/gmd:associationType/gmd:D
S AssociationTypeCode codelListValue="Science Associated"
Parent Associations:
gmi:MI|_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/gmd:a
ggregationinfo/gmd:MD_Aggregatelnformation/gmd:associationType/gmd:D
S AssociationTypeCode codelListValue="largerWorkCitation"

SO

19115-1 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/mri:as

sociatedResource/mri:MD_AssociatedResource/mri:name

Metadata Associations:
mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/mri:as
sociatedResource/mri:MD_AssociatedResource/mri:associationType/mri:DS_
AssociationTypeCode
codeList="codeListLocation#DS_AssociationTypeCode"

codeListValue="Science Associated"

Parent Associations:




mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/mri:as
sociatedResource/mri:MD_AssociatedResource/mri:associationType/mri:DS_

AssociationTypeCode
codeList="codeListLocation#DS_AssociationTypeCode"

codeListValue="largerWorkCitation"

EMS

N/A

Examples

DIF 9

<Parent_DIF>CNDP- ESP_IPY_POL2006-11139- C02-
01CGL_ESASSI</Parent_DIF>

DIF 10

<Parent_DIF>CNDP- ESP_IPY_POL2006-11139- C02-
01CGL_ESASSI</Parent_DIF>

<DIF>

<MetadataAssociation>
<Entryld>CIESIN_SEDAC_E,NTRI_TEXTS_COL</Entryld>
<Type>Science Associated</Type>
<Description>Some description of the association</Description>

</MetadataAssociation>

</DIF>

SERF

|<Parent_SERF> METOFFICE UKMET</Parent SERF>




ECHO 10 Collection

Parent Association:
<CollectionAssociation>
<ShortName>g3atb</ShortName>
<Versionld>4</Versionld>
<CollectionType>Parent Association</CollectionType>
<CollectionUse>This isthe SAGE Ill Level 1B solar transmission file
containing 85 profiles from zero to 100 km in 0.5 km intervals that are
used in inversion algorithms to extract the measured species associated

with the transmission wavelengths.</CollectionUse>

</CollectionAssociation>

Metadata Association:

<CollectionAssociation>
<ShortName>g3arepga</ShortName>
<Versionld>4</Versionld>
<CollectionType>Science Associated</CollectionType>
<CollectionUse>The weekly quality assurance report containing

information that might be useful in gaining insight into the quality of these
data.</CollectionUse>

</CollectionAssociation>

SO 19115-2

Parent Association:

<gmd:aggregationlnfo>




<gmd:MD_Aggregatelnformation>
<gmd:aggregateDataSetName>
<gmd:Cl_Citation>
<gmd:title>
<gco:CharacterString>g3atb</gco:CharacterString>
</gmd:title>
<gmd:date gco:nilReason="unknown"/>
<gmd:edition>
<gco:CharacterString>4</gco:CharacterString>
</gmd:edition>
<gmd:otherCitationDetails>
<gco:CharacterString>This is the SAGE Il Level 1B solar
transmission file containing 85 profiles from zero to 100 km in 0.5 km
intervals that are used in inversion algorithms to extract the measured
species associated with the transmission
wavelengths.</gco:CharacterString>
</gmd:otherCitationDetail s>
</gmd:CI_Citation>
</gmd:aggregateDataSetName>
<gmd:aggregateDataSetldentifier>
<gmd:MD_Identifier>
<gmd:code>

<gco:CharacterString>g3atb</gco:CharacterString>

</gmd:code>




</gmd:MD_ldentifier>
</gmd:aggregateDataSetldentifier>
<gmd:associationType>

<gmd:DS_AssociationTypeCode

codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#DS_AssociationTypeCode"

codeListValue="largerWorkCitation">largerWorkCitation</gmd:DS_Associ
ationTypeCode>
</gmd:associationType>
</gmd:MD_Aggregatelnformation>

</gmd:aggregationlnfo>

Metadata Association:
<gmd:aggregationlnfo>
<gmd:MD_Aggregatelnformation>
<gmd:aggregateDataSetName>
<gmd:Cl_Citation>
<gmd:title>
<gco:CharacterString>g3atb</gco:CharacterString>

</gmd:title>
<gmd:date gco:nilReason="unknown"/>
<gmd:edition>

<gco:CharacterString>4</gco:CharacterString>




</gmd:edition>
<gmd:otherCitationDetails>
<gco:CharacterString>This is the SAGE Ill Level 1B solar
transmission file containing 85 profiles from zero to 100 km in 0.5 km
intervals that are used in inversion algorithms to extract the measured
species associated with the transmission
wavelengths.</gco:CharacterString>
</gmd:otherCitationDetail s>
</gmd:CI_Citation>
</gmd:aggregateDataSetName>
<gmd:aggregateDataSetldentifier>
<gmd:MD_Identifier>
<gmd:code>
<gco:CharacterString>g3atb</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmd:aggregateDataSetldentifier>
<gmd:associationType>
<gmd:DS_AssociationTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.

xml#DS_AssociationTypeCode"

codeListValue="Science Associated">Science
Associated</gmd:DS_AssociationTypeCode>

</gmd:associationType>

</gmd:MD_Aggregatelnformation>

</gmd:aggregationinfo>




1SO 19115-1

Parent Association:
<mri:associatedResource>
<mri:MD_AssociatedResource>
<mri:name>
<cit:Cl_Citation>
<cit:title>
<gco:CharacterString>g3atb</gco:CharacterString>
</cit:title>
<cit:date gco:nilReason="missing"/>
<cit:edition>
<gco:CharacterString>4</gco:CharacterString>
</cit:edition>
<cit:otherCitationDetail s>
<gco:CharacterString>This is the SAGE Ill Level 1B solar
transmission file containing 85 profiles from zero to 100 km in 0.5 km
intervals that are used in inversion algorithms to extract the measured
species associated with the transmission
wavelengths.</gco:CharacterString>
</cit:otherCitationDetails>
</cit:Cl_Citation>
</mri:name>

<mri:associationType>

<mri:DS_AssociationTypeCode
codeList="codeListLocation#DS_AssociationTypeCode"




codeListValue="largerWorkCitation">largerWorkCitation</mri:DS_Associ
ationTypeCode>

</mri:associationType>
</mri:MD_AssociatedResource>

</mri:associatedResource>

Metadata Associaiton:
<mri:associatedResource>
<mri:MD_AssociatedResource>
<mri:name>
<cit:Cl_Citation>
<cit:title>
<gco:CharacterString>g3arepqga</gco:CharacterString>
</cit:title>
<cit:date gco:nilReason="missing"/>
<cit:edition>
<gco:CharacterString>4</gco:CharacterString>
</cit:edition>
<cit:otherCitationDetail s>
<gco:CharacterString>The weekly quality assurance report
containing information that might be useful in gaining insight into the

quality of these data.</gco:CharacterString>

</cit:otherCitationDetail s>




</cit:Cl_Citation>
</mri:name>
<mri:associationType>

<mri:DS_AssociationTypeCode
codeList="codeListLocation#DS_AssociationTypeCode"

codeListValue="Science Associated">Science
Associated</mri:DS_AssociationTypeCode>

</mri:associationType>

</mri:MD_AssociatedResource>

</mri:associatedResource>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591398-
SCIOPS

DIF 10 —Parent Assoc. - Example based on schema with data from DIF 9
record.

- Metadata Assoc. - Example manually created based on schema.
SERF - http://gcmd.gsfc.nasa.gov/mws/serf/METOFFICE_UKCP

ECHO 10 Collection —Parent Assoc. — Example manually created from
Metadata Assoc.

- Metadata Assoc. -
https://cmr.earthdata.nasa.gov/search/concepts/C184964545- LARC

ISO 19115-2 — Parent Assoc. — Example manually created from Metadata
Assoc.

- Metadata Assoc.
hhttps://cmr.earthdata.nasa.gov/search/concepts/C184964545- LARC.iso

ISO 19115-1 — Parent Assoc. — Example manually created from Metadata
Assoc.



- Metadata Assoc. - Example based on 1SO19139t019115-
3.xsl translation of 1SO 19115- 2 record

Recommendations

The MetadataAssociation should include a controlled Type attribute used to
indicate the basis (justification) for relating one resource to another. A
unique identifier and authority should be added to formalize these
associations. In a future release we will add and merge the granule parent
association mappings. An association type code list needs to be created to
use for the ISO 19115-1 translation.

A.B.15 Publication Reference

Element Specification

PublicationReference/Authors (0..1)
PublicationReference/PublicationDate (0..1)
PublicationReference/Title (0..1)
PublicationReference/Series (0..1)
PublicationReference/Edition (0..1)
PublicationReference/Volume (0..1)
PublicationReference/lssue (0..1)
PublicationReference/ReportNumber (0..1)
PublicationReference/PublicationPlace (0..1)
PublicationReference/Publisher (0..1)
PublicationReference/Pages (0..1)
PublicationReference/ISBN (0..1)
PublicationReference/DOI (0..1)
PublicationReference/OnlineResource (0..1)
PublicationReference/OtherReferenceDetails (0..1)

Description

This element describes key bibliographic citations pertaining to the data.
The Authors element contains all the authors for the publication.

Profile Utilization

Collection, Granule, Service, Visualization, Variable, Document



Cardinality

0..*

Analysis

Reference information is found in GCMD. The Reference element includes a
way to specify reference as a block of text or include individual reference
attributes as part of the 1SO 19115 Reference model.

Mapping

DIF 9 DIF/Reference/
DIF 10 DIF/Referencel/
SERF SERF/Referencel/
ECHO 10 N/A

Collection

ECHO 10 N/A

Granule

SO

19115-2 gmd:MD_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/
gmd:aggregationinfo/gmd:MD_Aggregatel nformation/gmd:aggregateD
ataSetName/gmd:Cl_Citation

SO
19115-1 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/
mri:additionalDocumentation/cit:Cl_Citation

EMS N/A

Examples

DIF 9

<Reference>

<Author>International Union for the Conservation of Nature and Natural
Resources - IUCN</Author>

<Publication_Date>2012</Publication_Date>

<Title>Environmental Treaty Status Data Set, 2012 Release</Title>




<Publication_Place>Palisades, NY</Publication_Place>

<Publisher>NASA Socioeconomic Data and Applications Center
(SEDAC)</Publisher>

<DOI>http://dx.doi.org/10.7927/H4DZ067Z</DOI >

</Reference>

DIF 10

<Reference>

<Author>International Union for the Conservation of Nature and Natural
Resources - IUCN</Author>

<Publication_Date>2012</Publication_Date>
<Title>Environmental Treaty Status Data Set, 2012 Release</Title>
<Publication_Place>Palisades, NY </Publication_Place>

<Publisher>NASA Socioeconomic Data and Applications Center
(SEDAC)</Publisher>

<DOI>http://dx.doi.org/10.7927/HADZ067Z</DOI >

</Reference>

SERF

<Reference>

<Author>P.J. Werdell, S\W. Bailey, G.S. Fargion, C. Pietras, K.D.
Knobelspiesse, G.C. Feldman, and C.R. McClain</Author>

<Publication_Date>2003</Publication_Date>

<Title>Unique data repository facilitates ocean color satellite
validation</Title>

<Series>EOS Trans</Series>




<Volume>84</Volume>
<lssue>38</lssue>
<Publisher>AGU </Publisher>

<Pages>377</Pages>

</Reference>

SO 19115-2

<gmd:aggregateDataSetName>
<gmd:CI_Citation>
<gmd:title>
<gco:CharacterString>
Unique data repository facilitates ocean color satellite validation
</gco:CharacterString>
</gmd:title>
<gmd:date>
<gmd:Cl_Date>
<gmd:date>
<gco:Date>2003</gco:Date>
</gmd:date>
<gmd:dateType>
<gmd:Cl_DateTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.xm

|#CIl_DateTypeCode"
codeListValue="publication">publication</gmd:Cl_DateTypeCode>




</gmd:dateType>
</gmd:Cl_Date>
</gmd:date>
<gmd:citedResponsibleParty>

<gmd:Cl_ResponsibleParty>

</gmd:Cl_ResponsibleParty >
</gmd:citedResponsibleParty>
<gmd:series>
<gmd:Cl_Series>
<gmd:name>
<gco:CharacterString>EOS Trans</gco:CharacterString>
</gmd:name>
<gmd:issueldentification>
<gco:CharacterString>38</gco:CharacterString>
</gmd:issueldentification>
</gmd:Cl_Series>
</gmd:series>
<gmd:otherCitationDetails>
<gco:CharacterString>337</gco:CharacterString>
</gmd:otherCitationDetail s>

</gmd:CI_Citation>

</gmd:aggregateDataSetName>




SO 19115-1

<mri:additionalDocumentation >
<cit:Cl_Citation>
<cit:title>

<gco:CharacterString>Spline functions, interpolation, and
numerical quadrature</gco:CharacterString>

</cit:title>
<cit:date>
<cit:Cl_Date>
<cit:date>
<gco:DateTime>1967- 01-01T00:00:00</gco:DateTime>
</cit:date>
<cit:dateType>
<cit:Cl_DateTypeCode
codeList="codeListLocation#Cl_DateTypeCode"
codeListValue="publication">publication</cit:Cl_DateTypeCode>
</cit:dateType>
</cit:Cl_Date>
</cit:date>
<cit:citedResponsibleParty>
<cit:Cl_Responsibility>
<cit:role>

<cit:Cl_RoleCode
codeList="codeListLocation#Cl_ RoleCode"




codeListValue="publisher">publisher</cit:Cl_RoleCode>
</cit:role>
<cit:party>
<cit:Cl_Organisation>
<cit:name>

<gco:CharacterString>John Wiley and Sons,
Inc.</gco:CharacterString>

</cit:name>
<cit:contactlnfo>
<cit:Cl_Contact>
<cit:address>
<cit:Cl_Address>

<cit;:administrativeArea>

<gco:CharacterString>NY </gco:Character String>
</cit:administrativeArea>
</cit:Cl_Address>
</cit:address>
</cit:Cl_Contact>
</cit:contactlnfo>
</cit:Cl_Organisation>
</cit:party>

</cit:Cl_Responsibility>




</cit:citedResponsibleParty >
<cit:citedResponsibleParty >
<cit:Cl_Responsibility>
<cit:role>
<cit:Cl_RoleCode
codeList="codeListLocation#Cl_RoleCode"
codeListValue="originator">originator</cit:Cl_RoleCode>
</cit:role>
<cit:party>
<cit:Cl_Organisation>

<cit:name>

<gco:CharacterString>Greville,
T.N.E.</gco:CharacterString>

</cit:name>
</cit:Cl_Organisation>
</cit:party>
</cit:Cl_Responsibility>
</cit:citedResponsibleParty>
<cit:citedResponsibleParty>
<cit:Cl_Responsibility>
<cit:role>
<cit:Cl_RoleCode
codeList="codeListLocation#CIl_RoleCode"

codeListValue="originator">originator</cit:Cl_RoleCode>

</cit:role>




<cit:party>
<cit:Cl_Organisation>
<cit:name>

<gco:CharacterString>Ralston, A.
(ed.)</gco:CharacterString>

</cit:name>
</cit:Cl_Organisation>
</cit:party>
</cit:Cl_Responsibility>
</cit:citedResponsibleParty>
<cit:citedResponsibleParty>
<cit:Cl_Responsibility>
<cit:role>
<cit:Cl_RoleCode
codeList="codeListLocation#CIl_RoleCode"
codeListValue="originator">originator</cit:Cl_RoleCode>
</cit:role>
<cit:party>
<cit:Cl_Organisation>
<cit:name>

<gco:CharacterString>Wilf, H.S.
(ed.)</gco:CharacterString>

</cit:name>

</cit:Cl_Organisation>




</cit:party>
</cit:Cl_Responsibility>
</cit:citedResponsibleParty>
<cit:series>
<cit:Cl_Series>
<cit:name>

<gco:CharacterString>MATHEMATICAL METHODS OF
DIGITAL COMPUTERS</gco:CharacterString>

</cit:name>
<cit:issueldentification>
<gco:CharacterString>Volume 2</gco:CharacterString>
</cit:issueldentification>
</cit:Cl_Series>
</cit:series>

</cit:Cl_Citation>

</mri:additionalDocumentation>

Source Data Information:

DIF 9 -
http://gcmd.gsfc.nasa.gov/mws/dif/CIESIN_SEDAC_ENTRI_TEXTS COL

DIF 10 - Example based on schema with data from DIF 9 record.

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/SeaBASS
ISO 19115-2 - Example manually generated from schema and SERF

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of
http://www.ngdc.noaa.gov/metadata/published/ NOAA/NESDIS/NCDC/Geopo
rtal/iso/xml/C00823.xml record



Recommendations

During the UMM-C review, it was decided that the text inside this element
must be deconstructed and the various components placed into the correct
elements. If the metadata still retains a block of text in this element upon
migration to the CMR, the text will be placed into the
PublicationReference/OtherReferenceDetails element.

A.B.16 ISO Topic Category
Element Specification

ISOTopicCategory

Description

This element is used to identify the keywords from the EN SO 19115-
1:2014 Geographic Information - Metadata - Part 1: Fundamentals
(http://www.isotc211.org/) Topic Category Code List. It is a high-level
thematic classification to assist in the grouping and search of available
services.

Source: EN 1SO 19115-1:2014 Geographic Information —Metadata — Part 1:
Fundamentals



Figure A.1. MD_TopicCategoryCode List

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*

Analysis

Based on selected science keywords, the 1SO Topic Category keywords
should be auto-populated into the metadata by the CMR at ingest time.
Metadata authors will also have the option to manually add/edit the
ISOTopicCategory keywords in the metadata record using docBUILDER,
Metadata Management Tool (MMT), or any alternate preferred XML editor.



Mapping

DIF 9 DIF/ISO_Topic_Category

DIF 10 DIF/1SO_Topic_Category

SERF SERF/ISO_Topic_Category

ECHO 10 N/A

Collection

ECHO 10 N/A

Granule

SO

19115-2 gmd:MD_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentifica
tion/gmd:topicCategory/gmd:MD_TopicCategoryCode

ISO

19115-1 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Datal dentificati
on/mri:topicCategory/mri:MD_TopicCategoryCode

EMS N/A

Examples

DIF 9

<ISO_Topic_Category uuid="d9cd5b7e- e9e7-4746- bbc8-
bc69f7b606c7">GEOSCIENTIFIC INFORMATION</ISO_Topic_Category>
<ISO_Topic_Category uuid="0353d44f- 2fc2- 44df-9143-

bla3b86d5aal”">INLAND WATERS</ISO_Topic_Category>

DIF 10

<ISO_Topic_Category uuid="1ebf71bd- d007-42f8-8f9b-
8c44a6b65a28">CLIMATOLOGY/METEOROLOGY/ATMOSPHERE</ISO_To
pic Category>

SERF

<ISO_Topic_Category uuid="26173055- 5433- 42b3- bd00-




9alf6ba294el">FARMING</ISO_Topic_Category>

<ISO_Topic_Category uuid="c3d9cf68-90b1- 46be- 914c-
38ech2e70097">BIOTA</ISO_Topic_ Category>

SO 19115-2

<gmd:topicCategory>
<gmd:MD_TopicCategoryCode>farming</gmd:MD_TopicCategoryCode>

<gmd:MD_TopicCategoryCode>biota</gmd:MD_TopicCategoryCode>

</gmd:topicCategory>

1SO 19115-1

<mri:topicCategory>
<mri:MD_TopicCategoryCode>farming</mri:MD_TopicCategoryCode>

<mri:MD_TopicCategoryCode>biota</mri:MD_TopicCategoryCode>

</mri:topicCategory >

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214313574-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1225368560-
LAADS

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW
ISO 19115-2 - Example manually generated from schema and SERF

ISO 19115-1 - Example manually generated from schema and SERF

A.B.17 Science Keywords
Element Specification

ScienceKeywords/Category (1)
ScienceKeywords/Topic (1)



ScienceKeywords/Term (1)
ScienceKeywords/VariableLevell (0..1)
ScienceKeywords/VariableLevel2 (0..1)
ScienceKeywords/VariableLevel3 (0..1)
ScienceKeywords/DetailedVariable (0..1)

Description

This element enables specification of Earth Science keywords. All of the
sub- elements except for DetailedVariable are controlled and use the GCMD
Science Keyword vocabulary. The vocabulary is managed by the Keyword
Management System (KMS) and it can be found at this location:
http://gcmdservices.gsfc.nasa.gov/static/kms/sciencekeywords/sciencekeyw
ords.csv. The DetailedVariable is an uncontrolled free text element that
allows the metadata author to include another keyword to more fully
describe the data.

Profile Utilization

Collection, Granule, Service, Document

Cardinality

1.~



Mapping

DIF 9 /IDIF/Parameters/

DIF 10 IDIF/Science_Keywords/

SERF /ISERF/Science Parameters/

ECHO /Collection/ScienceK eywords/ScienceKeyword/

10

Collecti

on

ECHO N/A

10

Granule

SO /

19115-2 | gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentificatio
n/gmd:descriptiveKeywords/gmd:MD_Keywords/gmd:keyword/gco:C
haracter String
with
/
gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Datal dentificatio
n/gmd:descriptiveKeywords/gmd:MD_Keywords/gmd:keyword/gmd:t
ype/MD_KeywordTypeCode[ @codeListValue="theme"]

SO /

19115-1 | mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentificatio
n/mri:descriptiveKeywords/mri:MD_Keywords/mri:keyword/gco:Cha
racterString
with
/
mdb:MD_Metadata/mdb:identificationInfo/mri:MD_Datal dentificatio
n/mri:descriptiveKeywords/mri:MD_Keywords/mri:keyword/mri:type
/mri:MD_KeywordTypeCode
codeList=http://www.isotc211.org/2005/resources/Codelist/gmxCod
elists.xml#MD_KeywordTypeCodecodeListValue="theme"

EMS N/A

Examples
DIF 9
<Parameters>

<Category>EARTH SCIENCE</Category>
<Topic>BIOSPHERE</Topic>

<Term>ECOLOGICAL DYNAMICS</Term>

<Variable_Level 1>ECOTOXICOLOGY</Variable Level 1>
<Variable Level 2>SPECIES BIOACCUMULATION</Variable Level 2>




| </Parameters>

DIF 10

<Science_Keywords>
<Category>EARTH SCIENCE</Category>
<Topic>ATMOSPHERE</Topic>
<Term>ATMOSPHERIC CHEMISTRY </Term>
<Variable_Level 1>CARBON AND HYDROCARBON
COMPOUNDS</Variable Level 1>
<Variable Level 2>CARBON DIOXIDE</Variable Level 2>
</Science_Keywords>




SERF

<Science_ Parameters uuid="5066def0- bl14b- 4a2c- b40f-dc9953860366" >
<Science_Category>EARTH SCIENCE</Science_Category>
<Science_Topic>HUMAN DIMENSIONS</Science_Topic>

<Science Term>ENVIRONMENTAL
GOVERNANCE/MANAGEMENT</Science_Term>

<Science Variable Level 1>LAND
MANAGEMENT</Science Variable Level 1>

<Science Variable Level 2>LAND USE/LAND COVER
CLASSIFICATION</Science _Variable Level 2>

</Science_Parameters>

<Science_ Parameters uuid="ec0e2762- f57a- 4fdc-b395- c8d7d5590d18" >
<Science_Category>EARTH SCIENCE</Science_Category>
<Science_Topic>HUMAN DIMENSIONS</Science_Topic>
<Science_Term>NATURAL HAZARDS</Science_Term>

</Science_Parameters>

ECHO 10 Caollection

<ScienceKeywords>
<ScienceKeyword>
<CategoryKeyword>EARTH SCIENCE</CategoryKeyword>
<TopicKeyword>HYDROSPHERE</TopicKeyword>
<TermKeyword>SURFACE WATER</TermKeyword>

<VariableLevel 1IKeyword>




<Value>DISCHARGE/FLOW</Value>
</VariableLevel1Keyword>

</ScienceKeyword>

<ScienceKeyword>

<CategoryKeyword>EARTH SCIENCE</CategoryKeyword>
<TopicKeyword>HYDROSPHERE</TopicKeyword>
<TermKeyword>SURFACE WATER</TermKeyword>
<VariableLevel1Keyword>

<Value>STAGE HEIGHT</Value>
</VariableLevell1Keyword>

</ScienceKeyword>

</ScienceKeywords>

SO 19115-2

<gmd:descriptiveKeywords>
<gmd:MD_Keywords>
<gmd:keyword>
<gco:CharacterString>EARTH

SCIENCE&gt;HYDROSPHERE& gt; SURFACE
WATER& gt;DISCHARGE/FLOW& gt;NONE& gt;NONE& gt;NONE</gco:Charact
erString>

</gmd:keyword>

<gmd:keyword>

<gco:CharacterString>EARTH
SCIENCE&gt;HYDROSPHERE& gt; SURFACE WATER& gt;STAGE




HEIGHT&gt;NONE&gt;NONE& gt;NONE</gco:CharacterString>
</gmd:keyword>
<gmd:type>

<gmd:MD_KeywordTypeCode
codeList="http://www.isotc211.0rg/2005/resources/Codelist/gmxCodelists.xml
#MD_KeywordTypeCode"
codeListValue="theme">theme</gmd:MD_KeywordTypeCode>
</gmd:type>
<gmd:thesaurusName>

<gmd:Cl_Citation>

<gmd:title>

<gco:CharacterString>NASA/GCMD Science
Keywords</gco:CharacterString>

</gmd:title>

</gmd:CI_Citation>
</gmd:thesaurusName>

</gmd:MD_Keywords>

</gmd:descriptiveKeywords>

SO 19115-1

<mri:descriptiveKeywords>
<mri:MD_Keywords>

<mri:keyword>




<gco:CharacterString>EARTH
SCIENCE& gt;HYDROSPHERE& gt; SURFACE
WATER& gt;DISCHARGE/FLOW& gt;NONE& gt;NONE& gt;NONE</gco:Charac
terString>
</mri:keyword>
<mri:keyword>
<gco:CharacterString>EARTH
SCIENCE& gt;HYDROSPHERE& gt; SURFACE WATER&gt;STAGE
HEIGHT& gt;NONE& gt;NONE& gt;NONE</gco:CharacterString>
</mri:keyword>
<mri:type>
<mri:MD_KeywordTypeCode
codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/schema/resourc
es/Codelist/gmxCodelists.xml#MD_KeywordTypeCode"
codeListValue="theme">theme</mri:MD_KeywordTypeCode>

</mri:type>

<mri:thesaurusName>

</mri:thesaurusName>

</mri:MD_Keywords>

</mri:descriptiveKeywords>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214305884-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1223726607-
GES _DISC

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW



ECHO 10 Collection -
https://cmr.earthdata.nasa.gov/search/concepts/C179003030- ORNL_DAAC
ISO 19115- 2- https://cmr.earthdata.nasa.gov/search/concepts/C179003030-
ORNL_DAAC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

Recommendations

EMS should drop its discipline element from product requirements in favor
of using these keywords and mapping them to existing discipline elements.

CMR should look to create components for common data and permit users
to manage them through the MMT. For more information about components
please see https://geo-ide.noaa.gov/wiki/index.php?title=1SO_Components

A.B.18 Ancillary Keywords
Element Specification

AncillaryKeywords

Description

This element allows authors to provide words or phrases to further describe
the data and therefore its vocabulary is not controlled.

Profile Utilization

Collection, Granule, Service, Visualization, Variable, Document

Cardinality

0..*






Mapping

DIF 9 /DIF/Keyword
DIF DIF/Ancillary_Keyword
10
SERF /SERF/Keyword
ECHO N/A
10
Collec
tion
ECHO N/A
10
Granu
le
SO
19115 gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/gmd:d
-2 escriptiveKeywords/gmd:MD_Keywords/gmd:keyword/gco:CharacterString
SO
19115 mdb:MD_Metadata/mdb:identificationlnfo/mri:MD_Dataldentification/mri:d
-1 escriptiveKeywords/mri:MD_Keywords/mri:keyword/gco:CharacterString
EMS (discipline
Examples
DIF 9

<Keyword>ANTARCTICA</Keyword>
<Keyword>ORGANOCHLORINES</Keyword>
<Keyword>SEABIRDS</Keyword>
<Keyword>fulmar</Keyword>
<Keyword>Adelie penguin</Keyword>
<Keyword>preenoil</Keyword>
<Keyword>polychlorinated biphenyls</Keyword>
<Keyword>hexachlorobenzene</Keyword>
<Keyword>dieldrin</Keyword>
<Keyword>PCB</Keyword>
<Keyword>HCB</Keyword>
<Keyword>DDE</Keyword>
<Keyword>Pygoscelis adeliae</Keyword>
<Keyword>Fulmarus glacialoides</Keyword>
<Keyword>morphometrics</Keyword>




DIF 10

<Ancillary_Keyword>RADIANCE</Ancillary_Keyword>
<Ancillary_Keyword>INFRARED</Ancillary_Keyword>
<Ancillary_Keyword>CALIBRATED</Ancillary_Keyword>
<Ancillary_Keyword>GEOLOCATED</Ancillary_Keyword>
<Ancillary Keyword>EOSDIS</Ancillary Keyword>

SERF

<Keyword>Science Curriculum</Keyword>

<Keyword>Science Studies</Keyword>

<Keyword>Classroom Activities</Keyword>

SO 19115-2

<gmd:descriptiveKeywords>
<gmd:MD_Keywords>
<gmd:keyword>
<gco:CharacterString>Science Curriculum</gco:CharacterString>
</gmd:keyword>
<gmd:keyword>
<gco:CharacterString>Science Studies</gco:CharacterString>
</gmd:keyword>
<gmd:keyword>
<gco:CharacterString>Classroom Activities</gco:CharacterString>

</gmd:keyword>




</gmd:MD_Keywords>

</gmd:descriptiveKeywords>

SO 19115-1

<mri:descriptiveKeywords>
<mri:MD_Keywords>
<mri:keyword>
<gco:CharacterString>Science Curriculum</gco:CharacterString>
</mri:keyword>
<mri:keyword>
<gco:CharacterString>Science Studies</gco:CharacterString>
</mri:keyword>
<mri:keyword>
<gco:CharacterString>Classroom Activities</gco:CharacterString>

</mri:keyword>

</mri:MD_Keywords>

</mri:descriptiveKeywords>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov/search/concepts/C1214305884-
AU_AADC

DIF 10 - https://cmr.earthdata.nasa.gov/search/concepts/C1243477316-
GES_DISC



SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW
ISO 19115-2 - Example manually generated from schema and SERF

ISO 19115-1 - Example manually generated from schema and SERF

Recommendations

The UMM should include an attribute as part of the AncillaryKeyword
element that can specify a Uniform Resource Identifier (URI) to reference
an external vocabulary system's keyword.

A.B.19 Additional Attributes

Element Specification
Additional Attribute/Name (1)
Additional Attribute/Type (0..1)

Additional Attribute/ldentifier (0..1)

Additional Attribute/DataType (1)

Additional Attribute/Description (1)

Additional Attribute/M easurementResolution (0..1)
Additional Attribute/RangeBegin (0..1)

Additional Attribute/RangeEnd (0..1)

Additional Attribute/UnitsOfMeasure (0..1)
Additional Attribute/ValueAccuracy (0..1)
Additional Attribute/ValueAccuracyExplanation (0..1)
Additional Attribute/Value (0..1)

Additional Attribute/Group (0..1)

Additional Attribute/UpdateDate (0..1)

Description
This entity stores the data's distinctive attributes (i.e. attributes used to

describe the unique characteristics of the resource which extend beyond
those defined in this mapping).

Profile Utilization



Collection, Granule, Service, Visualization, Variable, Document

Cardinality

0..*

Analysis

ECHO uses AdditionalAttributes to describe the data represented in each
granule within a collection. These values are important search criteria for
the granules. Example attributes include values for cloud cover, MODIS Tile
grid coordinates, and elevation information. All additional attribute
definitions are included in the collection metadata. A collection may also
specify a value, to be understood as the value for all granules. Granules
reference defined additional attributes and supply a value that is associated
to that granule. Granules may not define a new additional attribute that is
not defined by the collection. In DIF 9 and SERF there 1is no
AdditionalAttributes element similar to ECHO. Recognizing there 1is no
equivalence between Extended Metadata, that does not have a well defined
structure, and additional attributes which does, there still needs to be a way
to translate the data from one standard to DIF 9 or SERF. The proposal is to
use ExtendedMetadata to store this kind of information in key value pairs.
DIF 10 has additional attributes and is directly mappable. If the additional
attribute type i1s known it can be mapped to the correct section of ISO.
Currently additional attributes are mapped to several sections within ISO
depending 1if the attribute 1is geographical, describes coverage, describes
data quality, describes acquisition, or maps to a keyword.

Mapping
DIF 9 /DIF/ExtendedMetadata/Metadata/
DIF 10 |/DIF/Additional Attributes/
SERF /SERF/ExtendedMetadata/Metadata/
ECHO /Collection/Additional Attributes/Additional Attribute/
10
Collect1
on
ECHO /Granule/AdditionalAttributes/AdditionalAttribute/

10




Granule

ISO /

19115-2 | gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentification/gm
d:descriptiveKeywords/gmd:MD_ Keywords/gmd:keyword/gco:CharacterS
tring
or
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentification/gm
d:extent/gmd:EX Extent/gmd:geographicElement/gmd:EX GeographicDe
scription/gmd:geographicldentifier/gmd:MD Identifier
or
/
gmi:MI Metadata/gmd:contentInfo/gmd:MD CoverageDescription/gmd:d
mmension/gmd:MD Band/gmd:otherProperty/gco:Record/eos:AdditionalAt
tributes/eos:AdditionalAttribute
or
/
gmi:MI Metadata/gmd:dataQualityInfo/gmd:DQ_ DataQuality/gmd:report/
gmd:DQ QuantitativeAttributeAccuracy/gmd:result/gmd:DQ_Quantitative
Result/gmd:value/gco:Record/eos:AdditionalAttributes/eos:Additional Attr
ibute
or
/
gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI AcquisitionInforma
tion/gmi:instrument/eos:EOS Instrument/eos:otherProperty/gco:Record/e
os:AdditionalAttributes/eos:AdditionalAttribute
or
/
gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI_AcquisitionInforma
tion/gmi:platform/eos:EOS Platform/eos:otherProperty/gco:Record/eos:A
dditional Attributes/eos:AdditionalAttribute

ISO /
19115-1 | mdb:MD_ Metadata/mdb:identificationInfo/mri:MD_ Dataldentification/mri1

:descriptiveKeywords/mri:MD Keywords/mri:keyword/gco:CharacterStri
ng

or

/

mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentification/mri
:extent/gex:EX Extent
id="boundingExtent"/gex:geographicElement/gex:EX GeographicDescrip
tion/gex:geographicldentifier/mcc:MD Identifier

or

/

mdb:MD Metadata/mdb:contentInfo/mrc:MD CoverageDescription/mrc:a




EMS

ttributeDescription/mrc:attributeGroup/mrc:MD _AttributeGroup/mrc:attr
ibute/mrc:MD_SampleDimension/mrc:otherProperty/gco:Record/mrc:Add
itionalAttributes/mrc:AdditionalAttribute

or

/

mdb:MD Metadata/mdb:dataQualityInfo/mdq:DQ_DataQuality/mdq:repor
t/mdq:DQ_QuantitativeAttributeAccuracy/mdq:result/mdq:DQ_Quantitati
veResult/mdq:value/gco:Record/mdq:AdditionalAttributes/mdq:Additional
Attribute

or

/

mdb:MD Metadata/mdb:acquisitionInformation/mac:MI_AcquisitionInfor
mation/mac:instrument/mac:EOS_Instrument
1d="d226e165"/mac:otherPropertyType/mac:otherProperty/gco:Record/m
ac:AdditionalAttributes/mac:AdditionalAttribute

or

/

mdb:MD Metadata/mdb:acquisitionInformation/mac:MI_AcquisitionInfor
mation/mac:platform/mac:EOS_Platform
1d="d226e145"/mac:otherPropertyType/mac:otherProperty/gco:Record/m
ac:AdditionalAttributes/mac:Additional Attribute

N/A

Examples

DIF 9

<Extended Metadata>

<Metadata>

<Group>EMS </Group>
<Name>EMS Product</Name>
<Value>MODO09QIN</Value>

</Metadata>

<Metadata>
<Group>gov.nasa.gsfc.gcmd</Group>
<Name>metadata.extraction date</Name>
<Value>2014-11-05 10:00:22</Value>

</Metadata>

<Metadata>
<Group>gov.nasa.gsfc.gcmd</Group>
<Name>metadata.keyword version</Name>
<Value>8.0</Value>

</Metadata>




</Extended_M etadata>

DIF 10

<Additional Attributes>
<Name>SuccessCloudPhaseRtrPct_IR</Name>
<DataType>FLOAT</DataType>

<Description>None</Description>

</Additional Attributes>

SERF

<Extended Metadata>

<Extended_Metadata>/n <Metadata>
<Group>gov.nasa.gsfc.gcmd</Group>
<Name>metadata.extraction_date</Name>
<Value>2014- 12-05 10:36:11</Value>

</Metadata>

<Metadata>
<Group>gov.nasa.gsfc.gcmd</Group>
<Name>metadata.keyword_version</Name>
<Value>8.0</Value>

</Metadata>

</Extended Metadata>

ECHO 10 Caoallection




<Additional Attribute>
<Name>SuccessCloudPhaseRtrPct_IR</Name>
<DataType>FLOAT</DataType>

<Description>None</Description>

</Additional Attribute>

ECHO 10 Granule

<Additional Attributes>
<Additional Attribute>
<Name>AIRSAR_FLIGHT_LINE</Name>
<Values>
<Value>mammoth_138.90021</Value>
</Values>
</Additional Attribute>

</Additional Attributes>

SO 19115-2

<eos:Additional Attribute>
<eos:reference>
<eo0s:EOS_Additional AttributeDescription>
<eos:type>

<eos:EOS_Additional AttributeTypeCode

codeList=http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO




S Additional AttributeTypeCode"
codeListValue="contentlnformation"
>contentinformation</eos:EOS_Additional AttributeTypeCode>
</eos:type>

<eos.name>

<gco:CharacterString>SuccessCloudPhaseRtrPct_IR</gco:CharacterStrin
g>

</eos:name>

<eos:description>
<gco:CharacterString>None</gco:CharacterString>

</eos:description>

<eos:dataType>
<eo0s:EOS_AdditionalAttributeDataTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"

codeListValue="FLOAT">FLOAT</eos:EOS_AdditionalAttributeDataTypeC
ode>
</eos:dataType>
</eo0s:EOS_AdditionalAttributeDescription>

</eos:reference>

</eos:Additional Attribute>

SO 19115-1




<mrc:Additional Attributes>
<mrc:Additional Attribute>
<mrc:reference>
<mrc:EOS_Additional AttributeDescription>
<mrc:type>
<mrc:EOS_AdditionalAttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="contentInformation">contentlnformation</mrc:EOS_Addit
ionalAttributeTypeCode>
</mrc:type>

<mrc:name>

<gco:CharacterString>SuccessCloudPhaseRtrPct_IR</gco:CharacterStrin
g>

</mrc:name>
<mrc:description>
<gco:CharacterString>None</gco:CharacterString>
</mrc:description>
<mrc:dataType>
<mrc:EOS_AdditionalAttributeDataTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"

codeListValue="FLOAT">FLOAT</mrc:EOS_AdditionalAttributeDataType
Code>




</mrc:dataType>
</mrc:EOS_Additional AttributeDescription>
</mrc:reference>

</mrc:Additional Attribute>

</ mrc:Additional Attributes>

Source Data Information:

DIF 9 - http://gcmd.gsfc.nasa.gov/mws/dif/MODO09Q1IN_C5 NRT
DIF 10 - Example manually generated based on schema and ECHO data.
SERF - http://gcmd.gsfc.nasa.gov/mws/serf/NASA_3D_VIEW

ECHO 10 Collection - https://api.echo.nasa.gov:443/catal og-
rest/echo_catalog/datasets/C90762185- LAADS

ECHO 10 Granule - https://api.echo.nasa.gov/catal og-
rest/echo_catalog/granules/G181127451- ASF

ISO 19115-2 - https://api.echo.nasa.gov:443/catalog-
rest/echo_catalog/datasets/C90762185- LAADS.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of ISO
19115- 2 record

A.B.20 Platform
Element Specification

Platform (1..*)

Platform/Type (0..1)
Platform/ShortName (1)
Platform/LongName (0..1)
Platform/Characteristics (0..*)
Platform/Characteristics/Name (1)
Platform/Characteristics/Description (1)
Platform/Characteristics/DataType (1)
Platform/Characteristics/Unit (1)
Platform/Characteristics/Value (1)
Platform/Instrument (1..*) {See Instrument for full specification}



Description

This element describes the relevant platforms used to acquire the data.
Platform types are controlled and since there are to many valid values to list
here the following URL is

provided: http://gcmdservices.gsfc.nasa.gov/static/kms/platforms/platforms.
csv. The types of platforms covered include but are not limited to Aircraft,
Earth Observation Satellites, In Situ Land-based Platforms, etc.

Profile Utilization

Collection, Granule, Service

Cardinality

0..*

Analysis

This class is found in ECHO, GCMD, and EMS. It is controlled within GCMD
and EMS, but not within ECHO. ECHO and GCMD DIF 10's Platform
includes the following attributes: ShortName, LongName, Type,
Characteristics, and Instruments. GCMD's DIF 9 Platform does not nest the
Instrument attributes or include a Characteristics attribute. Some of the
characteristics information is captured in the GCMD DIF 9 ancillary
platform metadata document. The EMS attribute "Mission" is mapped to
UMM/Platform/ShortName; EMS "Mission" can also be mapped to
UMM/Project/Campaign if applicable. EMS intends to use only one value -
and employ mission, platform and project (in this order) based on the
availability of the information.

The 1SO 19115-2 MI_Platform class was extended to EOS_Platform in order
to facilitate the addition of ECHO additional attributes and sensors to the
platform descriptions.



Mapping

DIF 9 /DIF/Source Name

DIF 10 /DIF/Platform/

SERF /SERF/Source Name

ECHO 10 |/Collection/Platforms/Platform/

Collection

ECHO 10 |/Granule/Platforms/Platform/

Granule

ISO /

19115-2 gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI Acquisition]
nformation/gmi:platform/eos:EOS_Platform/
and
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificati
on/gmd:descriptiveKeywords/gmd:MD Keywords/gmd:keyword/gc
o:CharacterString
with
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificati
on/gmd:descriptiveKeywords/gmd:MD Keywords/gmd:keyword/gm
d:type/MD KeywordTypeCode[@codeListValue="platform"]

ISO /

19115-1 mdb:MD Metadata/mdb:acquisitionInformation/mac:MI_Acquisitio
nInformation/mac:platform/eos:EOS_Platform
and
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificati
on/mri:descriptiveKeywords/mri:MD_ Keywords/mri:keyword/gco:C
haracterString
with
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_Dataldentificati
on/mri:descriptiveKeywords/mri:MD Keywords/mri:keyword/mri:ty
pe/mri:MD_ KeywordTypeCode
codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/sche
ma/resources/Codelist/gmxCodelists.xml#MD _ KeywordTypeCode"

codeListValue="platform"
Examples

DIF 9




<Source_Name uuid="e66a90c4- 3a5c- 4e52- b039- bc93857642bf" >
<Short_Name>GPS</Short_Name>

<Long_Name>Global Positioning System Satellites</Long_Name>

</Source_Name>

DIF 10

<Platform>
<Type>Earth Observation Satellites</Type>
<Short_Name>AQUA</Short_Name>
<Long_Name>Earth Observing System, AQUA</Long_Name>
<Characteristics>
<Name>EquatorCrossingTime</Name>
<Description>Local time of the equator crossing and direction
(ascending or descending </Description>
<DataType>Time/direction (ascending)</DataType>
<Unit>Local Mean Time</Unit>
<Value>3:30, ascending</Value>
</Characteristics>
<lInstrument>
<Short_Name>M ODIS</Short_Name>
<Long_Name>M oderate- Resolution Imaging
Spectroradiometer</Long_Name>
<Technique>Imaging Spectroradiometry</Technique>
<Sensor>
<Short_Name>MODIS</Short_Name>
<Long_Name>Cross- track Scanning Radiometer</Long_Name>
<Technique>Radiometry</Technique>
</Sensor>
</Instrument>
</Platform>

SERF

<Source_Name uuid="3c5df34c- b231-460d- b3b6-4145c1fa8f25">

<Short_Name>BUOY S</Short_Name>

</Source_Name>




ECHO 10 Collection

<Platforms>
<Platform>
<ShortName>|CESat</ShortName>

<LongName>Ilce, Cloud, and Land Elevation
Satellite</LongName>

<Type>Spacecraft</Type>
<Characteristics>
<Characteristic>
<Name>Orbitlinclination</Name>

<Description>Angle between the orbit plane and the Earth's
equatorial

plane</Description>
<DataType>float</DataType>
<Unit>Degrees</Unit>
<Value>94.0</Value>
</Characteristic>
<Characteristic>
<Name>OrbitalPeriod</Name>

<Description>Orbital period in decimal
minutes.</Description>

<DataType>float</DataType>
<Unit>Minutes</Unit>

<Value>96.7</Value>




</Characteristic>

</Characteristics>

<|lnstruments>

</Instruments>

</Platform>

</Platforms>

ECHO 10 Granule

<Platforms>

<Platform>

<ShortName>A|IRCRAFT</ShortName>

<Instruments...</Instruments>

</Platform>
</Platforms>

SO 19115-2

<gmi:platform>
<eo0s:EOS _Platform id="d142e304">
<gmi:identifier>
<gmd:MD_Identifier>
<gmd:code>
<gco:CharacterString>I CESat</gco:CharacterString>

</gmd:code>




<gmd:description>

<gco:CharacterString>Ilce, Cloud, and Land Elevation
Satellite</gco:CharacterString>

</gmd:description>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:description>
<gco:CharacterString>Spacecraft</gco:Character String>
</gmi:description>
<gmi:instrument xlink:href="#d142e335"/>
<gmi:instrument xlink:href="#d142e423"/>
<eos:otherPropertyType>
<gco:RecordType
xlink:href="http://earthdata.nasa.gov/metadata/schema/eos/1.0/eos.xsd#xp
ointer(//element[ @name="Additional Attributes'])">Echo Additional
Attributes</gco:RecordType>
</eos:otherPropertyType>
<eos:otherProperty>
<gco:Record>
<eos:AdditionalAttributes><!- -Platform Characteristic-->
<eos:Additional Attribute>
<eos:reference>

<eo0s:EOS_Additional AttributeDescription>

<eos:type>

<eo0s:EOS Additional AttributeTypeCode




codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</eos:EOS_Add
itional AttributeTypeCode>
</eos:type>

<eos:name>

<gco:CharacterString>Orbitinclination</gco:CharacterString>
</eos:name>
<eos:description>

<gco:CharacterString>Angle between the orbit
plane and the Earth's equatorial plane</gco:CharacterString>

</eos:description>
<eos:dataType>
<e0s:EOS_AdditionalAttributeDataTypeCode
codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"
codeListValue="float">float</eos:EOS_AdditionalAttributeDataTypeCode>

</eos:dataType>

<eos:parameterUnitsOfMeasure>

<gco:CharacterString>Degrees</gco:CharacterString>
</eos:parameterUnitsOf M easure>
</eos:EOS_Additional AttributeDescription>

</eos:reference>




<eos:value>
<gco:CharacterString>94.0</gco:CharacterString>
</eos:value>

</eos:Additional Attribute>

</eos:Additional Attributes>
</gco:Record>
</eos:otherProperty>
</e0s:EOS_Platform>
</gmi:platform>
<gmd:descriptiveKeywords>
<gmd:MD_Keywords>
<gmd:keyword>

<gco:CharacterString>ICESat &gt; Ice, Cloud, and Land
Elevation Satellite</gco:CharacterString>

</gmd:keyword>
<gmd:type>
<gmd:MD_KeywordTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#MD_KeywordTypeCode"

codeListValue="platform">platform</gmd:MD_KeywordTypeCode>

</gmd:type>




<gmd:thesaurusName>

</gmd:thesaurusName>

</gmd:MD_Keywords>

</gmd:descriptiveKeywords>

SO 19115-1

<mdb:MD_Metadata>
<mdb:acquisitionlnformation>
<mac:MI_AcquisitionInformation>
<mac:platform>
<mac:EOS_Platform id="d142e304">
<mac:identifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>I CESat</gco:CharacterString>
</mcc:code>
<mcc:description>

<gco:CharacterString>lce, Cloud, and Land Elevation
Satellite</gco:CharacterString>

</mcc:description>
</mcc:MD_Identifier>

</mac:identifier>




<mac:description>
<gco:CharacterString>Spacecraft</gco:Character String>
</mac:description>
<mac:instrument xlink:href="#d142e335"/>
<mac:instrument xlink:href="#d142e423"/>
<mac:otherPropertyType>
<gco:RecordType
xlink:href="http://earthdata.nasa.gov/metadata/schema/eos/1.0/eos.xsd#xp
ointer(//element[ @name="Additional Attributes'])">Echo Additional
Attributes</gco:RecordType>
</mac:otherPropertyType>
<mac:otherProperty>
<gco:Record>
<mac:Additional Attributes>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation" >platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>




<gco:CharacterString>Orbitinclination</gco:CharacterString>
</mac:name>
<mac:description>

<gco:CharacterString>Angle between the orbit
plane and the Earth's equatorial plane</gco:CharacterString>

</mac:description>
<mac:dataType>
<mac:EOS_Additional AttributeDataTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"

codeListValue="float">float</mac:EOS_AdditionalAttributeDataTypeCode
>

</mac:dataType>

<mac:parameterUnitsOfMeasure>

<gco:CharacterString>Degrees</gco:CharacterString>
</mac:parameterUnitsOfMeasure>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>94.0</gco:CharacterString>
</mac:value>

</mac:Additional Attribute>




</mac:Additional Attributes>
</gco:Record>
</mac:otherProperty>
</mac:EOS_Platform>
</mac:platform>
</mac:MI_AcquisitionInformation>
</mdb:acquisitionlnformation>

</mdb:MD_Metadata>

<mri:descriptiveKeywords>
<mri:MD_Keywords>
<mri:keyword>

<gco:CharacterString>ICESat &gt; Ice, Cloud, and Land
Elevation Satellite</gco:CharacterString>

</mri:keyword>
<mri:type>
<mri:MD_KeywordTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#MD_KeywordTypeCode"
codeListValue="platform">platform</mri:MD_KeywordTypeCode>
</mri:type>

<mri:thesaurusName>




</mri:thesaurusName>

</mri:MD_Keywords>

</mri:descriptiveKeywords>

EMS

AQUARIUS

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591238-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C186802661-
LAADS

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/01- buoy-99

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C1000000444-
NSIDC_ECS

ECHO 10 Granule -
https://cmr.earthdata.nasa.gov:443/search/concepts/G7108549- LARC_ASDC

ISO 19115-2 -
https://cmr.earthdata.nasa.gov:443/search/concepts/C1000000444-
NSIDC_ECS.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record
EMS - NSIDCVO flat file



Recommendations

Platforms should be reconciled so all keywords are controlled within the
CMR through the keyword management system. To be consistent, UMM
Platform structure should be used.

A.B.20.1 Instrument

Element Specification

Platform/Instrument (1..*)
Platform/Instrument/ShortName (1)
Platform/Instrument/LongName (0..1)
Platform/Instrument/Technique (0..1)
Platform/Instrument/Characteristics (0..*)
Platform/Instrument/Characteristics/Name (1)
Platform/Instrument/Characteristics/Description (1)
Platform/Instrument/Characteristics/DataType (1)
Platform/Instrument/Characteristics/Unit (1)
Platform/Instrument/Characteristics/Value (1)
Platform/Instrument/OperationalMode (0..*)

Platform/Instrument/NumberOfinstruments (0..1)
Platform/Instrument/ComposedOf/Instrument  (0..*)
Description

The Instrument element is nested within the Platform element and is used
to register the device that measured or recorded the data, including direct
human observation. This is useful to find data from a specific instrument.
Note that the use of the "Sensor" object has been removed from UMM to
avoid confusion between the names "Sensor" and "Instrument” as well as
rationalizing the use of Instrument with the 1SO Instrument representation.
To provide compatability with DIF 10 we map
IDIF/Platform/Instrument/Sensor to Platform/Instrument/Instrument in
UMM. For ECHO 10, we also map Sensor objects to UMM Instrument
objects.

The "ComposedOf" relationship shown above provides the ability for an
instrument to be composed of one of more other instruments. This
hierarchical representation of Instrument composition provides the
mechanism for modeling the complexity of modern instruments. The nesting



of instruments within an instrument is currently limited to 1 level and all
instrument short names within a platform must be unique.

Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*

Analysis

This element is found in ECHO, GCMD, and EMS. It is controlled within
GCMD but not within ECHO or EMS. ECHO and GCMD DIF 10's Instrument
element includes the following sub-elements: ShortName, LongName,
Technique, NumberOfSensors, Characteristics, Sensors, and
OperationModes. GCMD's DIF 9 Source_Name element does not nest the
Instrument sub-element or include any of the other elements found in
ECHO. Some of the characteristics information is captured in the GCMD
DIF 9 ancillary instrument metadata document. Because this is a newly
required element in the UMM and not all collections have associated
instruments, the keywords "Not Available", "Not Applicable", and
"Unknown" will be added to the controlled keyword list for collections that
are not associated with an instrument.

The 1SO 19115-2 MI_Instrument class was extended to EOS Instrument in
order to facilitate the addition of ECHO additional attributes to the
instrument descriptions.

Significant changes in UMM Version 1.3

The use of the terms "Instrument” and "Sensor" has been a source of
confusion and debate throughout the evolution of ESDIS metadata
standards development. GCMD's DIF standard used SensorName to
represent an instrument. ECHO- 10 later attempted to model the complexity



of modern instruments by creating an instrument object that can be
composed of multiple sensors. During the development of UMM, both
approaches were supported by creating both Instrument and Sensor
objects. Beginning with Version 1.3 of UMM-Common, the Sensor object
was removed in favor of using Instrument as the generalization of both
Instrument and Sensor. There was little semantic difference between the
objects, so removing the Sensor class while retaining the ECHO- like
relationships between instruments provides arich structure for describing
the instruments provided on a modern platform and eliminates the
Sensor/Instrument debate for the entire CMR community.

The ECHO model of an Instrument that is composed of Sensors is
implemented in UMM by using instrument composition. Figure A.2 below
shows the relationships between the Acquisition Information, Platform and
Instrument objects. Note that the Instrument object now has a recursive
relationship that istitled "ComposedOf". This relationship enables a
hierarchy of Instrument objects where each instrument can be composed of
one or more other instruments. This provides the capability to model
complex instruments without resorting to a Sensor object.

Figure A.2. Platform and Instrument Relationships

Using the ECHO 10 example from below, a UMM-C representation written
in JSON, as is implemented in the CMR, would look like the following:

"Instruments": [

{
"ShortName": "GLAS",



"LongName": "Geoscience Laser Altimeter System",
"Technique": "Laser Altimetry and Light Detection and Radar",
"Characteristics": [
{
"DataType": "int",
"Description”: "The width of the sensor scan as the
satellite moves along the ground track.",
"Name": "SwathWidth",
"Unit": "kilometers",
"Value": "2"
}
1,
"ComposedOf": {
"Instruments”: |
{
"ShortName": "LA",
"LongName": "Laser Altimeter",
"Technique": "Exact Measurement of Time between
Transmit Pulse and receive ground return",
"Characteristics": |
{
"DataType": "varchar",
"Description”: "transmission",
"Name": "wavelength",
"Unit": "nanometer”,
"Value": "1064 nm"

"DataType": "varchar",
"Description”: "digitizer",
"Name": "waveform",
"Unit": "counts",

"Value": "0-255"

]
3

{
"ShortName": "PC",

"LongName": "Photon Counter for the 532 nm Aerosol
Returns",
"Technique": "Counting of 532nm photon return in 75m
bins 40km to surface",
"Characteristics": |
{
"DataType": "varchar",
"Description”: "detector",



"Name": "wavelength",
"Unit": "nanometer",
"Value": "532nm"

"ShortName": "GPS",
"LongName": "Global Positioning System Receiver",
"Technique": "Radionavigation",
"ComposedOf": {
"Instruments": [

{
"ShortName": "GPS Receiver",
"LongName": "Dual frequency GPS receiver",
"Technique": "Pseudorange and carrier phase"
b

Mapping
DIF 9 /DIF/Sensor Name/
DIF 10 /DIF/Platform/Instrument/
and
/DIF/Platform/Instrument/Sensor
SERF /SERF/Sensor Name/
ECHO /Collection/Platforms/Platform/Instruments/Instrument/
10 and
Collecti /
on Collection/Platforms/Platform/Instruments/Instrument/Sensors/Sen
sor/
ECHO /Granule/Platforms/Platform/Instruments/Instrument/
10

Granule




ISO /

19115-2 | gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI Acquisitionln
formation/gmi:instrument/eos:EOS Instrument/
and
/
gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI_AcquisitionInformation/gmi
:instrument/eos:EOS_Instrument/eos:sensor/eos:EOS_Sensor/
and
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificatio
n/gmd:descriptiveKeywords/gmd:MD Keywords/gmd:keyword/gco:
CharacterString
with
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificatio
n/gmd:descriptiveKeywords/gmd:MD Keywords/gmd:keyword/gmd:
type/MD KeywordTypeCode[@codeListValue="instrument"]

ISO /

19115-1 | mdb:MD_ Metadata/mdb:acquisitionInformation/mac:MI_ Acquisition
Information/mac:instrument/eos:EOS Instrument
and
/
mdb:MD_ Metadata/mdb:acquisitionInformation/mac:MI_AcquisitionInformation/
mac:instrument/eos:EOS_Instrument/eos:sensor/eos:EOS_Sensor/
and
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificatio
n/mri:descriptiveKeywords/mri:MD Keywords/mri:keyword/gco:Cha
racterString
with
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificatio
n/mri:descriptiveKeywords/mri:MD Keywords/mri:keyword/mri:typ
e/mri:MD KeywordTypeCode
codeList="http://www.ngdc.noaa.gov/metadata/published/xsd/sche
ma/resources/Codelist/gmxCodelists.xml#MD _ KeywordTypeCode"

codeListValue="instrument"

EMS mmstrument

Examples

DIF 9

<Sensor Name uuid="eS5fde4c4- 15cd-4278-b922-005488df096f">




<Short_Name>GPS</Short_Name>

<Long_Name>Global Positioning System</Long_Name>
</Sensor_Name>
<Sensor_Name uuid="029feed6- 79dc- 4316- b8ac- be8f1e557f89" >

<Short_Name>GPS RECEIVERS</Short_Name>

</Sensor_Name>

DIF 10

<Platform>
<Type>Earth Observation Satellites</Type>
<Short_Name>AQUA</Short_Name>
<Long_Name>Earth Observing System, AQUA</Long_Name>
<Characteristics>
<Name>EquatorCrossingTime</Name>
<Description>Local time of the equator crossing and direction
(ascending or descending)</Description>
<DataType>Time/direction (ascending)</DataType>
<Unit>Local Mean Time</Unit>
<Value>3:30, ascending</Value>
</Characteristics>
<lInstrument>
<Short_ Name>M ODIS</Short_Name>
<Long_Name>M oderate- Resolution Imaging
Spectroradiometer</Long_Name>
<Technique>Imaging Spectroradiometry</Technique>
<Sensor>
<Short_Name>MODIS</Short_Name>

<Technique>Radiometry</Technique>
</Sensor>
</Instrument>
</Platform>

<Long_Name>Cross- track Scanning Radiometer</Long_Name>

SERF




<Sensor_Name uuid="d0cf9340- dc51-447f-al51-fécdad265d9a" >

<Short_Name>ANEMOMETERS</Short_Name>

</Sensor_ Name>

ECHO 10 Caollection

<|nstruments>
<lnstrument>
<ShortName>GLAS</ShortName>

<LongName>Geoscience Laser Altimeter
System</LongName>

<Technique>Laser Altimetry and Light Detection and
Radar</Technique>

<Characteristics>
<Characteristic>
<Name>SwathWidth</Name>

<Description>The width of the sensor scan as the
satellite moves along

the ground track.</Description>
<DataType>int</DataType>
<Unit>kilometers</Unit>
<Value>2</Value>
</Characteristic>
</Characteristics>

<Sensors>




</Sensors>

</Instrument>

<lInstrument>
<ShortName>GPS</ShortName>

<LongName>Global Positioning System
Receiver</LongName>

<Technique>Radionavigation</Technique>
<Sensors>
<Sensor>
<ShortName>GPS Receiver</ShortName>
<LongName>Dual frequency GPS receiver</LongName>

<Technique>Pseudorange and carrier
phase</Technique>

</Sensor >
</Sensors>

</Instrument>

</Instruments>

ECHO 10 Granule

<|nstruments>

<lnstrument>

<ShortName>AIRMSPI INSTRUMENT</ShortName>

<Characteristics/>




<Sensors...</Sensors

</Instrument>

</Instruments>

EOS Extension of I1ISO 19115-2

<gmi:instrument>
<eos:EOS_Instrument id="d142e335">
<gmi:citation>
<gmd:Cl_Citation>
<gmd:title>

<gco:CharacterString>GLAS& gt;Geoscience Laser
Altimeter System</gco:CharacterString>

</gmd:title>
<gmd:date gco:nilReason="unknown"/>
</gmd:Cl_Citation>
</gmi:citation>
<gmi:identifier>
<gmd:MD_Identifier>
<gmd:code>
<gco:CharacterString>GLAS</gco:CharacterString>
</gmd:code>
<gmd:description>

<gco:CharacterString>Geoscience Laser Altimeter
System</gco:CharacterString>




</gmd:description>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:type>

<gco:CharacterString>L aser Altimetry and Light Detection and
Radar</gco:CharacterString>

</gmi:type>
<gmi:description gco:nilReason="missing"/>
<gmi:mountedOn xlink:href="#d142e304"/>
<eos:otherPropertyType>
<gco:RecordType
xlink:href="http://earthdata.nasa.gov/metadata/schema/eos/1.0/eos.xsd#xp
ointer(//element[@name="Additional Attributes'])">Echo Additional
Attributes</gco:RecordType>
</eos:otherPropertyType>
<eos:otherProperty>
<gco:Record>
<eos:Additional Attributes><!- -Instrument Characteristic-->
<eos:Additional Attribute>
<eos:reference>
<eo0s:EOS_Additional AttributeDescription>
<eos:type>
<eo0s:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"




codeListValue="instrumentlnformation">instrumentlnformation</eos;:EOS
_Additional AttributeTypeCode>

</eos:type>

<eos.name>

<gco:CharacterString>SwathWidth</gco:CharacterString>
</eos:name>
<eos:description>

<gco:CharacterString>The width of the sensor scan
as the satellite moves along the ground track.</gco:CharacterString>

</eos:description>
<eos:dataType>
<eo0s:EOS _AdditionalAttributeDataTypeCode
codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"
codeListValue="int">int</eos:EOS_AdditionalAttributeDataTypeCode>

</eos:dataType>

<eos:parameterUnitsOfMeasure>

<gco:CharacterString>kilometers</gco:CharacterString>
</eos:parameterUnitsOf M easure>
</eos:EOS_Additional AttributeDescription>
</eos:reference>
<eos:value>

<gco:CharacterString>2</gco:CharacterString>




</eos:value>

</eos:Additional Attribute>

</eos:Additional Attributes>
</gco:Record>

</eos:otherProperty>

</e0s:EOS Instrument>
</gmi:instrument>
<gmd:descriptiveKeywords>
<gmd:MD_Keywords>
<gmd:keyword>

<gco:CharacterString>GLAS &gt; Geoscience Laser Altimeter
System</gco:CharacterString>

</gmd:keyword>
<gmd:keyword>

<gco:CharacterString>GPS &qgt; Global Positioning System
Receiver</gco:CharacterString>

</gmd:keyword>
<gmd:type>
<gmd:MD_KeywordTypeCode

codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#MD_KeywordTypeCode"




codeListValue="instrument">instrument</gmd:MD_KeywordTypeCode>
</gmd:type>

<gmd:thesaurusName>

</gmd:thesaurusName>

</gmd:MD_Keywords>

</gmd:descriptiveKeywords>

SO 19115-1

<mdb:acquisitionlnformation>
<mac:MI_AcquisitionInformation>
<mac:instrument>
<mac:EOS Instrument id="d142e335">
<mac:citation>
<cit:Cl_Citation>
<cit:title>

<gco:CharacterString>GLAS& gt;Geoscience Laser
Altimeter System</gco:CharacterString>

</cit:title>
<cit:date gco:nilReason="missing"/>
</cit:Cl_Citation>
</mac:citation>

<mac:identifier>




<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>GLAS</gco:CharacterString>
</mcc:code>
<mcc:description>

<gco:CharacterString>Geoscience Laser Altimeter
System</gco:CharacterString>

</mcc:description>
</mcc:MD_Identifier>
</mac:identifier>
<mac:type>

<gco:CharacterString>Laser Altimetry and Light Detection and
Radar</gco:CharacterString>

</mac:type>

<mac:description gco:nilReason="missing"/>

<mac:mountedOn xlink:href="#d142e304"/>

<mac:otherPropertyType>

<gco:RecordType

xlink:href="http://earthdata.nasa.gov/metadata/schema/eos/1.0/eos.xsd#xp
ointer(//element[@name="Additional Attributes'])">Echo Additional
Attributes</gco:RecordType>

</mac:otherPropertyType>

<mac:otherProperty>

<gco:Record>

<mac:Additional Attributes>




<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="instrumentlnformation">instrumentlnformation</mac:EO
S Additional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>SwathWidth</gco:CharacterString>
</mac:name>
<mac:description>

<gco:CharacterString>The width of the sensor scan
as the satellite moves along the ground track.</gco:CharacterString>

</mac:description>
<mac:dataType>
<mac:EOS_Additional AttributeDataTypeCode
codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S AdditionalAttributeDataTypeCode"
codeListValue="int">int</mac:EOS_AdditionalAttributeDataTypeCode>

</mac:dataType>

<mac:parameterUnitsOfM easure>




<gco:CharacterString>kilometers</gco:CharacterString>
</mac:parameterUnitsOfMeasure>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>2</gco:CharacterString>
</mac:value>

</mac:Additional Attribute>

</mac:Additional Attributes>
</gco:Record>
</mac:otherProperty>

<mac:sensor>

</mac:sensor>
</mac:EOS_Instrument>
</mac:instrument>
<mri:descriptiveKeywords>
<mri:MD_Keywords>

<mri:keyword>

<gco:CharacterString>GLAS &qgt; Geoscience Laser Altimeter




System</gco:CharacterString>
</mri:keyword>
<mri:keyword>

<gco:CharacterString>GPS &qgt; Global Positioning System
Receiver</gco:CharacterString>

</mri:keyword>
<mri:type>
<mri:MD_KeywordTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#MD_KeywordTypeCode"

codeListValue="instrument">instrument</mri:MD_KeywordTypeCode>

</mri:type>

</mri:MD_Keywords>
</mri:descriptiveKeywords>

EMS

AQUARIUS RADIOMETER,AQUARIUS SCATTEROMETER

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591238-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C186802661-
LAADS

SERF - http://gcmd.gsfc.nasa.gov/mws/serf/CLIMLIST

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C1000000444-
NSIDC_ECS



ECHO 10 Granule -
https://cmr.earthdata.nasa.gov:443/search/concepts/G7108549- LARC_ASDC

ISO 19115-2 -
https://cmr.earthdata.nasa.gov:443/search/concepts/C1000000444-
NSIDC_ECS.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

EMS - NSIDCVO flat file

Recommendations

Instruments should be reconciled so all keywords are controlled within the
CMR through the keyword management system.

A.B.21 Project

Element Specification

Project
Project/ShortName (1)
Project/Campaign (0..*)
Project/LongName (0..1)
Project/StartDate (0..1)
Project/EndDate (0..1)

Description

The project element describes the name of the scientific program, field
campaign, or project from which the data were collected. This element may
also cover along term project that continuously creates new data sets - like
MEaSUREs from ISCCP and NVAP or CMARES from MISR.

Project also includes the Campaign sub-element to support multiple
campaigns under the same project.



Profile Utilization

Collection, Granule, Service, Document

Cardinality

0..*

Analysis

This element is found in both ECHO, where it is not controlled, and within
GCMD, where it is controlled. Multiple campaigns can be associated with
the same project, which is not represented in either GCMD or ECHO
(keyword with no hierarchy in either format). The EMS element is mapped
to UMM/Platform/ShortName; EMS "Mission" can also be mapped to
UMM/Project/Campaign if applicable. EMS intends to use only one value
and employ mission, platform, and project (in this order) based on the
availability of the information. Because the Project element is required in
the UMM-C, EMS may not have to use platform or any other element; thus,
no mapping is required.



Mapping

DIF 9 /DIF/Project/

DIF 10 /DIF/Project/

SERF /SERF/Project/

ECHO 10 |/Collection/Campaigns/Campaign/

Collection

ECHO 10 | /Granule/Campaigns/Campaign/

Granule

ISO /

19115-2 gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI AcquisitionIn
formation/gmi:operation/gmi:MI Operation/
and
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificatio
n/gmd:descriptiveKeywords/gmd:MD Keywords/gmd:keyword/gco:
CharacterString
with
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificatio
n/gmd:descriptiveKeywords/gmd:MD_ Keywords/gmd:keyword/gmd
:type/MD KeywordTypeCode[@codeListValue="project"]

ISO /

19115-1 mdb:MD Metadata/mdb:acquisitionInformation/mac:MI_ Acquisitio
nInformation/mac:operation/mac:MI Operation
and
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificati
on/mri:descriptiveKeywords/mri:MD Keywords/mri:keyword/gco:C
haracterString
with
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD Dataldentificati
on/mri:descriptiveKeywords/mri:MD _ Keywords/mri:keyword/mri:ty
pe/mri:MD KeywordTypeCode
codeList="http://standards.iso.org/iso/19115/resources/Codelist/cat
/codelists.xml#MD _ KeywordTypeCode"

codeListValue="project"
EMS mission
Examples

DIF 9




<Project uuid="f560fb6c- 341d- 4626- 969f-2978d261f161" >
<Short_Name>0OBIS</Short_Name>

<Long_Name>OCEAN BIOGEOGRAPHIC INFORMATION
SYSTEM</Long_Name>

</Project>

<Project uuid="bb4e35cc- 520c- 4d24- 984f-d81ch2965a85" >
<Short_Name>COML </Short_Name>
<Long_Name>CENSUS OF MARINE LIFE</Long_Name>

</Project>

DIF 10

<Project>

<Short_Name>MEASURES</Short_Name>
<Campaign>S0O2</Campaign>
<Long_Name>Making Earth Science Data Records for Use in Research
Environments</Long_Name>
</Project>

SERF

<Project uuid="687d4231- 8da8- 4236-9cc4-26d7ff198578" >
<Short_Name>UNEP/GRID</Short_Name>

<Long_Name>UNEP/Global Resources Information
Database</Long_Name>

</Project>

ECHO 10 Caollection

<Campaigns>
<Campaign>
<ShortName>2009_AN_NASA</ShortName>
<LongName>Operation IceBridge West Antarctica/Antarctic Sea Ice




2009</LongName>
<StartDate>2009- 01-01T00:00:00Z</StartDate>
<EndDate>2009- 12-31T00:00:00Z</EndD ate>
</Campaign>
<Campaign>
<ShortName>2010_GR_NASA</ShortName>
<LongName>Operation IceBridge Greenland/Arctic Sea Ice
2010</LongName>
<StartDate>2010- 01-01T00:00:00Z</StartDate>
<EndDate>2010- 12-31T00:00:00Z</EndDate>
</Campaign>
<Campaign>
<ShortName>2010_AN_NASA</ShortName>
<LongName>Operation lceBridge West Antarctica/Antarctic Sea Ice
2010</LongName>
<StartDate>2010- 01-01T00:00:00Z</StartDate>
<EndDate>2010- 12-31T00:00:00Z</EndD ate>
</Campaign>
<Campaign>
<ShortName>2011_ GR_NASA</ShortName>
<LongName>Operation IceBridge Greenland/Arctic Sea Ice
2011</LongName>
<StartDate>2011- 01-01T00:00:00Z</StartDate>
<EndDate>2011- 12-31T00:00:00Z</EndDate>
</Campaign>

</Campaigns>

ECHO 10 Granule

<Campaigns><Campaign><ShortName>AIRM SPI</ShortName></Camp
aign></Campaigns>

SO 19115-2

<gmi:operation>
<gmi:MI_Operation>
<gmi:description>
<gco:CharacterString>2009_AN_NASA &gt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2009 2009-01-01T00:00:00Z to 2009- 12-
31T00:00:00Z</gco:CharacterString>




</gmi:description>
<gmi:identifier>
<gmd:MD_Ildentifier>
<gmd:code>
<gco:CharacterString>2009_AN_NASA</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:status/>
<gmi:parentOperation gco:nilReason="inapplicable"/>
</gmi:MI|_Operation>
</gmi:operation>
<gmi:operation>
<gmi:MI_Operation>
<gmi:description>
<gco:CharacterString>2010_GR_NASA &qgt; Operation IceBridge
Greenland/Arctic Sea Ice 2010 2010-01-01T00:00:00Z to 2010- 12-
31T00:00:00Z</gco:CharacterString>
</gmi:description>
<gmi:identifier>
<gmd:MD_Ildentifier>
<gmd:code>
<gco:CharacterString>2010_GR_NASA</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:status/>
<gmi:parentOperation gco:nilReason="inapplicable"/>
</gmi:MI|_Operation>
</gmi:operation>
<gmi:operation>
<gmi:MI_Operation>
<gmi:description>
<gco:CharacterString>2010_AN_NASA &qgt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2010 2010-01-01T00:00:00Z to 2010- 12-
31T00:00:00Z</gco:CharacterString>
</gmi:description>
<gmi:identifier>
<gmd:MD_Ildentifier>
<gmd:code>
<gco:CharacterString>2010_AN_NASA</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:status/>




<gmi:parentOperation gco:nilReason="inapplicable"/>
</gmi:MI|_Operation>
</gmi:operation>
<gmi:operation>
<gmi:MI_Operation>
<gmi:description>
<gco:CharacterString>2011 GR_NASA &qgt; Operation IceBridge
Greenland/Arctic Sea Ice 2011 2011-01-01T00:00:00Z to 2011-12-
31T00:00:00Z</gco:CharacterString>
</gmi:description>
<gmi:identifier>
<gmd:MD_Ildentifier>
<gmd:code>
<gco:CharacterString>2011_GR_NASA</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmi:identifier>
<gmi:status/>
<gmi:parentOperation gco:nilReason="inapplicable"/>
</gmi:MI|_Operation>
</gmi:operation>

<gmd:descriptiveKeywords>
<gmd:MD_Keywords>
<gmd:keyword>
<gco:CharacterString>2009_AN_NASA &gt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2009</gco:CharacterString>
</gmd:keyword>
<gmd:keyword>
<gco:CharacterString>2010_GR_NASA &qgt; Operation IceBridge
Greenland/Arctic Sea Ice 2010</gco:CharacterString>
</gmd:keyword>
<gmd:keyword>
<gco:CharacterString>2010_AN_NASA &gt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2010</gco:CharacterString>
</gmd:keyword>
<gmd:keyword>
<gco:CharacterString>2011_GR_NASA &gt; Operation IceBridge
Greenland/Arctic Sea Ice 2011</gco:CharacterString>
</gmd:keyword>




</gmd:keyword>
<gmd:type>
<gmd:MD_KeywordTypeCode
codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#MD_KeywordTypeCode"
codeListValue="project">project</gmd:MD_KeywordTypeCode>
</gmd:type>
<gmd:thesaurusName>
<gmd:CIl_Citation>
<gmd:title>
<gco:CharacterString>NASA/GCMD Project
Keywords</gco:CharacterString>
</gmd:title>
<gmd:date gco:nilReason="unknown"/>
<gmd:citedResponsibleParty>

</gmd:citedResponsibleParty>
</gmd:Cl_Citation>
</gmd:thesaurusName>
</gmd:MD_Keywords>
</gmd:descriptiveKeywords>

SO 19115-1

<mac:operation>
<mac:MI_Operation>
<mac:description>
<gco:CharacterString>2009_AN_NASA &gt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2009 2009-01-01T00:00:00Z to 2009- 12-
31T00:00:00Z</gco:CharacterString>
</mac:description>

<mac:identifier>

<mcc:MD_ldentifier>




<mcc:code>
<gco:CharacterString>2009_AN_NASA</gco:CharacterString>
</mcc:code>
</mcc:MD_Ildentifier>
</mac:identifier>
<mac:status/>
<mac:parentOperation gco:nilReason="inapplicable"/>
</mac:M|_Operation>
</mac:operation>
<mac:operation>
<mac:MI_Operation>
<mac:description>
<gco:CharacterString>2010_GR_NASA &qgt; Operation IceBridge
Greenland/Arctic Sea Ice 2010 2010-01-01T00:00:00Z to 2010-12-
31T00:00:00Z</gco:CharacterString>
</mac:description>
<mac:identifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>2010_GR_NASA</gco:CharacterString>
</mcc:code>
</mcc:MD_Ildentifier>

</mac:identifier>




<mac:status/>
<mac:parentOperation gco:nilReason="inapplicable"/>
</mac:M|_Operation>
</mac:operation>
<mac:operation>
<mac:MI|_Operation>
<mac:description>
<gco:CharacterString>2010_AN_NASA &gt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2010 2010-01-01T00:00:00Z to 2010-12-
31T00:00:00Z</gco:CharacterString>
</mac:description>
<mac:identifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>2010_AN_NASA</gco:CharacterString>
</mcc:code>
</mcc:MD_Identifier>
</mac:identifier>
<mac:status/>
<mac:parentOperation gco:nilReason="inapplicable"/>
</mac:MI|_Operation>
</mac:operation>

<mac:operation>




<mac:MI|_Operation>
<mac:description>
<gco:CharacterString>2011_GR_NASA &gt; Operation IceBridge
Greenland/Arctic Sea Ice 2011 2011-01-01T00:00:00Z to 2011-12-
31T00:00:00Z</gco:CharacterString>
</mac:description>
<mac:identifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>2011_GR_NASA</gco:CharacterString>
</mcc:code>
</mcc:MD_Identifier>
</mac:identifier>
<mac:status/>
<mac:parentOperation gco:nilReason="inapplicable"/>
</mac:M|_Operation>

</mac:operation>

<mri:descriptiveKeywords>
<mri:MD_Keywords>
<mri:keyword>

<gco:CharacterString>2009_AN_NASA &gt; Operation
IceBridge West Antarctica/Antarctic Sea Ice 2009</gco:CharacterString>




</mri:keyword>

<mri:keyword>

<gco:CharacterString>2010_GR_NASA &qgt; Operation IceBridge
Greenland/Arctic Sea Ice 2010</gco:CharacterString>

</mri:keyword>

<mri:keyword>

<gco:CharacterString>2010_AN_NASA &qgt; Operation IceBridge
West Antarctica/Antarctic Sea Ice 2010</gco:CharacterString>

</mri:keyword>

<mri:keyword>

<gco:CharacterString>2011_GR_NASA &gt; Operation IceBridge
Greenland/Arctic Sea Ice 2011</gco:CharacterString>

</mri:keyword>

<mri:type>
<mri:MD_KeywordTypeCode
codeList="http://standards.iso.org/iso/19115/resources/Codelist/cat/codelis
ts.xml#MD_KeywordTypeCode"codelListValue="project">project</mri:MD
_KeywordTypeCode>

</mri:type>

</mri:MD_Keywords>

</mri:descriptiveKeywords>

EMS Flat File

IceBridge

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591412-
SCIOPS
DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1224770842-



GES _DISC
SERF - http://gcmd.gsfc.nasa.gov/mws/serf/01- Arctic_Atlas- 00

ECHO 10 Collection -
https://cmr.earthdata.nasa.gov:443/search/concepts/C190766021-

NSIDC _ECS

ECHO 10 Granule -
https://cmr.earthdata.nasa.gov:443/search/concepts/G7108549- LARC _ASDC

ISO 19115-2 -

https://cmr.earthdata.nasa.gov:443/search/concepts/C190766021-
NSIDC_ECS.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

EMS - NSIDCVO flat file



Recommendations

Project keywords should be reconciled with the GCMD project keywords so
all keywords are controlled within the CMR through the keyword
management system.

A.B.22 Temporal Extent
Element Specification
Temporal Extent/TemporalRangeType (0..1)
Temporal Extent/PrecisionOfSeconds (0..1)
Temporal Extent/EndsAtPresentFlag (0..1)

{Choice of 1}
1) Temporal Extent/RangeDateTime (0..*)

Temporal Extent/RangeDateTime/BeginningDateTime (1)

Temporal Extent/RangeDateTime/EndingDateTime (0..1)

2) Temporal Extent/SingleDateTime (0..*)

3) TemporalExtent/PeriodicDateTime  (1..*)

Temporal Extent/PeriodicDateTime/Name (1)

Temporal Extent/PeriodicDateTime/StartDate (1)

Temporal Extent/PeriodicDateTime/EndDate (1)

Temporal Extent/PeriodicDateTime/DurationUnit (1)
Temporal Extent/PeriodicDateTime/DurationValue (1)
Temporal Extent/PeriodicDateTime/PeriodCycleDurationUnit (1)

Temporal Extent/PeriodicDateTime/PeriodCycleDurationValue (1)

Description



This element contains sub-elements, which describe the time period in
which the data set was acquired or when the measurements occured for a
specific collection. This extent can be represented in a variety of ways:
RangeDateTime, SingleDateTime, or PeriodicDateTime.

Profile Utilization

Collection, Granule

Cardinality

1.*

Analysis

This element is found in both ECHO and GCMD. The GCMD
Temporal Coverage element is described here:
http://gemd.gsfc.nasa.gov/add/difguide/temporal coverage.html and
supports range date and times.

ECHO's Temporal element is defined here:
https://api.echo.nasa.gov/ingest/schema/collection/Temporal.html and
supports single date and time, range date and times, and period date and
times, among other attributes. The Temporal element also supports
temporal resolution data.

Mapping
DIF 9 /DIF/Temporal Coverage
DIF 10 {Choice of one}

1) /DIF/Temporal Coverage/Range DateTime/
2) /DIF/Temporal Coverage/Single DateTime/
3) /DIF/Temporal Coverage/Periodic DateTime/

SERF N/A

ECHO 10 |/Collection/Temporal/TimeType
Collection |/Collection/Temporal/DateType




/Collection/Temporal/TemporalRangeType
/Collection/Temporal/PrecisionOfSeconds
/Collection/Temporal/EndsAtPresentFlag
{Choice of one}

1) /Collection/Temporal/RangeDateTime
2) /Collection/Temporal/SingleDateTime
3) /Collection/Temporal/PeriodicDateTime

ECHO 10
Granule

{Choice of one}
1)/Granule/Temporal/RangeDateTime/BeginningDateTime
/Granule/Temporal/RangeDateTime/EndingDateTime

2)/Granule/Temporal/SingleDateTime

ISO
19115-2

/

gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificatio
n/gmd:extent/gmd:EX Extent
id="boundingExtent"/gmd:description/gco:CharacterString -
TimeType and TemporalRangeType

/

gmi:MI Metadata/gmd:dataQualityInfo/gmd:DQ_DataQuality/gmd:r
eport/gmd:DQ_ AccuracyOfATimeMeasurement/gmd:measureldentif
ication/gmd:MD _ Identifier/gmd:code/gco:CharacterString
PrecisionOfSeconds

/

gmi:MI Metadata/gmd:dataQualitylnfo/gmd:DQ_DataQuality/gmd:r
eport/gmd:DQ_AccuracyOfATimeMeasurement/gmd:result/gmd:DQ
_QuantitativeResult/gmd:value/gco:Record

xsi:type="gco:Real PropertyType"/gco:Real - PrecisionOfSeconds
Value

1)/gmi:MI Metadata/gmd:identificationInfo/gmd:MD_ Dataldentifica
tion/gmd:extent/gmd:EX Extent/gmd:temporalElement/gmd:EX Te
mporalExtent/gmd:extent/gml:TimePeriod/gml:beginPosition
/gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificati
on/gmd:extent/gmd:EX Extent/gmd:temporalElement/gmd:EX Tem
poralExtent/gmd:extent/gml:TimePeriod/gml:endPosition

2/gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentificat
ion/gmd:extent/gmd:EX Extent/gmd:temporalElement/gmd:EX Te
mporalExtent/gmd:extent/gml:TimelInstant/gml:timePosition

ISO
19115-1

/

mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificati
on/mri:extent/gex:EX Extent/gex:description/gco:CharacterString

/

mdb:MD Metadata/mdb:dataQualityInfo/mdq:DQ_DataQuality/mdq:
report/mdq:DQ_AccuracyOfATimeMeasurement/mdq:measure/mdq:
DQ MeasureReference/mdq:measureldentification/mcc:MD Identifi
er/mcc:code/gco:CharacterString PrecisionOfSeconds




EMS

/

mdb:MD Metadata/mdb:dataQualityInfo/mdq:DQ_DataQuality/mdq:
report/mdq:DQ_AccuracyOfATimeMeasurement/mdq:result/mdq:D
Q QuantitativeResult/mdq:value/gco:Record

xsi:type="gco:Real PropertyType"/gco:Real PrecisionOfSeconds
Value

1)/mdb:MD_ Metadata/mdb:identificationInfo/mri:MD Dataldentific
ation/mri:extent/gex:EX Extent/gex:temporalElement/gex:EX Temp
oralExtent/gex:extent/gml:TimePeriod/gml:beginPosition

/

mdb:MD Metadata/mdb:identificationInfo/mri:MD_ Dataldentificati
on/mri:extent/gex:EX Extent/gex:temporalElement/gex:EX Tempor
alExtent/gex:extent/gml:TimePeriod/gml:endPosition

2)/mdb:MD_ Metadata/mdb:identificationInfo/mri:MD_ Dataldentific
ation/mri:extent/gex:EX Extent/gex:temporalElement/gex:EX Temp
oralExtent/gex:extent/ gml:Timelnstant/gml:timePosition

N/A

Examples

DIF 9

<Temporal Coverage>
<Start Date>2005- 10-29</Start Date>
<Stop_Date>2005-11-21</Stop_Date>

</Temporal Coverage>

DIF 10

<Temporal Coverage>

<Time Type>UTC</Time Type>

<Date Type>Gregorian</Date Type>
<Temporal Range Type>Continuous Range</Temporal Range Type>
<Precision_Of Seconds>1</Precision Of Seconds>

<Range DateTime>

<Beginning Date Time>2002- 05-
04T00:00:00.000Z</Beginning Date Time>
</Range DateTime>
</Temporal Coverage>




ECHO 10 Collection

<Temporal >
<TimeType>Universal Time</TimeType>
<DateType>Eastern Daylight</DateType>
<TemporalRangeType>Long Range</TemporalRangeType>
<PrecisionOfSeconds>1</PrecisionOf Seconds>
<EndsAtPresentFlag>true</EndsAtPresentFlag>
<RangeDateTime>
<BeginningDateTime>1990- 01-01T00:00:00Z</BeginningDateTime>
<EndingDateTime>2003- 12-31T00:00:00Z</EndingDateTime>

</RangeDateTime>

</Temporal >

ECHO 10 Granule

<RangeDateTime>
<BeginningDateTime>2006- 01-15T00:00:00.000Z</BeginningDateTime>
<EndingDateTime>2006- 01-23T00:00:00.000Z</EndingDateTime>

</RangeDateTime>

<SingleDateTime>2002- 02-27T723:49:24.0000000Z</SingleDateTime>

SO 19115-2

<gmd:extent>




<gmd:EX_Extent id="boundingExtent">
<gmd:description>
<gco:CharacterString>SpatialCoverageType=Horizontal,
SpatiallnfoCoverageType=Horizontal,
Spatial Granul eSpatialRepresentation=CARTESIAN, Temporal Range
Type=Long Range, Time Type=Universal Time</gco:CharacterString>
</gmd:description>
<!--Bounding Rectangle--><gmd:geographicElement>
<gmd:EX_GeographicBoundingBox>
<gmd:westBoundLongitude>
<gco:Decimal >- 180</gco:Decimal >
</gmd:westBoundLongitude>
<gmd:eastBoundLongitude>
<gco:Decimal>180</gco:Decimal >
</gmd:eastBoundLongitude>
<gmd:southBoundL atitude>
<gco:Decimal >- 55</gco:Decimal >
</gmd:southBoundL atitude>
<gmd:northBoundL atitude>
<gco:Decimal>90</gco:Decimal >
</gmd:northBoundL atitude>
</gmd:EX_GeographicBoundingBox>

</gmd:geographicElement>

<gmd:temporal Element><!- -RangeDateTime- -




><gmd:EX_Temporal Extent id="boundingTemporal Extent">
<gmd:extent>
<gml:TimePeriod gml:id="wl6aac43c11">

<gml:beginPosition frame="Eastern Daylight">1990- 01-
01T00:00:00Z</gml:beginPosition>

<gml:endPosition frame="Eastern Daylight"
indeterminatePosition="now"/>

</gml:TimePeriod>
</gmd:extent>
</gmd:EX_Temporal Extent>
</gmd:temporal Element>
</gmd:EX_Extent>

</gmd:extent>

<gmd:dataQualitylnfo>
<gmd:DQ_DataQuality>
<gmd:scope>
<gmd:DQ_Scope>
<gmd:level>
<gmd:MD_ScopeCode

codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#M D_ScopeCode”

codeListValue="series">series</gmd:MD_ScopeCode>

</gmd:level >




</gmd:DQ_Scope>
</gmd:scope>
<gmd:report>
<gmd:DQ_AccuracyOfATimeMeasurement >
<gmd:measureldentification>
<gmd:MD_Ildentifier>

<gmd:code>

<gco:CharacterString>PrecisionOf Seconds</gco:CharacterString>
</gmd:code>
</gmd:MD_ldentifier>
</gmd:measureldentification>
<gmd:result>
<gmd:DQ_QuantitativeResult>
<gmd:valueUnit/>
<gmd:value>
<gco:Record xsi:type="gco:Real PropertyType">
<gco:Real>1</gco:Real >
</gco:Record>
</gmd:value>
</gmd:DQ_QuantitativeResult>
</gmd:result>

</gmd:DQ_AccuracyOfATimeM easurement>




| </gmd:report>

SO 19115-1

<mri:extent>
<gex:EX_Extent id="boundingExtent">
<gex:description>
<gco:CharacterString>SpatialCoverageType=Horizontal,
SpatiallnfoCoverageType=Horizontal,
SpatialGranuleSpatialRepresentation=CARTESIAN, Temporal Range
Type=Long Range, Time Type=Universal Time</gco:CharacterString>
</gex:description>
<gex:geographicElement>
<gex:EX_GeographicBoundingBox>
<gex:westBoundLongitude>
<gco:Decimal >- 180</gco:Decimal >
</gex:westBoundLongitude>
<gex:eastBoundLongitude>
<gco:Decimal>180</gco:Decimal >
</gex:eastBoundLongitude>
<gex:southBoundL atitude>
<gco:Decimal >- 55</gco:Decimal >
</gex:southBoundL atitude>

<gex:northBoundL atitude>

<gco:Decimal>90</gco:Decimal >




</gex:northBoundL atitude>
</gex:EX_GeographicBoundingBox>
</gex:geographicElement>
<gex:temporalElement>
<gex:EX_Temporal Extent id="boundingTemporal Extent">
<gex:extent>
<gml:TimePeriod gml:id="d94e190" >

<gml:beginPosition frame="Eastern Daylight">1990- 01-
01T00:00:00Z</gml:beginPosition>

<gml:endPosition frame="Eastern Daylight"
indeterminatePosition="now"/>

</gml:TimePeriod>
</gex:extent>
</gex:EX_Temporal Extent>
</gex:temporal Element>
</gex:EX_Extent>

</mri:extent>

<mdb:dataQualitylnfo>
<mdq:DQ_DataQuality>
<mdq:scope>
<mcc:MD_Scope>

<mcc:level >

<mcc:MD_ScopeCode




codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.
xml#M D_ScopeCode"
codeListValue="series">series</mcc:MD_ScopeCode>
</mcc:level >
</mcc:MD_Scope>
</mdq:scope>
<mdq:report>
<mdq:DQ_AccuracyOfATimeMeasurement>
<mdqg:measure>
<mdqg:DQ_MeasureReference>
<mdq:measureldentification>
<mcc:MD_ldentifier>

<mcc:code>

<gco:CharacterString>PrecisionOf Seconds</gco:CharacterString>
</mcc:code>
</mcc:MD_lIdentifier>
</mdq: measureldentification>
</mdq:DQ_MeasureReference>
</mdqg: measure>
<mdq:evaluationM ethod>
<mdq:DQ_Fulllnspection>

<mdq:evaluationProcedure/>




</mdq:DQ_Fulllnspection>
</mdg:evaluationM ethod>
<mdq:result>
<mdqg:DQ_QuantitativeResult>
<mdq:value>
<gco:Record xsi:type="gco:Real_PropertyType">
<gco:Real>1</gco:Real >
</gco:Record>
</mdqg:value>
<mdgq:valueUnit/>
</mdq:DQ_QuantitativeResult>
</mdgq:result>

</mdq:DQ_AccuracyOfATimeM easurement >

</mdg:report>

Source Data Information:

DIF 9 - https://cmr.earthdata.nasa.gov:443/search/concepts/C1214591238-
SCIOPS

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C90764068-
LAADS

ECHO 10 Collection -

https://cmr.earthdata.nasa.gov:443/search/concepts/C179001954- SEDAC
ECHO 10 Granule -

https://cmr.earthdata.nasa.gov:443/search/concepts/G187435093- LARC

ISO 19115-2 -

https://cmr.earthdata.nasa.gov:443/search/concepts/C179001954-
SEDAC.iso



ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

Recommendations

ECHO's Temporal element should be adopted by the UMM -as it is a
superset of what GCMD supports and can capture single date and times,
range date and times, and periodic date and times, as well as temporal
resolution data.

Finally, any dates, times, or temporal ranges specified in the
TemporalCoverage element should use the 1SO 8601 format. Unknown
dates can also be represented in the 1SO 8601 format.

There are several elements in the ECHO schema (such as
/Collection/Temporal/DateType and TimeType) that need cleanup, revision,
or deprecation.

A.B.23 Spatial Extent
Element Specification

Spatial Extent/SpatialCoverageType (0..1) <HORIZONTAL, VERTICAL,
ORBITAL, HORIZONTAL_VERTICAL, ORBITAL_VERTICAL>
SpatialExtent/Horizontal SpatialDomain (0..1)

Spatial Extent/Horizontal SpatialDomain/Zoneldentifier (0..1)
SpatialExtent/Horizontal SpatialDomain/Geometry (1)

Spatial Extent/Horizontal SpatialDomain/Geometry/CoordinateSystem (1)
<CARTESIAN, GEODETIC>

{choice of 1..*}

1)Spatial Extent/Horizontal SpatialDomain/Geometry/Points

2)Spatial Extent/Horizontal SpatialDomain/Geometry/BoundingRectangles

3)Spatial Extent/Horizontal SpatialDomain/Geometry/GPolygons

4)Spatial Extent/Horizontal SpatialDomain/Geometry/Lines



Spatial Extent/Vertical SpatialDomain (0..*)
SpatialExtent/Vertical SpatialDomain/Type (1)
SpatialExtent/Vertical SpatialDomain/Value (1)

Spatial Extent/Vertical SpatialDomain/Unit (1)
SpatialExtent/OrbitParameters (0..1)

Spatial Extent/OrbitParameters/SwathWidth (1)

Spatial Extent/OrbitParameters/Period (1)
SpatialExtent/OrbitParameters/InclinationAngle (1)
SpatialExtent/OrbitParameters/NumberOfOrbits (1)
Spatial Extent/OrbitParameters/StartCircularLatitude (0..1)

Spatial Extent/GranuleSpatialRepresentation (1) <CARTESIAN,
GEODETIC, ORBIT, NO_SPATIAL>

Description

Specifies the geographic and vertical (altitude, depth) coverage of the data.

Profile Utilization

Collection, Granule

Cardinality

1

Analysis



This element is found in both GCMD and ECHO. Spatial metadata describes
the area of Earth that a collection covers. In DIF 9, the spatial extent is
represented as a bounding box using a Cartesian coordinate system. In
ECHO, spatial data can be represented in both Cartesian and Geodetic
coordinate systems or as orbits. The Cartesian and Geodetic (World
Geodetic System (WGS) 84) coordinate systems accept spatial data types of
Point, Line, Bounding Rectangle and Polygon. See ECHO's Data Partner
User Guide for more details on ECHO's support for spatial data.



Mapping

DIF 9

The first four are Bounding Rectangle in DIF 10.
/DIF/Spatial Coverage/Southernmost Latitude

/DIF/Spatial Coverage/Northernmost Latitude
/DIF/Spatial Coverage/Westernmost Longitude
/DIF/Spatial Coverage/Easternmost Longitude
Minimum_Altitude

Maximum_Altitude

Maximum_Depth

or

/DIF/Extended Metadata for more complicated geometries

DIF 10

SERF

/DIF/Spatial Coverage/Spatial Coverage Type
/DIF/Spatial Coverage/Granule Spatial Representation
/DIF/Spatial Coverage/Zone Identifier
/DIF/Spatial Coverage/Geometry/Coordinate System
{Choice of 1}
1)/DIF/Spatial Coverage/Geometry/Bounding Rectangle
2)/DIF/Spatial Coverage/Geometry/Point
3)/DIF/Spatial Coverage/Geometry/Line
4)/DIF/Spatial Coverage/Geometry/Polygon
/DIF/Spatial Coverage/Orbit Parameters/Swath Width
/DIF/Spatial Coverage/Orbit Parameters/Period
/DIF/Spatial Coverage/Orbit Parameters/Inclination_Angle
/DIF/Spatial Coverage/Orbit Parameters/Number Of Orbits
/DIF/Spatial Coverage/Orbit Parameters/Start Circular Latitude
/DIF/Spatial Coverage/Vertical Spatial Info/Type
/DIF/Spatial Coverage/Vertical Spatial Info/Value
/DIF/Spatial Coverage/Minimum_Altitude
/DIF/Spatial Coverage/Maximum_Altitude
/DIF/Spatial Coverage/Altitude Unit
/DIF/Spatial Coverage/Minimum_Depth
/DIF/Spatial Coverage/Maximum_Depth
/DIF/Spatial Coverage/Depth Unit
/DIF/Spatial Coverage/Spatial Info

N/A

ECHO
10
Collecti
on

/Collection/Spatial/SpatialCoverageType
/Collection/Spatial/HorizontalSpatialDomain
/Collection/Spatial/HorizontalSpatialDomain/Zoneldentifier
/

Collection/Spatial/HorizontalSpatialDomain/Geometry/CoordinateSyste

m




{Choice of 1..*}

1) /Collection/Spatial/HorizontalSpatialDomain/Geometry/Point

2)
/Collection/Spatial/HorizontalSpatialDomain/Geometry/BoundingRectagl
e

3) /Collection/Spatial/HorizontalSpatialDomain/Geometry/GPolygon

4) /Collection/Spatial/HorizontalSpatialDomain/Geometry/Line
/Collection/Spatial/VerticalSpatialDomain
/Collection/Spatial/VerticalSpatialDomain/Type
/Collection/Spatial/VerticalSpatialDomain/Value
/Collection/Spatial/OrbitParameters/SwathWidth
/Collection/Spatial/OrbitParameters/Period
/Collection/Spatial/OrbitParameters/InclinationAngle
/Collection/Spatial/OrbitParameters/NumberOfOrbits
/Collection/Spatial/OrbitParameters/StartCircularLatitude
/Collection/Spatial/GranuleSpatialRepresentation

ECHO
10
Granule

/Granule/Spatial/VerticalSpatialDomains/VerticalSpatialDomain/Type
/Granule/Spatial/VerticalSpatialDomains/VerticalSpatialDomain/Value

OPTION

1)/Granule/Spatial/HorizontalSpatialDomain/Geometry/Point/PointLongi
tude

/Granule/Spatial/HorizontalSpatialDomain/Geometry/Point/PointLatitud
e
2)/Granule/Spatial/HorizontalSpatialDomain/Geometry/Line/Point/Point
Longitude

/Granule/Spatial/HorizontalSpatialDomain/Geometry/Line/Point/PointLat
itude
3)/Granule/Spatial/HorizontalSpatialDomain/Geometry/GPolygon/Bound
ary/Point/PointLongitude

/
Granule/Spatial/HorizontalSpatialDomain/Geometry/GPolygon/Boundary
/Point/PointLatitude
4)/Granule/Spatial/HorizontalSpatialDomain/Geometry/BoundingRectan
gle/WestBoundingCoordinate

/
Granule/Spatial/HorizontalSpatialDomain/Geometry/BoundingRectangle
/NorthBoundingCoordinate

/
Granule/Spatial/HorizontalSpatialDomain/Geometry/BoundingRectangle
/EastBoundingCoordinate

/
Granule/Spatial/HorizontalSpatialDomain/Geometry/BoundingRectangle
/SouthBoundingCoordinate




5)/Granul e/Spatial/Horizontal SpatialDomain/Geometry/BoundingRectan
gle/CenterPoint/PointLongitude

/IGranule/Spatial/Horizontal SpatialDomain/Geometry/BoundingRectangl

e/CenterPoint/PointL atitude

6)/Granul e/Spatial/Horizontal SpatialDomain/Geometry/GPolygon/Center
Point/PointLongitude

/

Granule/Spatial/Horizontal SpatialDomain/Geometry/GPolygon/CenterPo
int/PointLatitude

7)/Granule/Spatial/Horizontal SpatialDomain/Geometry/GPolygon/Bound
ary

with

/Granule/Spatial/Horizontal SpatialDomain/Geometry/GPolygon/Exclusiv
eZone/Boundary

8)/Granul e/Spatial/Horizontal SpatialDomain/Orbit

1SO
19115-2

/
gmi:MI_Metadata/gmd:identificationlnfo/gmd:MD_Dataldentification/g
md:extent/gmd:EX_Extent/gmd:description/gco:CharacterString

with format:

Vertical SpatialDomainType= {type}, VerticalSpatialDomainValue=
{value}

BASE XPATH=/gmi:MI|_Metadata/gmd:identificationInfo/gmd:MD_Datal
dentification/gmd:extent/gmd:EX_Extent/gmd:geographicElement

This section is used by collections —used by granules options 1-7
BASE_XPATH/gmd:EX_GeographicBoundingBox/gmd:westBoundLongitu
de/gco:Decimal
BASE_XPATH/gmd:EX_GeographicBoundingBox/gmd:eastBoundLongitu
de/gco:Decimal

BASE XPATH/gmd:EX_GeographicBoundingBox/gmd:southBoundL atitu
de/gco:Decimal
BASE_XPATH/gmd:EX_GeographicBoundingBox/gmd:northBoundL atitu
de/gco:Decimal

and

BASE _XPATH/gmd:EX_BoundingPolygon/gmd:polygon/gml:Point/gml:po
s

- Used by Granule Option 1,5

or

BASE _XPATH/gmd:EX_BoundingPolygon/gmd:polygon/gml:LineString/g
ml:posList

- Used by Granule Option 2,6

or

BASE _XPATH/gmd:EX_BoundingPolygon/gmd:polygon/gml:Polygon/gml:
exterior/gml:LinearRing/gml:posList - Used by Granule Option 3,6,7




BASE XPATH/gmd:EX BoundingPolygon/gmd:polygon/gml:Polygon/gml:
exterior/gml:LinearRing/gml:posList - Used by Granule Option 7

BASE XPATH/gmd:EX BoundingPolygon/gmd:extentTypeCode/gco:Bool
ean set to 0 (Holes) - Used by Granule Option 7

Granule Option 8

/

gmi:MI Metadata/gmi:acquisitionInformation/gmi:MI_ AcquisitionInform
ation/gmi:platform/eos:EOS Platform/eos:otherProperty/gco:Record/eos
:AdditionalAttributes/eos:AdditionalAttribute/eos:value/gco:CharacterSt
ring

with
eos:EOS_AdditionalAttributeTypeCode[@codeListValue="platformInfor
mation"|

ISO
19115-1

/

mdb:MD Metadata/mdb:identificationInfo/mri:MD _ Dataldentification/m
ri;extent/gex:EX Extent[@id='boundingExtent']/gex:description/gco:Cha
racterString

with format:

VerticalSpatialDomainType= {type}, VerticalSpatialDomainValue=
{value}

BASE XPATH=/mdb:MD_ Metadata/mdb:identificationInfo/mri:MD_ Data
Identification/mri:extent/EX Extent[@id='boundingExtent']/gex:geograp
hicElement/

This section is used by collections —used by granules options 1-7

/

BASE XPATH/gex:EX GeographicBoundingBox/gex:westBoundLongitud
e/gco:Decimal

/

BASE XPATH/gex:EX GeographicBoundingBox/gex:eastBoundLongitud
e/gco:Decimal

/

BASE XPATH/gex:EX GeographicBoundingBox/gex:southBoundLatitude
/gco:Decimal

/

BASE XPATH/gex:EX GeographicBoundingBox/gex:northBoundLatitude
/gco:Decimal

and

/BASE _XPATH/gex:EX BoundingPolygon/gex:polygon/gml:Point/gml:pos
- Used by Granule Option 1,5

/

BASE XPATH/gex:EX BoundingPolygon/gex:polygon/gml:LineString/gm
l:posList

- Used by Granule Option 2,6




BASE XPATH/gex:EX BoundingPolygon/gex:polygon/gml:Polygon/gml:e
xterior/gml:LinearRing/gml:posList - Used by Granule Option 3,6,7

BASE XPATH/gex:EX BoundingPolygon/gex:polygon/gml:Polygon/gml:i
nterior/gml:LinearRing/gml:posList - Used by Granule Option 7

Granule Option 8

/

mdb:MD Metadata/mdb:acquisitionInformation/mac:MI AcquisitionInfo
rmation/mac:platform/eos:EOS_ Platform/mac:otherProperty/gco:Record
/mac:AdditionalAttributes/mac:AdditionalAttribute/mac:value/gco:Chara
cterString

with
eos:EOS_AdditionalAttributeTypeCode[@codeListValue="platformInfor
mation" ]
eos:EOS_AdditionalAttributeTypeCode[@codeListValue="AscendingCro
ssing "]
eos:EOS_AdditionalAttributeTypeCode[@codeListValue="StartLat"]
eos:EOS_AdditionalAttributeTypeCode[@codeListValue="StartDirection
"]

eos:EOS_AdditionalAttributeTypeCode[@codeListValue="EndLat"]

eos:EOS_AdditionalAttributeTypeCode[@codeListValue="EndDirection"
]

EMS

N/A

Examples

DIF 9

<Spatial Coverage>
<Southernmost Latitude>- 78.0</Southernmost Latitude>
<Northernmost Latitude>- 78.0</Northernmost Latitude>
<Westernmost Longitude>- 178.0</Westernmost Longitude>
<Easternmost Longitude>- 178.0</Easternmost Longitude>

</Spatial Coverage>

DIF 10




<Spatial_Coverage>
<Spatial_Coverage _Type>Horizontal</Spatial_Coverage Type>
<Geometry>
<Coordinate_System>CARTESIAN</Coordinate_System>
<Bounding_Rectangle>
<Southernmost_Latitude>20</Southernmost_Latitude>
<Northernmost_Latitude>53</Northernmost_L atitude>
<Westernmost_Longitude>- 130</Westernmost_longituge>
<Easternmost_Longitude>- 60</Easternmost_Longitude>
</Bounding_Rectangle>
</Geometry>

<Granule_Spatial_Representation>CARTESIAN</Granule_Spatial_Represe
ntation>

</Spatial Coverage>

ECHO 10 Caollection

<Spatial >
<SpatialCoverageType>Horizontal</SpatialCoverageType>
<Horizontal SpatialDomain>
<Geometry>
<CoordinateSystem>CARTESIAN</CoordinateSystem>
<BoundingRectangle>

<WestBoundingCoordinate>- 130</WestBoundingCoordinate>




<NorthBoundingCoordinate>53</NorthBoundingCoordinate>
<EastBoundingCoordinate>- 60</EastBoundingCoordinate>
<SouthBoundingCoordinate>20</SouthBoundingCoordinate>
</BoundingRectangle>
</Geometry>
</Horizontal SpatialDomain>

<GranuleSpatialRepresentation>CARTESIAN</GranuleSpatialRepresentat
ion>

</Spatial >

ECHO 10 Granule

<Vertical SpatialDomain>
<Type>Maximum Altitude</Type>
<Value>0.1mb, or appr. 50km</Value>

</Vertical SpatialDomain>

<Spatial >

<Horizontal SpatialDomain>

<Zoneldentifier>Universal Transverse Mercator
(UTM)</Zoneldentifier>

</Horizontal SpatialDomain>




</Spatial >

Option 1

<Point>
<PointLongitude>- 80.1187</PointLongitude>
<PointLatitude>72.5477</PointLatitude>

</Point>

Option 8

<Orbit>
<AscendingCrossing>- 118.11119</AscendingCrossing>
<StartLat>50.0</StartLat>
<StartDirection>A</StartDirection>
<EndLat>50.0</EndLat>
<EndDirection>A</EndDirection>

</Orbit>

SO 19115-2

<gmd:extent>
<gmd:EX_Extent id="boundingExtent">
<gmd:description>

<gco:CharacterString>SpatialCoverageType=Horizontal,
Spatial Granul eSpatialRepresentation=CARTESIAN</gco:CharacterString




</gmd:description>
<!--Bounding Rectangle--><gmd:geographicElement>
<gmd:EX_GeographicBoundingBox>
<gmd:westBoundLongitude>
<gco:Decimal >- 130</gco:Decimal >
</gmd:westBoundLongitude>
<gmd:eastBoundLongitude>
<gco:Decimal >- 60</gco:Decimal >
</gmd:eastBoundLongitude>
<gmd:southBoundL atitude>
<gco:Decimal>20</gco:Decimal >
</gmd:southBoundL atitude>
<gmd:northBoundL atitude>
<gco:Decimal>53</gco:Decimal >
</gmd:northBoundL atitude>
</gmd:EX_GeographicBoundingBox>
</gmd:geographicElement>

<gmd:temporal Element><!- -RangeDateTime- -
><gmd:EX_Temporal Extent id="boundingTemporal Extent">

<gmd:extent>

<gml:TimePeriod gml:id="wl6aacl4a">

<gml:beginPosition>1995- 01-




01T00:00:00.000Z</gml:beginPosition>
<gml:endPosition/>
</gml:TimePeriod>
</gmd:extent>
</gmd:EX_Temporal Extent>
</gmd:temporal Element>
</gmd:EX_Extent>

</gmd:extent>

Granule

Vertical:

<gmd:description>
<gco:CharacterString>VerticalSpatialDomainType=Maximum Altitude,
Vertical SpatialDomainValue=0.1mb, or appr. 50km,

Vertical SpatialDomainType=Minimum Altitude,

Vertical SpatialDomainValue=SFC,

Vertical SpatialDomainType=Atmosphere Layer,

Vertical SpatialDomainValue=Atmosphere Profile</gco:CharacterString>

</gmd:description>

Zoneldentifier:
<gmd:geographicElement>
<gmd:EX_GeographicDescription>
<gmd:geographicldentifier>

<gmd:MD_ldentifier>




<gmd:code>

<gco:CharacterString>Universal Transverse Mercator
(UTM)</gco:CharacterString>

</gmd:code>

<gmd:description>

<gco:CharacterString>Zoneldentifier</gco:CharacterString>
</gmd:description>
</gmd:MD_ldentifier>
</gmd:geographicldentifier>
</gmd:EX_GeographicDescription>

</gmd:geographicElement>

Option 1
<gmd:geographicElement><!- -Point Bounds- ->
<gmd:EX_GeographicBoundingBox>
<gmd:westBoundLongitude>
<gco:Decimal>- 80.1187</gco:Decimal >
</gmd:westBoundLongitude>
<gmd:eastBoundLongitude>
<gco:Decimal>- 80.1187</gco:Decimal >
</gmd:eastBoundLongitude>

<gmd:southBoundL atitude>




<gco:Decimal>72.5477</gco:Decimal >
</gmd:southBoundL atitude>
<gmd:northBoundL atitude>
<gco:Decimal>72.5477</gco:Decimal >
</gmd:northBoundL atitude>
</gmd:EX_GeographicBoundingBox>
</gmd:geographicElement>
<gmd:geographicElement><!- -Point- ->
<gmd:EX_BoundingPolygon>
<gmd:polygon>
<gml:Point gml:id="d2e39" >

<gml:pos srsName="http://www.opengis.net/def/crs/EPSG/4326"
srsDimension="2">72.5477 -80.1187</gml:pos>

</gml:Point>
</gmd:polygon>
</gmd:EX_BoundingPolygon>

</gmd:geographicElement>

Option 8
<eos:Additional Attribute>
<eos:reference>
<eos:EOS_Additional AttributeDescription>

<eos:type>




<eo0s:EOS_Additional AttributeTypeCode
codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platforminformation" >platformlnformation</eos:EOS_Add
itional AttributeTypeCode>
</eos:type>
<eos:name>
<gco:CharacterString>AscendingCrossing</gco:CharacterString>
</eos:name>
</eos:EOS_Additional AttributeDescription>
</eos:reference>
<eos:value>
<gco:CharacterString>- 118.11119</gco:CharacterString>
</eos:value>
</eos:Additional Attribute>
<eos:Additional Attribute>
<eos:reference>
<eos:EOS_Additional AttributeDescription>
<eos:type>
<eo0s:EOS _Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platforminformation" >platformlnformation</eos:EOS_Add
itional AttributeTypeCode>




</eos:type>
<eos:name>
<gco:CharacterString>StartLat</gco:CharacterString>
</eos:name>
</eos:EOS_Additional AttributeDescription>
</eos:reference>
<eos:value>
<gco:CharacterString>50.0</gco:CharacterString>
</eos:value>
</eos:Additional Attribute>
<eos:Additional Attribute>
<eos:reference>
<eo0s:EOS_Additional AttributeDescription>
<eos:type>
<e0s:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</eos:EOS_Add
itional AttributeTypeCode>
</eos:type>
<eos:name>
<gco:CharacterString>StartDirection</gco:CharacterString>

</eos:name>




</eo0s:EOS_AdditionalAttributeDescription>
</eos:reference>
<eos:value>
<gco:CharacterString>A</gco:CharacterString>
</eos:value>
</eos:Additional Attribute>
<eos:Additional Attribute>
<eos:reference>
<eo0s:EOS_Additional AttributeDescription>
<eos:type>
<eos:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</eos:EOS_Add
itional AttributeTypeCode>
</eos:type>
<eos:name>
<gco:CharacterString>EndLat</gco:CharacterString>
</eos:name>
</eo0s:EOS_AdditionalAttributeDescription>
</eos:reference>
<eos:value>

<gco:CharacterString>50.0</gco:CharacterString>




</eos:value>
</eos:Additional Attribute>
<eos:Additional Attribute>
<eos:reference>
<eos:EOS_Additional AttributeDescription>
<eos:type>
<eo0s:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platforminformation">platformlnformation</eos:EOS_Add
itional AttributeTypeCode>
</eos:type>
<eos:name>
<gco:CharacterString>EndDirection</gco:CharacterString>
</eos:name>
</eos:EOS_Additional AttributeDescription>
</eos:reference>
<eos:value>
<gco:CharacterString>A</gco:CharacterString>
</eos:value>

</eos:Additional Attribute>

SO 19115-1




<mri:extent>
<gex:EX_Extent id="boundingExtent">
<gex:description>
<gco:CharacterString>SpatialCoverageType=Horizontal,

SpatialGranuleSpatialRepresentation=CARTESIAN</gco:CharacterString
>

</gex:description>
<gex:geographicElement>
<gex:EX_GeographicBoundingBox>
<gex:westBoundLongitude>
<gco:Decimal>- 130</gco:Decimal >
</gex:westBoundLongitude>
<gex:eastBoundLongitude>
<gco:Decimal>- 60</gco:Decimal >
</gex:eastBoundLongitude>
<gex:southBoundL atitude>
<gco:Decimal>20</gco:Decimal >
</gex:southBoundL atitude>
<gex:northBoundL atitude>
<gco:Decimal>53</gco:Decimal >
</gex:northBoundL atitude>
</gex:EX_GeographicBoundingBox>

</gex:geographicElement>




<gex:temporalElement>
<gex:EX_Temporal Extent id="boundingTemporal Extent">
<gex:extent>
<gml:TimePeriod gml:id="d13e34">

<gml:beginPosition>1995- 01-
01T00:00:00.000Z</gml:beginPosition>

<gml:endPosition/>
</gml:TimePeriod>
</gex:.extent>
</gex:EX_Temporal Extent>
</gex:temporal Element>
</gex:EX_Extent>

</mri:extent>

Granul e
Vertical:
<gex:description>

<gco:CharacterString>VerticalSpatialDomainType=Maximum Altitude,
Vertical SpatialDomainValue=0.1mb, or appr. 50km,

Vertical SpatialDomainType=Minimum Altitude,

Vertical SpatialDomainValue=SFC,

Vertical SpatialDomainType=Atmosphere Layer,

Vertical SpatialDomainValue=Atmosphere Profile</gco:CharacterString>

</gex:description>




Zoneldentifier:
<gex:geographicElement>
<gex:EX_GeographicDescription>
<gex:geographicldentifier>
<mcc:MD_ldentifier>
<gex:.code>

<gco:CharacterString>Universal Transverse Mercator
(UTM)</gco:CharacterString>

</gex:.code>

<gex:description>

<gco:CharacterString>Zoneldentifier</gco:CharacterString>
</gex:description>
</mcc:MD_Ildentifier>
</gex:geographicldentifier>
</gex:EX_GeographicDescription>

</gex:.geographicElement>

Option 1
<gex:geographicElement><!- -Point Bounds- ->
<gex:EX_GeographicBoundingBox>
<gex:westBoundLongitude>

<gco:Decimal>- 80.1187</gco:Decimal >




</gex:westBoundLongitude>
<gex:eastBoundLongitude>
<gco:Decimal>- 80.1187</gco:Decimal >
</gex:eastBoundLongitude>
<gex:southBoundL atitude>
<gco:Decimal>72.5477</gco:Decimal >
</gex:southBoundL atitude>
<gex:northBoundL atitude>
<gco:Decimal>72.5477</gco:Decimal >
</gex:northBoundL atitude>
</gex:EX_GeographicBoundingBox>
</gex:geographicElement>
<gex:geographicElement><!- -Point-->
<gex:EX_BoundingPolygon>
<gex:polygon>
<gml:Point gml:id="d2e39" >

<gml:pos srsName="http://www.opengis.net/def/crs/EPSG/4326"
srsDimension="2">72.5477 -80.1187</gml:pos>

</gml:Point>
</gex:polygon>
</gex:EX_BoundingPolygon>

</gex:geographicElement>




Option 8
<mdb:acquisitionlnformation>
<mac:MI_Acquisitionlnformation>
<mac:platform>
<mac:EOS_Platform>

<mac:identifier gco:nilReason="missing"/>

<mac:description gco:nilReason="missing"/>

<mac:instrument gco:nilReason="missing"/>

<mac:otherPropertyType>

<gco:RecordType

xlink:href="http://earthdata.nasa.gov/metadata/schema/eos/1.0/eos.xsd#xp
ointer(//element[ @name="Additional Attributes'])">Echo Additional
Attributes</gco:RecordType>

</mac:otherPropertyType>

<mac:otherProperty>

<gco:Record>
<mac:Additional Attributes>
<mac:AdditionalAttribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation" >platformlnformation</mac:EOS_Ad




ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>OrbitalModelName</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>WRS- 2</gco:CharacterString>
</mac:value>
</mac:Additional Attribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>




<gco:CharacterString>StartOrbitNumber</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>667</gco:CharacterString>
</mac:value>
</mac:Additional Attribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>StopOrbitNumber</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>

</mac:reference>




<mac:value>
<gco:CharacterString>667</gco:CharacterString>
</mac:value>
</mac:AdditionalAttribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>

<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>

</mac:type>

<mac:name>

<gco:CharacterString>EquatorCrossingLongitude</gco:CharacterString>

</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>9.54</gco:CharacterString>
</mac:value>

</mac:Additional Attribute>




<mac:AdditionalAttribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>EquatorCrossingDateTime</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>

<gco:CharacterString>2002- 06-
19T00:56:48.48Z</gco:CharacterString>

</mac:value>
</mac:Additional Attribute>
<mac:Additional Attribute>

<mac:reference>

<mac:EOS_Additional AttributeDescription>




<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>AscendingCrossing</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>- 158.10</gco:CharacterString>
</mac:value>
</mac:Additional Attribute>
<mac:AdditionalAttribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation" >platformlnformation</mac:EOS_Ad




ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>StartLat</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>81.8</gco:CharacterString>
</mac:value>
</mac:Additional Attribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>




<gco:CharacterString>StartDirection</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>D</gco:CharacterString>
</mac:value>
</mac:Additional Attribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>EndLat</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>

</mac:reference>




<mac:value>
<gco:CharacterString>- 81.8</gco:CharacterString>
</mac:value>
</mac:AdditionalAttribute>
<mac:Additional Attribute>
<mac:reference>
<mac:EOS_Additional AttributeDescription>
<mac:type>
<mac:EOS_Additional AttributeTypeCode

codeList="http://earthdata.nasa.gov/metadata/resources/Codelists.xmI#EO
S Additional AttributeTypeCode"

codeListValue="platformlnformation">platformlnformation</mac:EOS_Ad
ditional AttributeTypeCode>
</mac:type>

<mac:name>

<gco:CharacterString>EndDirection</gco:CharacterString>
</mac:name>
</mac:EOS_Additional AttributeDescription>
</mac:reference>
<mac:value>
<gco:CharacterString>D</gco:CharacterString>
</mac:value>

</mac:Additional Attribute>




</mac:Additional Attributes>
</gco:Record>
</mac:otherProperty>
</mac:EOS_Platform>
</mac:platform>

</mac:MI_AcquisitionInformation>

</mdb:acquisitionlnformation>

Source Data Information:

DIF 9 -
http://gcmd.gsfc.nasa.gov/mws/dif/macayeal _cont_GPS Ross Ice Shelf 0229
546

DIF 10 - Example based on schema with data from ECHO10 record.

ECHO 10 Collection - https://api.echo.nasa.gov:443/catal og-
rest/echo_catalog/datasets/C230264- GHRC

ECHO 10 Granule - https://api.echo.nasa.gov:443/catalog-
rest/echo_catalog/granules/G205050987- GSFCS4PA, Zoneldentifier —
Manually created, https://api.echo.nasa.gov:443/catalog-
rest/echo_catalog/granules/G187452045- LARC,
https://api.echo.nasa.gov:443/catal og-
rest/echo_catalog/granules/G183870388- NSIDC_ECS

ISO 19115- 2- https://api.echo.nasa.gov:443/catalog-
rest/echo_catalog/datasets/C230264- GHRC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of 1SO
19115- 2 record

Recommendations

ECHO's Spatial element should be used in the UMM - as it is a superset of
what GCMD includes. DIF 10 has included extra elements to allow for more
complicated geometries and granule spatial information.



A.B.24 Tiling Identification System

Element Specification

TilingldentificationSystem/TilingldentificationSystemName (1)
< CALIPSO, MISR, MODIS Tile EASE, MODIS Tile SIN, WELD Alaska Tile,

WELD CONUS Tile, WRS-1,WRS-2>
TilingldentificationSystem/Coordinatel (1)

TilingldentificationSystem/Coordinatel/MinimumValue (1)
TilingldentificationSystem/Coordinatel/MaximumValue (0..1)
TilingldentificationSystem/Coordinate2 (1)
TilingldentificationSystem/Coordinate2/MinimumValue (1)

TilingldentificationSystem/Coordinate2/MaximumValue (0..1)

Description

Defines a named two-dimensional tiling system.

Profile Utilization

Collection, Granule

Cardinality

0..*

Analysis

This element exists in ECHO and has been added to DIF 10. See the
TilingldentificationSystem Appendix for more information about specific
coordinate system translations.



Mapping

DIF 9 N/A

DIF 10 /DIF/Spatial_Coverage/Spatial Info/TwoD_Coordinate_System

SERF N/A

ECHO /Collection/TwoDCoordinateSystems/TwoDCoordinateSystem

10

Collecti

on

ECHO /Granule/TwoDCoordinateSystem/StartCoordinatel

10 /Granule/TwoDCoordinateSystem/EndCoordinatel

Granule |/Granule/TwoDCoordinateSystem/StartCoordinate2
/Granule/TwoDCoordinateSystem/EndCoordinate2

ISO /

19115-2 | gmi:MI Metadata/gmd:identificationInfo/gmd:MD_ Dataldentification/g
md:extent/gmd:EX Extent/gmd:geographicElement/gmd:EX Geograph
icDescription/gmd:geographicldentifier/gmd:MD Identifier/gmd:code/
gco:CharacterString
/
gmi:MI Metadata/gmd:identificationInfo/gmd:MD Dataldentification/g
md:extent/gmd:EX Extent/gmd:geographicElement/gmd:EX Geograph
icDescription/gmd:geographicldentifier/gmd:MD Identifier/gmd:descri
ption/gco:CharacterString

ISO /

19115-1 | mdb:MD_ Metadata/mdb:identificationInfo/mri:MD_ Dataldentification/
mri:extent/gex:EX Extent/gex:geographicElement/gex:EX Geographic
Description/gex:geographicldentifier/mcc:MD Identifier/mcc:code/gco
:CharacterString
/
mdb:MD Metadata/mdb:identificationInfo/mri:MD Dataldentification/
mri:extent/gex:EX Extent/gex:geographicElement/gex:EX Geographic
Description/gex:geographicldentifier/mcc:MD_Identifier/mcc:descripti
on/gco:CharacterString

EMS N/A

Examples
DIF 10

<Spatial Coverage>




<Spatial_Info>
<Spatial_Coverage_Type>Horizontal</Spatial_Coverage Type>
<TwoD_Coordinate_System>

<TwoD_Coordinate_System_Name>MISR</TwoD_Coordinate_System_Na
me>
<Coordinatel>
<Minimum_Value>1</Minimum_Value>
<Maximum_Value>233</Maximum_Value>
</Coordinatel>
<Coordinate2>
<Minimum_Value>1</Minimum_Value>
<Maximum_Value>180</Maximum_Value>
</Coordinate2>
</TwoD_Coordinate_System>
</Spatial_Info>
</Spatial Coverage>

ECHO 10 Caollection

<TwoDCoordinateSystems>

<TwoDCoordinateSystem>

<TwoDCoordinateSystemName>CALIPSO</TwoDCoordinateSystemName
>
<Coordinatel>
<MinimumValue>1</MinimumValue>
<MaximumValue>75000</MaximumV alue>
</Coordinatel>
<Coordinate2>
<MinimumValue>1</MinimumValue>

<MaximumValue>233</MaximumV alue>

</Coordinate2>




</TwoDCoordinateSystem>

</TwoDCoordinateSystems>

ECHO 10 Granule

<TwoDCoordinateSystem>
<StartCoordinatel>116</StartCoordinatel>
<StartCoordinate2>24</StartCoordinate2>
<EndCoordinate2>167</EndCoordinate2>

<TwoDCoordinateSystemName>MI|SR</TwoDCoordinateSystemName>

</TwoDCoordinateSystem>

SO 19115-2

<gmd:geographicElement>
<gmd:EX_GeographicDescription>
<gmd:geographicldentifier>
<gmd:MD_Identifier>

<gmd:code>
<gco:CharacterString>01,75000p1,233</gco:CharacterString>

</gmd:code>

<gmd:description>
<gco:CharacterString>CALIPSO</gco:CharacterString>

</gmd:description>

</gmd:MD_ldentifier>




</gmd:geographicldentifier>
</gmd:EX_GeographicDescription>

</gmd:geographicElement>

-Granule
<gmd:geographicElement>
<gmd:EX_GeographicDescription>
<gmd:geographicldentifier>
<gmd:MD_Identifier>
<gmd:code>
<gco:CharacterString>p116b24- 167</gco:CharacterString>
</gmd:code>
<gmd:description>
<gco:CharacterString>MISR</gco:CharacterString>
</gmd:description>
</gmd:MD_ldentifier>
</gmd:geographicldentifier>

</gmd:EX_GeographicDescription>

</gmd:geographicElement>

SO 19115-1

<gex:geographicElement>

<gex:EX_GeographicDescription>




<gex:geographicldentifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString> 01,75000p1,233</gco:CharacterString>
</mcc:code>
<gex:description>
<gco:CharacterString>CALIPSO</gco:CharacterString>
</gex:description>
</mcc:MD_Identifier>
</gex:geographicldentifier>
</gex:EX_GeographicDescription>

</gex:geographicElement>

- Granule
<gex:geographicElement>
<gex:EX_GeographicDescription>
<gex:geographicldentifier>
<mcc:MD_ldentifier>
<mcc:code>
<gco:CharacterString>p116b24- 167</gco:CharacterString>
</mcc:code>

<gex:description>




<gco:CharacterString>MISR</gco:CharacterString>
</gex:description>
</mcc:MD_Identifier>
</gex:geographicldentifier>

</gex:EX_GeographicDescription>

</gex:geographicElement>

Source Data Information:

DIF 10 - https://cmr.earthdata.nasa.gov:443/search/concepts/C183897339-
LARC

ECHO 10 Collection -

https://cmr.earthdata.nasa.gov:443/search/concepts/C5862864- LARC_ASDC
ECHO 10 Granule -

https://cmr.earthdata.nasa.gov:443/search/concepts/G183655594- LARC
ISO 19115- 2-

https://cmr.earthdata.nasa.gov:443/search/concepts/C5862864-
LARC_ASDC.iso

https://cmr.earthdata.nasa.gov:443/search/concepts/G183655594- LARC.iso

ISO 19115-1 - Example based on 1SO19139t019115- 3.xsl translation of ISO
19115- 2 record



Appendix A-1 Tiling ldentification System

Table A.4 outlines all tiling identification systems (formerly 2D coordinate
systems) used currently in the CMR and their corresponding format in the
ISO translation. This table also includes information on a generic translation
used if none of the known systems are applicable.

Table A.4: Tiling ldentification Systems Translation

Tiling Identification System Sample 1SO Translated
Format

CALIPSO 029309,29310p171,171

MISR p232b1- 180

MODIS Tile EASE h12v14

MODIS Tile SIN hOv9

WRS- 2 pl58r4

WRS-1 p24- 24r28- 28

WELD Alaska Tile uses generic translation

WELD CONUS Tile uses generic translation

generic 1SO to ECHO x2-12y3-18

translation

More information may be found at the following link related to the Metadata
Evolution for NASA Data Systems (MENDS) Working Group documentation
(Earthdata Login Required):
https://wiki.earthdata.nasa.gov/display/NASAISO/Two-

Dimensional +Coordinate+Systems




Appendix A-2  Abbreviations and Acronyms

ACL Access Control List

CMR Common Metadata Repository

DAAC Distributed Active Archive Center

DIF Directory Interchange Format

DOI Digital Object Identifier

ECHO Earth Observing System (EOS) Clearing House

EOS Earth Observing System

EOSDIS Earth Observing System Data and Information
System

ESDIS Earth Science Data and Information System

ESO ESDIS Standards Office

GCMD Global Change Master Directory

ISO International Organization for Standardization

KMS Keyword Management System

MAS Metadata Architecture Studies

MENDS Metadata Evolution for NASA Data Systems

MMT Metadata Management Tool

NASA National Aeronautics and Space Administration

SERF Service Entry Resource Format

UMM Unified Metadata Model

UMM -C Unified Metadata Model Collections

UMM - Common

Unified Metadata Model Common Elements




UMM-D Unified Metadata Model Documents
UMM-G Unified Metadata Model Granules
UMM-M Unified Metadata Model Meta
UMM-S Unified Metadata Model Services
UMM-Var Unified Metadata Model Variables
UMM-Vis Unified Metadata Model Visualization
URI Uniform Resource ldentifier

URL Uniform Resource Locator

URS User Registration System

XML Extensible Markup Language
XPath XML Path Language




